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Workflow
Welcome to the HX Edit Pilot’s Guide. This guide contains details of the HX Edit v.2.92 
application’s features and functionality with Line 6® Helix® devices (Helix®, Helix® Rack 
and Helix® LT), as well as with HX devices (HX Stomp™ and HX Effects™). All behaviors 
are the same on Mac and PC computers unless otherwise noted. It is recommended 
that you also read the Owner’s Manual for details on using your particular device. 

What’s in it for Me?
HX Edit is a simple, but powerful, editor, preset librarian, and IR manager application. It 
allows you to easily customize, back up and manage your tone presets and setlists, as 
well as manage the Impulse Responses on your Line 6 Helix or HX device.
HX Edit is the editor/librarian software for use with all Helix or HX devices that are 
running firmware version 2.80 (or later).* For best performance, it is recommended to 
use the latest available versions for your HX Edit application, drivers, and device 
firmware (as well as for the Helix Native software, if you’re using it). If for any 
reason you wish to use an earlier firmware in your device, or an earlier HX Edit software 
version, you'll need to be sure the release versions of the firmware and software match 
for full functionality.

*IMPORTANT! Your Helix or HX device must be running firmware version 
no earlier than 2.80 (the latest available version is recommended) to be 

able to use it with HX Edit version 2.92 (the latest HX Edit version is recommended). 
Please be sure to read the Release Notes and  Installation Instructions available 
with all drivers, firmware, and applications carefully before installation since 
there may be specific instructions for the order and procedure to follow, 
depending on the existing versions you already have installed.

NOTE: Each Helix or HX device model offers a different set of inputs, outputs and 
signal flow capabilities. Throughout the following chapters, we've indicated HX 
Edit app functionality that is specific to your Helix or HX device type. 

Marketplace
Be sure to visit the Line 6 Marketplace online shop, where you'll find 3rd-party add-on 
assets that further enhance the functionality of your Helix and HX devices, as well 
as Helix Native plug-in! As of this writing, professionally crafted presets and IRs are 
available—check back often on Marketplace for product news and announcements. An 
Internet connection is required for the computer on which you'll be using the HX Edit 
app to authorize it for the use of Marketplace premium assets. Please see “Marketplace 
& Account Options” on page 45.

NOTE: Device firmware version 2.70 and HX Edit version 2.70 or later are required  
for full support and use of premium Marketplace presets and IRs. 

Workflow Overview
Once the HX Edit app is launched, it automatically syncs all presets and IRs from your 
Helix or HX device's internal memory. You'll see your device's presets & IRs displayed 
in the Librarian panels at the left. This allows you to export presets and IRs to create 
a virtually unlimited library on your computer, and then import them onto your device 
at any time. These Librarian panels also allow you to easily rename and reorder your 
presets and IRs, and the Create & Restore Backup feature makes it simple to create full 
backups that can be restored to your Helix or HX hardware in minutes.
You will also see your currently loaded preset's contents displayed in the Editor panels 
on the right. This allows you to load & fully customize your presets, configure bypass & 
controller assignments and create & edit snapshots. While connected, communication 
between the application and your connected device’s internal memory is instantaneous. 
Changes you make to any parameters in the Signal Flow or Inspector Windows, as 
well as any changes to presets, setlists and IRs within the Librarian, are immediately 
reflected on the device, and vice-versa.
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This interactive communication allows you to tweak your presets and setlists in real 
time, without the need to send/receive or manually sync to the device.

WARNING: Be careful when overwriting presets or Impulse Responses—these 
changes cannot be reverted! You can use the use the Create & Restore Backups 
feature to back up your Helix or HX device's contents before making changes. See 

“Creating & Restoring Complete Device Backups”. 

Computer Connectivity
To put the HX Edit application to work, connect your Helix or HX device to your 
computer’s USB 2 or 3 port. 

NOTE: If on Windows®, be sure to have the latest Line 6 drivers installed for your 
device. No driver installation is necessary on Mac computers.

It is highly recommended to install all included drivers when running the latest 
Windows HX Edit application installer—all drivers are already selected to be 
installed by default. The latest HX Edit applications installer is always available at  
line6.com/software/.

http://line6.com/support/manuals/
https://line6.com/marketplace/
https://line6.com/software/
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Exit any other Line 6 applications that may be running. With your Helix device 
powered on, launch HX Edit.

• Mac: Go to Applications > Line 6 > HX Edit
• Windows: Go to the Start button menu > All Apps (or Programs) > Line 6 > HX 

Edit
Upon launch, the application will detect Helix hardware and automatically retrieve 
and display its on-board presets & Impulse Responses. This may take a moment to 
download all of the preset information. 

Multi-Device, Multi-Window Support
The HX Edit application supports the use of multiple-connected Helix/HX devices 
simultaneously, where each device displays its own full application window. This allows 
you to more easily reference and edit presets and settings, as well copy presets and IRs 
between multiple USB-connected devices.

TIP: You can also use the Copy and Paste commands or drag and drop to copy a 
block and its current settings from one HX Edit device window to another! 

To access the separate application windows for each connected device, simply go 
to the HX Edit Devices menu and select the desired device to display or hide its 
window—a check mark at the left of a device here indicates its app window is open. 
You can choose to have multiple device windows open simultaneously, making it easy 
to copy and paste blocks, or drag and drop blocks, presets and IRs between them. The 
separate windows can also be resized and/or positioned on your screen independently. 
Please also see “GUI Overview” on page 8.

The app's Devices menu, showing two connected device's windows

You'll see an indicator at the bottom of each application window displaying its connected 
Helix/HX device type and the device's firmware version—or a warning that no device is 
detected.

Device indicator at bottom of the HX Edit main window

NOTE: On macOS computers, closing all open device windows does not exit the 
HX Edit application. As is common with multi-window supporting macOS apps, 
you'll need to use the Quit HX Edit command from the main HX Edit menu (or 

better, just train yourself to use the Cmd+Q shortcut). 
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Preset Compatibility
This guide covers version 2.92 of the HX Edit application. The easiest way to ensure the 
best performance and compatibility between HX Edit and your Helix or HX device is to 
make sure to have the latest updates. New as of HX Edit v2.90, the HX Edit application 
will now automatically check for, and walk you though installing, the latest firmware 
update for your connected Helix or HX device (see “Firmware Updater & Additional 
Resources” on page 70). An active Internet connection is required. 
Helix preset files are transferable between Helix devices (Helix, Helix Rack and Helix 
LT), as well as with the Helix® Native plug-in software. Additionally as of v2.80, HX Edit 
and Helix Native now both include Preset Translation functionality, and Helix Native 
further includes selectable Hardware Compatibility modes. As covered throughout this 
chapter, these features allow many presets to be shared between any Helix and HX type 
devices, and with Helix Native. 

TIP: It is also possible to Copy and Paste, or drag and drop individual blocks, along 
with their current settings, between Helix Native and HX Edit, as well as between 
multiple HX Edit device windows. See the following “Block Copy and Paste” section..

Helix presets that were originally created using the earlier Helix editor application and 
Helix device firmware 1.xx versions are still supported. Note that, once loaded and 
saved with the newer HX Edit application, your presets will have new information added 
to them to support the latest models and functionality—full backward compatibility 
with the Helix application and earlier Helix firmware versions, therefore, cannot be 
guaranteed. It is advised to keep a backup all your earlier presets if you plan on possibly 
returning to these previous device and application versions. 

Preset Compatibility with Helix Native Plug-in
All your Helix and HX device presets, setlists, and bundles are compatible between 
the HX Edit app (v2.80 or later) and Helix Native plug-in (v1.80 or later), by way of 
the Helix Native Hardware Compatibility mode (HC mode) functionality. Once you’ve 
exported a preset (or setlist or bundle) from your device using HX Edit, upon import, 
Helix Native determines the device type from which it was created, and automatically 
changes the plug-in’s HC mode to match the device, thus fully supporting the complete 
tone. Likewise, presets exported from Helix Native plug-in’s matching HC mode are 
fully compatible with your Helix or HX device.
Helix Native also offers Preset Translation functionality (also offered in HX Edit—see 
the next section). When loading a preset into Helix Native as the current tone (such as 
by dragging a preset from the HX Edit Presets Library or from a computer folder directly 
into the Helix Native Signal Flow), you’ll be prompted to either change the plug-in’s 
HC mode to match the preset’s source format, or to attempt to translate to match the 
current plug-in HC mode. 

This preset compatibility is the foundation of the Line 6 “Studio to Stage” concept, 
allowing you to load, edit and transfer your tones between HX Edit and Helix Native plug-
in! Note that Helix Native plug-in maintains its own Preset & IR libraries, independent of 
the presets and IRs that reside within your Helix hardware. For more information, please 
see the Helix Native Pilot’s Guide.

TIP: If you also own Helix Native plug-in, be sure to reference the “Helix 
compatible” version number (found in the Helix Native software's About box) to 
determine the recommended Helix/HX device firmware version you should use for 

maximum preset compatibility. It is highly recommended to always use the latest 
available device firmware and HX Edit and Helix Native software.

Since the different Helix device types include different physical inputs and outputs, 
some variances exist among settings, as well as for their support of block types & 
controllers, which may affect the sharing of presets between devices, or between HX 
Edit and Helix Native plug-in. The following sections in this chapter provide details 
about sharing presets and settings.

Preset Translation
When importing a preset into the HX Edit Presets Library, the application automatically 
detects the source device from which it was created (Helix, HX Effects, or HX Stomp).

NOTE: As covered in the previous section, if the preset attempting to be imported 
was exported from Helix Native (or dragged from the Helix Native Presets Library), 
the Hardware Compatibility mode of the preset determines its source device type 

format. 
If the HX Edit app window’s currently connected device is different that the preset’s 
source device, the app will attempt to translate the preset to the current device format. 
If translation is successful, the preset is imported into the current device’s library. 
Presets cannot be translated if created with a source device (or Helix Native HX 
mode)  which includes features or capabilities that exceed those of the current device 
(e.g., greater signal path count, exceeds maximum block count or type, etc.) If the 
preset cannot be translated, you’ll get an error window letting you know the preset is 
not compatible and why, and import is cancelled. For example, if attempting to import 
a Helix exported preset which includes an Amp model into an HX Effects device (HX 
Effects includes no support for Amp models), translation is not possible and you’ll see 
the following error.

Error message displayed when a preset cannot be translated on import

https://www.line6.com/manuals
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Feature Comparison Table
The following table shows the primary feature differences that affect preset translation 
between the Helix and HX hardware types. Additionally, Helix Native offers a HC mode  
Off option. When this Off mode setting is in us in Helix Native, the preset has fewer 
restrictions for block types and DSP limits. Therefore, presets exported from this Off 
mode can exceed the capabilities of any Helix or HX device. You can consult this table 
to determine if a preset from one source device  (or Helix Native HC mode) will be able 
to be translated to other devices. Also see the Preset Translation Compatibility table 
for more info. 

DEVICE / HC MODE FEATURE COMPARISON

Feature
Device Type or HC Mode Format:

Off 
(Helix Native only) Helix HX Stomp HX Effects

Included 
Models

Full set of v2.90 
Helix models

Full set of v2.90 
Helix models

Full set of v2.90 
Helix models, 

except 6 Switch 
Looper

Full set of v2.90 
Helix models, 

except Amps & 
Cabs

Blocks Per Path 
Capacity

16 16 6 9

Max. Block Type 
Per Path

None 2 Amps, 2 Cabs,  
2 IRs (1,024 

sample) or 1 IR 
(2,048 sample)

2 Amps, 2 Cabs,  
2 IRs (1,024 

sample) or 1 IR 
(2,048 sample)

2 Amps, 2 Cabs,  
2 IRs (1,024 

sample) or 1 IR 
(2,048 sample)

Max. DSP Limit
None Same as Helix 

hardware
Same as  

HX Stomp  
hardware

Same as  
HX Effects 
hardware

Snapshots 
Per Preset

8 8 3 4

Preset Library 
(independent per 

HC mode)

8 Setlists for 
up to 1,024 

Presets. 
Bundle support 

included

8 Setlists for 
up to 1,024 

Presets. 
Bundle support 

included

1 Setlist for up to 
128 Presets

1 Setlist for up 
to 128 Presets

Impulses Library 
(shared between 

HC modes)

Holds up to 
128 User IRs

Holds up to 128 
User IRs

Holds up to 128 
User IRs

Holds up to 128 
User IRs

NOTE: Likewise, if importing multiple presets at once, a setlist, or a bundle, where 
one or more presets are not able to be translated to the current device, the non-
translatable presets display an error window and are not imported, while the eligible 
presets are successfully translated and imported.

Input and output block options and controller support also differ among the Helix 
and HX device types (e.g., HX devices include no Variax input or EXP 3 pedal 
options as Helix devices do). These types of non-compatible features do not block 
preset translation, and instead these settings are automatically changed or ignored.  
Typically, non-compatible input and output block settings are reset to the common 
Main In or Main Out, and non-supported controller assignments are removed from the 
preset.

Preset Translation Compatibility Table
The following table provides an overview of the preset translation capabilities from each 
source device (or each source Helix Native HC mode).

PRESET TRANSLATION COMPATIBILITY

Created With:
Can Be Translated To:

HC mode Off 
(Helix Native) Helix HX Stomp HX Effects

Helix Native   
HC mode Off �

If does not 
exceed Helix 

block count and 
DSP limits

If does not 
exceed HX 

Stomp Block & 
Path count  

and DSP limits

If does not 
exceed HX 

Effects Block & 
Path count  

and DSP limits
Helix 

(Rack, Floor, LT)
or

Helix Native
Helix mode

� �
If does not 
exceed HX 

Stomp Block & 
Path count  

and DSP limits

If does not 
exceed HX 

Effects Block & 
Path count  

and DSP limits

HX Stomp
or

Helix Native
HX Stomp mode

� � �
If does not 
exceed HX 

Effects Block & 
Path count  

and DSP limits

HX Effects
or

Helix Native
HX Effects mode

� � � �
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Feature Compatibility
The following sections provide details on the compatibility of the major features between 
device types, and between HX Edit and Helix Native.

HX Edit Backup Files
The HX Edit application includes a feature that creates Helix Backup (.hxb) files to 
restore a Helix or HX device's presets, impulses and global settings (see page 21). 
Helix Backup files are specific to each device type and, therefore, cannot be opened or 
utilized in HX Edit when a different source device is connected. 
Helix Native plug-in does not currently include this back up functionality and, therefore, 
does not support creating or opening Helix Backup .hxb files.

Block Copy and Paste
Using the Copy Block and Paste Block commands, you can copy and paste any 
block type between any presets within HX Edit, as well as between multiple HX Edit 
windows (with any Helix or HX device connected) and any instance of the Helix Native 
plug-in. It is also possible to drag and drop any processing block to move it within the 
current preset, or to copy it into any other HX Edit device window. Restrictions apply 
when copying, pasting and moving some block types, depending on the source Helix/
HX device (or source Helix Native HC mode) and the destination. Please see “Cutting, 
Copying, Pasting & Clearing Blocks” on page 26.

Snapshot Copy and Paste
The current Snapshot, along with all its settings, can be copied and pasted using the 
Copy Snapshot and Paste Snapshot commands either within the current HX Edit 
preset or within the current Helix Native preset. Also see “Configuring & Managing 
Snapshots” on page 19.

Command Center Copy and Paste
Within the Command Center window, once a command assignment is created for any 
footswitch, EXP Pedal or other controller, you can use the Command Center's Copy and 
Paste command options to copy assignments between controllers, as well as between 
controllers within other HX Edit presets within the current HX Edit device window.* 
Helix Native plug-in does not include the Command Center, therefore, it is not possible 
to copy Command Center assignments between HX Edit and Helix Native. Also see “The 
Command Center Window” on page 37.

*NOTE: HX Stomp devices also do not include the Command Center feature. 

Input & Output Block Settings
When Importing a Helix/HX hardware-exported Preset into HX Edit with a different 
device type connected - During preset translation, the Input and Output block settings 
are changed to “Multi” or “Main” if the connected device does not support the original 
options (also see “Preset Translation” on page 4).
When Importing a Helix Native-exported Preset into Helix/HX Hardware - All input 
and output blocks that were set to “Host” will default to the “Multi” setting within the 
Helix devices, and to the “Main” setting in HX devices. Any input block set to “None” will 
remain as set to “None” within the hardware. 
When Importing a Helix/HX hardware-exported Preset into Helix Native Plug-in - 
All input and output blocks that were set to physical inputs and outputs (other than 
“None”) will default to the “Host” setting within the plug-in. Any input block set to 
“None” will remain set to “None” within the plug-in. 

Hardware Blocks (Send, Return, FX Loop & Looper)
When Importing a Helix Hardware-exported Preset into Helix Native - These 
hardware block types are only functional within Helix/HX devices. Within Helix Native, 
these block offer no routing functionality and their parameters are not editable. 

Impulse Responses
Impulse Response (IR) files are able to be utilized within IR blocks of all Helix and HX 
devices, as well as by the Helix Native plug-in in any HC mode. If you are to be sharing 
Helix presets between Helix Native plug-in and Helix or HX devices, it is a good idea 
to build and maintain your IR libraries similarly on each to allow the same IR files to be 
utilized for your presets that include them—see page 14.

NOTE: IRs, including those from the Line 6 Marketplace online shop and 3rd party 
vendors, are supported by all Helix and HX devices, as well as by Helix Native plug-
in. Any of your IRs can be imported and exported, as well as dragged and dropped, 

between HX Edit and Helix Native IR library windows. 

Controller Assignments
Controller assignment types vary between Helix and HX devices, for example, a Helix 
Floor preset may include an EXP 3 controller assignment, which Helix LT and HX 
devices do not include. Therefore, if a preset is imported and translated to a different 
device in HX Edit, non-supported assignments are discarded. 
The Helix Native plug-in does not utilize any hardware-based Bypass, Controller or 
Command Center Assignments that may exist within HX Edit-exported presets. Any 
such assignments remain intact within your presets, but are essentially ignored by Helix 
Native.* Snapshot and MIDI In type assignments, however, are supported in both Helix 
hardware and Helix Native plug-in.) Helix Native plug-in includes its own functionality to 
create plug-in parameter - Automation Controller type assignments, which are similarly 
ignored when Helix Native presets are imported into the HX Edit application. 

TIP: Helix Native includes a Preferences option to show or hide existing hardware-
based assignments within its Assignments tab.



 7 

MIDI In Bypass & Controller Assignments
Using HX Edit, you can create MIDI In Bypass Assignments to remotely toggle the 
bypass state of most block types, and MIDI In Controller Assignments to remotely 
control most Helix parameters, via external MIDI controller devices or MIDI software. 
MIDI In assignments saved within HX Edit-exported presets are supported when 
imported into other Helix/HX devices, as well as in Helix Native plug-in. Also see 
“Creating a Bypass Assignment” on page 32.

DSP Limit
In order to maintain preset compatibility with Helix and HX devices, each HC mode 
within the Helix Native plug-in incorporates DSP limits on its presets, matching the 
limits of the respective hardware devices. The exception to this rule is when the “Off” 
HC mode setting is in use in Helix Native. This mode effectively removes the DSP limits 
on presets, as well as several other restrictions. For this reason, presets exported from 
the Helix Native - HC Off mode may not be translatable in HX Edit for any device. Also 
see “Preset Compatibility with Helix Native Plug-in” on page 4. 

Marketplace Assets
Premium presets and IRs purchased from the online Marketplace are compatible with 
Helix devices and Helix Native plug-in. (Some Marketplace items may be compatible 
with HX devices, as indicated on the Marketplace site.) The import of premium 
Marketplace assets requires online license Authorization. Please see “Marketplace & 
Account Options” on page 45. 

NOTE: Version 1.70 of Helix Native and 2.70 of HX Edit and device firmware (or later 
versions) are required for full support and use of premium Marketplace presets and 
IRs. 
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GUI Overview
HX Edit has a very intuitive, easy-to-use interface. The main application window 
automatically detects your specific Helix or HX device type and displays all its options 
within the main application window. 

TIP: As covered in “Multi-Device, Multi-Window Support” on page 3, if you 
have more than one device connected, a separate application window is available 

for each device. 

Within the application window, the navigation is divided into three main sections: 
The Librarian Window - For managing preset and Impulse Response (IR) files.
The Signal Flow Window - Where you can add and move amp, effects & mix  
blocks, and customize your complete signal path routing.
The Inspector Window - Where you can choose from the huge selection of 
models, edit their parameters, create bypass & controller assignments, and more. 

Show/Hide
Librarian

Undo/Redo 
Buttons

Impulses
Tab

Tempo 
Controls

Presets
Tab

Signal Flow
Window

EDITO
R

LIBRARIAN

Edit TabMy Account/Preferences
Menu

Bypass/Controller 
Assign Tab

Inspector
Window

The HX Edit main GUI (Helix Floor device)

HX Stomp & HX Effects Device Owners: With an HX device connected, its 
application window displays the single signal flow, just as on your HX hardware 
screen. As covered in this chapter for Helix devices, you can utilize the 
application's signal flow to bypass, move, clear, copy & paste blocks, create 
split paths, and more. 

The HX Edit signal flow—with an HX Stomp connected

The HX Edit signal flow—with an HX Effects connected

TIP: The Command Center, for creating MIDI control assignments (Helix and HX 
Effects only) and Global EQ (Helix and HX Stomp only) are available as separate 
windows from the application's Window menu. 

Resizing the Application Window
The HX Edit main application window is resizable, allowing you to adjust it to best fit 
your screen size and workflow. Simply click and drag any corner or edge of the window 
to adjust to the preferred size, or click the “Maximize” button at the top of the window 
to use it in full screen mode. If you have multiple devices connected, each device's 
application window is independently resizable.
It is also possible to show or hide the Presets & Impulses Librarian panel, by clicking on 
the toggle button at the top left of the Signal Flow window. 

The Librarian window Show/Hide toggle button
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Application Menus
At the top of your computer screen (Mac) or top of the application window (Windows), 
you'll find the familiar application menu bar for the current device. Note that the available 
commands differ within the File and Edit menus depending on the application window, 
tabbed panel and/or specific control that currently has “focus.” The window focus is 
indicated by a blue outline appearing around the Librarian, Signal Flow or Inspector 
windows.* To change focus, simply click within the desired window, or use the TAB 
key. To follow are descriptions of the included application menu commands for Mac 
and Windows. Also see “Keyboard Shortcuts” on page 58 for additional information. 

*NOTE: It is possible that the Librarian's Presets or Impulses tab currently has 
focus, but if you've “hidden” the Librarian panel, you will not see its blue outline 
focus indicator. Using the TAB key will advance the focus to the other windows, 

even when the Librarian is hidden. 

NOTE: On Mac computers, HX Edit has one common, main application menu at the top 
of your screen. If you have multiple Helix devices connected and multiple app windows 
open, all available menu commands & keyboard shortcuts act only upon the current 

“front” application window. (Click on the desired application window to bring it to front.)

HX Edit (Mac only)
• About HX Edit - Launches the About box screen, which displays the versions 

of the HX Edit software and connected Helix device firmware, as well as legal 
information.

• Preferences - Launches the Preferences window, where you can select 
application and hardware settings—see page 42. You can also launch the 
Preferences window by clicking on the “gear icon” button or device indicator at 
the bottom of the application window.

• Quit HX Edit - Exits the application for all connected devices.

File
When a preset within the Presets tab currently has focus (or, when the Presets tab is 
displayed and focus is within any other window), the following commands are selectable:

• Save Preset - Saves changes for the currently loaded preset to the device's 
Preset Library. 

• Save Preset As - Displays the Save As window, allowing you to choose the 
desired Setlist and Preset Library location where to save the current tone. Note 
that choosing an occupied preset location will overwrite the existing preset 
within the location on your device.

• Import Preset - Imports any .hlx preset file (or files) from your computer, 
replacing the currently selected library preset(s).

• Export Preset - Exports the currently selected preset (or presets) and saves 
each to your computer as a .hlx file. 

• Import Setlist - (Helix devices only) Imports any .hls setlist file from your 
computer, replacing the current setlist on your Helix.

• Export Setlist - (Helix devices only) Exports the current setlist and saves it to 
your computer as an .hls setlist file.

• Import Bundle - (Helix devices only) Imports any .hlb bundle file from your 
computer, replacing all setlists and presets within the Helix.

• Export Bundle - (Helix devices only) Exports all the current setlists and their 
presets from your Helix and saves them to your computer as an .hlb bundle file.

When an IR slot within the Impulses tab currently has focus (or, when the Impulses 
tab is displayed, and focus is within any other window), the following commands are 
selectable:

• Save Preset - Saves changes to the currently loaded preset.
• Save Preset As - Displays the Save As window, allowing you to choose the 

desired Setlist and Preset Library location where to save the current tone. 
• Import Impulse - Imports an Impulse Response file (or files) from your computer, 

replacing the currently selected library Impulse(s).
• Export Impulse - Exports the currently selected Impulse (or Impulses) and 

saves each to your computer.

TIP: Please see “Presets Panel” on page 11 and “Impulses Panel” on page 
14 for details these File menu commands.

The following File menu commands are available regardless of window focus:
• Create Backup - Launches the Create a Helix Backup window, where you can 

export a full backup of your device's presets, impulses & global settings—see 
page 21.

• Restore From Backup - Launches the Restore From Backup window, where 
you can restore all your device's presets, IRs & global settings from a previously 
created backup—see page 21.

• Preferences - (Windows only) Launches the Preferences window, where you 
can access application and hardware settings—see page 42. You can also 
launch the Preferences window from the “gear icon” button or the connected 
device indicator at the bottom of the application window.

• Quit - (Windows only) Exits the application.

Edit
Regardless of tab focus:

• Undo - Reverses the last supported edit action.
• Redo - Reverses the last performed Undo action.

TIP: Please see “Undo / Redo” on page 20 for details.

When the Presets tab has focus:
• Copy Preset - Copies the selected Preset(s) to the clipboard.
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• Paste Preset - Pastes the last-copied preset(s), replacing the preset(s) within 
the selected preset library location(s).

• Select All Presets - Selects all Presets within the current Setlist.
• Rename Preset - Renames the currently loaded preset.

When the Impulses tab has focus:
• Copy IR - Copies the selected IR(s) to the clipboard.
• Paste IR - Pastes the last-copied IR(s), replacing the IR(s) within the selected 

IR library location(s).
• Clear IR - Deletes the selected the IR(s) from the Impulses library.
• Select All IRs - Selects all IRs within the Impulses library.
• Rename IR - Renames the currently selected IR.

When the Signal Flow window has focus:
• Cut Block - Copies the currently selected block and its settings to the clipboard 

and removes the block from the Signal Flow.
• Copy Block - Copies the currently selected block and its settings to the 

clipboard.
• Paste Block - Pastes the last-copied block's model and its settings to the 

selected block location. When an existing block is selected as the paste 
location, this replaces the existing block.

• Paste Block Before - When an existing block is currently selected, pastes the 
last-copied block's model and its settings to the location before the selected 
block.

• Paste Block After - When an existing block is currently selected, pastes the 
last-copied block's model and its settings to the location after the selected 
block.

• Clear Block - Deletes the selected block.
• Rename Preset - Renames the currently loaded preset.

TIP: Copy Block and Paste Block, as well a drag and drop of processing 
blocks, can be also used between multiple HX Edit windows, and back and 
forth with Helix Native plug-in! See “Cutting, Copying, Pasting & Clearing 

Blocks” on page 26 for details.

Snapshots
• Copy Snapshot - Copies the currently loaded preset's snapshot to the 

clipboard.
• Paste Snapshot - Pastes the last-copied snapshot contents, replacing the 

currently loaded snapshot's contents. 
• Rename Snapshot - Allows you to edit the title of the currently loaded snapshot 

(Helix and HX Effects devices only).

• Snapshots - Any of the current preset's snapshots can be selected directly 
here. (Note that Helix devices offer 8 snapshots, HX Stomp offers 3 and HX 
Effects offers 4.) 

TIP: Please see “Configuring & Managing Snapshots” on page 19 for 
details.

Window
• Show / Hide Librarian - Toggles the Presets/Impulses librarian panel between 

shown and hidden for the current device window.
• Command Center - Displays the Command Center window (Helix and HX 

Effects devices only)—see page 37.
• Global EQ - (Helix devices only) Displays the Global EQ window—see page 

41.

Help
• HX Edit Online Help - Takes you to the Line6.com Support site where you can 

find the helpful info on HX Edit and Helix & HX devices.
• HX Edit Application Pilot's Guide - Launches the PDF you are reading now.
• About HX Edit - (Windows only) Launches the About box, which includes the 

software version and legal credits.

Devices
Displays a selectable option to open or close an individual HX Edit application window 
for each connected Helix or HX device. A check mark appears to the left of each device 
here to indicate when its window is open. Also see “Multi-Device, Multi-Window 
Support” on page 3.

Preferences, Help & Account Options
At the bottom left of the application window, click on the menu buttons to access the 
app’s Preferences, Help & About Box, (see page 42) and My Account options (see 
page 45)

Preferences Help/About Account Options
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Presets Panel
The Librarian's Presets tabbed panel provides functionality for importing, exporting, 
and managing presets & setlists.

Setlist Commands

Presets Tab

Setlist Menu

Loaded Preset

Selected Preset

Preset Commands

The Presets panel

You'll find the same commands for copying, pasting, renaming, importing, and exporting 
within the application's File & Edit menus. These commands are also accessible via 
“Keyboard Shortcuts”. 

TIP: Helix device presets, setlists and bundles can also be imported and utilized 
within other Helix devices and the Helix Native plug-in! Please see “Preset 
Compatibility” on page 4 for more info.

HX Device Owners: All functionality described in this chapter is the same for 
use with all Helix and HX devices, unless otherwise noted.

Premium Marketplace Presets
If you've purchased and downloaded premium Helix or HX presets from the Marketplace, 
you must be Signed In to your Line 6 account within HX Edit and have your computer 
Authorized to allow HX Edit to initially Import or Export these presets (as well as for any 
setlists or bundles that include premium presets).*

*NOTE: Once you've initially imported your Marketplace assets to sync their 
licenses with your account, you don't need to have HX Edit actively Signed In to 
use them—and it is not necessary to even be connected to the Internet once your 

computer has been Authorized, except to Deauthorize the computer. Please see 
“Authorize / Deauthorize Your Computer” on page 47. 

Premium Marketplace presets are otherwise able to be utilized just like any other Helix 
presets. When imported, these premium Marketplace presets are indicated by guitar 
pick “badges” to their right within the Presets panel.

Premium Marketplace presets are indicated with golden guitar pick badges

Selecting, Loading & Saving Presets
It is important to note there is a difference between the selected and loaded preset 
within the Presets panel.

To Select a Preset - Click once on a preset location in the Presets panel and 
you'll see it become highlighted in gray. This indicates the preset is selected, 
meaning that a preset command (Copy, Paste, Import, etc.) will act upon this 
preset (even if a different preset is the one currently loaded within the Signal Flow).
To Load a Preset - Double-click on any preset (or click once to select it and 
then hit your Enter/Return key) and you'll see the preset highlighted and with 
amber colored text, indicating it as the preset currently in use. If no other preset is 
currently selected (highlighted in gray), menu commands will act upon this loaded 
preset, since it is effectively also the selected preset. 
To Save a Preset - Once a preset is loaded from the Presets Library and edited, 
you’ll most likely want to save the preset to retain your changes.* To save the 
Preset to your device’s library, choose the Save or Save As option from the 
app’s File menu, or click the Preset Save button  that appears at the top of the 
Signal Flow panel (see “Naming & Saving the Preset” on page 19). Also see 
the next section for the option to Export a preset to save it to your computer.

*TIP: Before editing a preset you may wish to first copy it to another location in the 
Presets panel, or export it, to be sure you have an original version of the preset 
before making changes.
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Importing and Exporting Preset Files
Presets are able to be exported to your computer as individual (.hlx) files, 
allowing you to create a limitless collection of tones that can be imported back 
onto your device's internal preset library at any time. 

To Import a Preset File - It is recommended to select an empty “New Preset” 
location within the Presets panel and select the Import Preset command. A 
brief dialog will inform you that importing will overwrite any preset information in 
the selected location. Click Yes to continue. A system window will display a file 
browser for selecting the preset you wish to import. Once imported, the preset 
will reside on your Helix or HX device's internal memory, within the selected 
preset location.
To Export a Preset File - Select the preset by single-clicking on it in the Librarian 
- Presets panel and select the Export Preset command. This creates a copy 
of the preset in its last-saved state from your Helix or HX device's memory and 
saves it to your computer. The familiar “save” window is presented, in which you 
can edit the filename and choose a destination folder. 

TIP: If you happen to own both a Helix (or Helix Native plug-in) and HX device, it is 
recommended to export your HX Stomp and HX Effects presets into their own, 
individual directories to avoid mixing them up with Helix and Helix Native plug-in 

preset files. 
Note that presets are exported in the format of the specific device you are using, which 
determines its behaviors for use with HX Edit preset translation and Helix Native’s 
Hardware Compatibility modes—see “Preset Compatibility” on page 4.

Renaming, Reordering, Copying and Pasting Presets
These functions allow you to customize your presets within the Presets panel. Choose 
Rename, Copy or Paste from the row of preset command buttons or application's 
Edit menu and it will act upon the selected (highlighted) preset. You can also right-click 
on a preset in the list to open a context menu with these same commands. For most 
commands, it is also possible to multi-select a number of presets by using Shift+Click 
to select a contiguous set of presets, or Cmd+Click (Mac) or Ctrl+Click (Windows) to 
select a non-contiguous set.

TIPS: There is no command to “delete” a preset, but you can right-click on a block 
within the signal flow and use the Clear All Blocks command.

NOTE: Copy and Paste of presets and IRs between HX Edit and Helix Native, or 
between multiple HX Edit device app windows is not currently supported. 
However, you can use drag and drop for these actions! See the next section. 

Drag and Drop Presets
It is possible to drag and drop any preset (or multi-selected presets) directly from the 
Presets panel to perform the following actions.

• Import - Drag a .hlx preset file from any computer folder and drop directly onto 
a Presets panel slot to import it into the device’s Presets Library.* This import 
action replaces and overwrites the slot’s existing preset. 

• Import and Load - Dragging a preset from a computer folder and dropping 
it directly into the currently loaded preset’s slot within the Presets Library, or 
dropping it directly into the Signal Flow window, will both Import the preset and 
load it as the new current tone, replacing the previous tone. (Note that if you 
drag and drop a preset into a slot that is not that of the currently loaded preset, 
this will import the preset into the library, but not also load it.)*

*NOTE: If you import a preset that was created with a different source Helix/HX 
device (or created with a different Helix Native HC mode) than currently in use,  
HX Edit will attempt to translate the preset for the current device. (See “Preset 

Translation” on page 4.) 

• Export - Drag one or multiple presets from the Presets panel and drop into any 
folder on your computer to export a copy of the .hlx preset file(s) there. 

• Reorder - Drag vertically to another location within the Presets panel to reorder 
the presets within the setlist as desired. When the preset is dropped into the 
new location slot, the surrounding presets are shifted upward or downward 
accordingly.

• Copy Between Two Devices - If you have multiple devices connected, it is 
possible to drag and drop presets between the multiple HX Edit device app 
windows' Presets panels, or directly into the Signal Flow, assuming the presets 
can be translated between the device types. (See “Preset Compatibility” on 
page 4.)

• Copy To/From Helix Native Plug-in - (Helix devices only) Drag a preset from 
the plug-in's Presets panel and drop directly into the Presets panel of the HX 
Edit app to import and load the preset on your Helix device, replacing and 
overwriting the previously loaded preset. Likewise, you can also drag and drop 
presets from HX Edit into Helix Native plug-in (see “Preset Compatibility” on 
page 4).

Importing and Exporting Setlists
The Presets panel allows you to instantly save the currently loaded setlist, 
including all its saved presets, to a Helix setlist file (.hls). This is very handy for 
making a backup of all presets within a setlist, so that a group of presets can 
easily be loaded back into your Helix in a single action. 

HX Device Owners: A Setlist for your HX Stomp/Effects consists of all presets 
within the device's preset library. Similar to the steps described here for Helix 
devices, you can use the HX Edit Import Setlist and Export Setlist commands, 
found within the app's File menu.
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To Import a Setlist - Select the Import Setlist command. This will prompt you 
to ensure that you wish to replace the currently selected setlist and the presets 
therein. Continue through the Open window to select the setlist you wish to load 
onto your connected device.*

*NOTE: If you import a setlist that was created with a different source Helix/HX 
device (or created with a different Helix Native HC mode) than currently in use,  
HX Edit will attempt to translate its presets for the current device. (See “Preset 

Translation” on page 4.) 

To Export a Setlist - Select the Export Setlist command to display the Save As 
dialog. 

Changing Setlists
(Helix devices only*) To change the active setlist shown in the Presets panel, click on 
the Setlist menu and choose from among your device's setlists. The currently-selected 
setlist will be indicated with an “open folder” icon in this menu.

*HX Device Owners: With an HX device in use, there is no Setlist menu, since 
these devices’ Presets Libraries include only one setlist. However, you can use 
the Import Setlist option to replace the current setlist with one saved on your 
computer.

Renaming Setlists
To rename the current setlist, right-click on the setlist name within the Setlist 
menu and type in your desired title.

HX Device Owners: The single Setlist on your HX Stomp/Effects displays no 
name on the hardware or within HX Edit. However, you can edit the Setlist's file 
name when Exporting the file to your computer.

Importing and Exporting Bundles
A Bundle file (.hlb) includes all 8 setlists' contents of your Helix device, including 
all their presets and saved settings, wrapped up in a tidy package.* This makes it 
easy to export to create and store a backup of your Helix device's complete 

Preset library, and easily restore your device's Presets library to your device (or to the 
Helix Native plug-in) by importing the bundle. 

NOTE: Bundle files do not contain any of the Helix device's Global Settings or 
Impulse Response (IR) files. To include all these Helix items, use the Create & 
Restore Backups feature—see page 21. 

*HX Device Owners: HX Stomp/Effects devices do not support Bundle files, 
therefore, you will see no available Bundle options.

The Import Bundle and Export Bundle options are found in the application's 
Preferences > Presets/IRs tab (see “Preferences and About Box” on page 42). 

Bundle options within the Preferences window (for Helix devices)

To Import a Bundle - Click the Import Bundle button and you'll be prompted 
to replace all setlists and presets within your Preset library. Continue through the 
File – Open window to select the bundle you wish to import. Note that you can 
optionally import any bundle that was exported from the Helix Native plug-in or 
any Helix device.
To Export a Bundle - Click the Export Bundle button to create a copy of all 
presets and their last-saved settings that exist in all setlists as a Helix bundle 
(.hlb) file. 

NOTE: On the next power up of your device after importing multiple presets, or 
importing any setlist or bundle, you may see your device perform an additional 
“Rebuilding Presets” process during boot up. This process is normal and optimizes 

preset loading times on the hardware. 

TIP: Wanting to restore the Factory Presets & settings for your device? You can do 
so by performing a Factory Restore—please see your Helix or HX device's Owner's 
Manual for details (and remember to use HX Edit to first do a backup of your 

current presets!)

TIP: Visit the line6.com/customtone site to share your tones and download from 
the huge online library of artist and user presets!

https://www.line6.com/manuals
https://www.line6.com/manuals
http://line6.com/customtone
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Impulses Panel
The Librarian's Impulses tabbed panel provides a list of all Impulse Response files 
(along with respective ID numbers in the left column) that currently reside on your Helix 
or HX device. Initially, this Impulses panel is empty, awaiting your import of Impulse 
Response files.

IR Commands

IR Index Numbers
Selected IR

Impulses Tab

The Impulses panel

HX Device Owners: IR files can be used by all Helix and HX devices. All 
functionality described in this chapter is the same for use with all devices, 
unless otherwise noted.

What are Impulse Responses?
Impulse Responses (or “IRs”) that can be used in Helix & HX devices are audio files that 
are the result of capturing the sound of a test tone (frequency sweep) through a guitar or 
bass amp speaker cabinet, which has been de-convolved with the original tone signal. 
This represents the frequency response of the miked cabinet itself, and can be used to 
simulate the way it alters the sound. This is similar to a convolution reverb, but with a 
much shorter decay. 
Add an IR block to your preset as an alternative to using one of the Cab blocks to 
provide speaker cabinet simulation. Several companies now offer large selections of 
professionally recorded IR files that can be used in Helix devices, or you can even do 
some research on how to record and create your own. Feel free to jump on your favorite 
guitar gear forums and join the ongoing, sometimes heated, discussions about the best 
and most realistic IRs, and methods to create them.
You can also find some IRs that were created using this convolution process to capture 
the properties of acoustic guitar bodies, guitar pickups and other sources. These IRs 
can certainly be used in the Helix IR blocks as well, to allow even deeper tone sculpting! 

TIP: Line 6 offers a free pack of IRs from Allure. You can grab them now at http://
line6.com/allure/.

You can also find a great selection of IRs, specifically created for Helix products, on the 
Marketplace—see page 45.

IR Formats and Restrictions
For all Helix and HX devices, as well as Helix Native plug-in, the following IR file types 
are supported.

• Helix Impulse Response (.hir) - This is the proprietary Line 6 IR file format. All 
IRs purchased through the Marketplace are of this file type. (Please also see 
“Marketplace & Account Options” on page 45.)

• WAV (.wav) - Most IR producers and vendors typically offer IRs within the .wav 
format. It is possible to import a mono or stereo .wav file IR, regardless of its bit 
depth, length, or sample rate frequency. While this is very convenient, please 
be careful to import only .wav files that were created specifically for use as IRs, 
not just any audio .wav file, or you may experience unexpected sonic results.

Helix Native Plug-in Users: If you plan on utilizing your Helix presets on both a 
Helix device and Helix Native plug-in, the best practice to import the same exact 
IR files into both, and in the same IR list order. This allows all IR blocks to reference 

and load the same indexed IR files for all presets that use them. Please also see “Preset 
Compatibility with Helix Native Plug-in” on page 4. 

Importing and Exporting Impulse Responses
To access the IRs stored on your Helix or HX device, click on the Impulses tab. From 
here you will be presented with a list of up to 128 IRs and their index numbers. 

NOTE: Premium Helix IRs purchased from Marketplace are also imported & 
exported using the following steps. It is required that you have Authorized your 

computer, and that you are Signed In to your Line 6 account in HX Edit to initially Import 
or Export them. Once imported into HX Edit, no active Internet connection is necessary 
to utilize your Marketplace IRs. Please see for “Marketplace & Account Options” on 
page 45 details.

To Import an IR, first select the desired index location in the application's Impulses 
panel and select Import. Select the desired IR .hir or .wav file you wish to load onto 
your device. It is also possible to select multiple IR files and all will be imported in one 
action. 

http://line6.com/allure/
http://line6.com/allure/
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When premium Marketplace IRs (.hir files) are imported, they are indicated by a golden 
guitar pick “badge” to their right within the Impulses panel.

Premium Marketplace IRs are indicated with a golden guitar pick badge

To Export an IR, click Export to display the Save As dialog.
You can also drag and drop to and from the Impulses panel to export and import IRs—
see the following section.

TIP: Use the File menu's Create Backup & Restore From Backup options to 
create a backup of your Impulses Panel's contents, and restore from the backup, 
at any time—see “Creating & Restoring Complete Device Backups”.

Renaming, Loading, Copying, and Clearing IRs
Several actions can be performed by clicking the commands above the Impulses 
list view, which will act upon the selected (highlighted) IR. You can also right-click to 
choose these options from the context menu (or use the app's “Keyboard Shortcuts”).

NOTE: Copy and Paste of presets and IRs between HX Edit and Helix Native, or 
between multiple HX Edit device app windows, is not currently supported. 
However, you can use drag and drop for these actions! See the next section. 

Drag and Drop IRs
There are several drag and drop options that allow you to import and export single or 
multiple IR files between your computer’s directories and HX Edit, as well as load IRs 
into your current tone. 

• Import - Drag one or more IR files from your computer folder directly into the 
Impulses panel. When multiple files are being dragged in, they are imported  
starting with the selected IR index slot. 

• Export - Select one or more IR index locations and drag from the Impulses list 
view directly to your computer to export the IR files to the selected hard drive 
folder.

NOTE: When exporting IRs from the HX Edit IR panel, any Marketplace 
purchased IR is saved to your computer as a Helix IR (.hir) type file. The .hir 
files are proprietary to Line 6 products, and licensed to you via the Line 6 
Account on which you purchased them. Any IR that was originally imported 
as a .wav file is exported as a .wav file. 

• Copy - It is also possible to drag and drop IRs within the Impulses list view to 
create a copy of the IR in a new index location.*

*NOTE: There are no options offered to move or reorder IRs in a single 
operation. Use the Copy, Paste and Clear functions to rearrange IR within the 
Impulses list as needed. 

• Copy Between Helix / HX Devices - If you have multiple devices connected, 
it is possible to drag and drop IRs between the multiple HX Edit device app 
windows' Impulses panels to copy them between devices.

• Copy To/From Helix Native Plug-in - With an instance of the Helix Native 
plug-in open, drop IRs from the HX Edit application's Impulses panel directly 
into the Impulses panel of the Helix Native. It is also possible to drag IRs from 
Helix Native directly into the Impulses panel of HX Edit to import copies of the 
same IRs.

• Load into Current Tone - Once you’ve imported one or more IRs into the 
Impulses Library, you can drag any IR from the Library window and drop it 
directly into the desired position within the Signal Path in the Edit window to 
create an IR block loaded with the IR file. Also see the next section.
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Loading an IR in an IR Block
When you insert an IR block within your preset's Signal Flow from the Model 
Menu, it initially defaults to referencing the IR that resides within the #1 IR index 

location (if you have not yet imported any IR file into the referenced index location, the 
“empty” IR block has no effect on the signal). 
To follow are a few methods for loading an IR into an IR block, which determines the IR  
file that is associated with the IR block (also see “IR File Reference” on page 16 for 
additional behaviors).

Use the Edit tab’s IR Select slider - Select the IR block within the Signal Flow, 
then, in the Edit tab, use the IR Select parameter slider (or its menu at the 
right) to select IR index number (1-128) that includes the desired IR.

Choosing an IR by its Library (1-128) index number within the Edit tab

Double-click in Library - Select the IR block within the Signal Path and then 
double-click on the preferred IR within the Impulses Library list to load into 
the IR block—replacing any currently referenced IR. Note that no action is 
performed if you do not have an IR block selected.

Drag and drop - As mentioned in the preceding section, you can also add 
an IR block already loaded with an IR by dragging the desired IR from the 
Impulses Library panel and dropping it directly into an empty location within 
your Signal Path. (Drag and drop from the IR Library always adds a 1024 
Sample type IR block.)

You can use the other IR block parameter sliders in the Edit tab to further shape the IR's 
tone and level—see “Editing Model Parameters” on page 29. Once done selecting 
an IR and its parameter options, be sure to save the preset to retain your IR block 
settings.

TIP: Optionally, you can create a Snapshot assignment (see page 36) on the IR 
Select parameter, which then allows you to change the IR within the block as 
desired, per snapshot!

Whenever you load a preset that includes one or more IR blocks that reference an 
empty IR index location, a pop up is displayed to alert you. For example, the alert 
shown below is telling you that the preset includes two IR blocks, on Paths 1A and 
1B, which cannot locate their originally associated IR files. The “Position” denotes the 
block position of each IR block from left to right on the path, starting with “0” for the left 
position. Please see the next section for more related IR behaviors.

Missing associated IR(s) alert pop-up

IR File Reference
Once an IR block is configured to utilize an IR index slot that includes an imported IR 
(.wav or .hir) file, and the preset then saved (using HX Edit and device firmware version 
2.90 or later), the preset creates a “reference signature” to the imported IR from its 
file name. Therefore, if you re-order IRs within the IR library list, your preset will still 
intelligently reference the originally associated IR file, even if it now resides in a different 
IR Library index location. The following behaviors apply:

• If you clear or replace the IR file within the IR index slot for which the preset’s 
IR block is configured to use, upon the load of the preset, the IR block will first 
attempt to locate another instance of the missing, associated IR file within the 
Impulses Library and automatically utilize it and its residing index slot. 
• If the configured IR index slot is currently empty, you’ll be alerted that the 

IR block’s associated IR file cannot be found (see previous section). The IR 
block continues to utilize the same (now empty) IR index slot. You’ll want to 
configure the IR block to utilize an occupied IR index slot (or import an IR into 
the currently referenced slot) and save the preset.

• If the original IR file is cleared from the Library and the IR index slot now 
includes a different IR file, you’ll be alerted that the associated IR cannot 
be found, and the IR block utilizes this new IR file within the configured 
index slot. You’ll need to save the preset with this reference to the new IR (or 
configure the IR block to use a different, occupied IR slot) to avoid seeing the 
alert pop-up on future loads of the preset.

• Once an IR block is configured with an IR Library index selection, and the 
preset then saved, the IR (.wav or .hir) file retains this reference signature when 
exported from the library—thus, even if you import the exported IR file again 
into any index slot within your Impulses Library, the saved preset’s IR block will 
still be able to locate and utilize it.*
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Yes, the above rules all sound a bit complicated, but in typical use, all this really just 
means that if you happen to move your IRs around in the IR Library list, your saved 
preset will now not lose their link to them!

*NOTE: The IR file reference functionality is also incorporated in the Helix Native 
plug-in (version 1.90 and later). Therefore, presets exported from Helix Native  

will exhibit the same behaviors and attempt to locate their referenced IR .wav files 
from within the HX Edit IR library upon loading. Likewise, presets exported from HX 
Edit will attempt to locate their IR blocks’ referenced IR .wav files when loaded within 
Helix Native. The moral of the story here is simply to import the same IR .wav files into 
both HX Edit and Helix Native if you plan on sharing your crafted presets between 
them, and the proper IRs will automatically be utilized from your IR library, regardless 
the IR slots where they reside.

NOTE: We highly recommend using the Create Backup feature in HX Edit to make 
it easy to restore your complete preset and IR libraries (see page 21). Immediately 

after performing a Restore From Backup, it is also best to power your device off and 
on again and allow all presets to “rebuild,” for best preset performance and IR file 
reference functionality. 
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Working in the Editor
The Editor portion of the HX Edit user interface consists of the Signal Flow and Inspector windows. The Signal Flow window is where you'll see the signal paths for your currently-
loaded preset, appearing much like the Home screen of your Helix, or Signal Flow screen of your HX device. The Inspector window below contains 2 tabbed panels, Edit & Bypass/
Controller Assign, where you can select models, tweak parameters, configure controllers and more. Regardless which of these tabs you have selected, the current preset's Name Field, 
Save, Snapshots, Undo, & Tempo options are always available at the top of the window. Additionally, there are dedicated windows for the Command Center for MIDI assignments (Helix 
& HX Effects only—see page 37), and the Global EQ (Helix & HX Stomp only—see page 41), accessible from the application's Window menu. If you have not already done so, be 
sure to read through the in-depth information in your device's Owner's Manual to get an understanding of the features we'll be covering in the following sections.

 HX Device Owners: HX Edit application functionality described within this chapter is the same with Helix or HX devices, except where noted.

Preset Name Field Preset Save Button Snapshots Menu Undo / Redo Buttons Tempo Controls

Edit & Bypass       
Controller Assign Tabs

Signal Flow Window

Librarian Show/Hide
Button

Inspector Window

http://line6.com/support/manuals/
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Naming & Saving the Preset
The Preset Name field at the top of the Editor displays the title of the currently loaded 
preset. Double-click on the text here to optionally rename the preset. Whenever you see 
your preset's title appearing in italicized text at the top of the Signal Flow window, it 
indicates that the preset has been edited from its last-saved state. 
The Preset Save button at the top of the Editor launches the Save To Library  window, 
where you can optionally re-title the preset in the Name field, and then choose the 
desired Setlist and Preset location to save the currently-loaded tone, overwriting the 
preset that resides within the selected location. (The currently loaded preset is selected 
by default, so you can overwrite it simply by clicking the OK button.) 

The Preset Save To Library window

Alternatively, you can choose the Preset Save or Preset Save As command from the 
HX Edit – File menu. As covered in “Presets Panel” on page 11, there are also the 
Librarian window options, Copy and Export, to create & store copies of your presets. 

Configuring & Managing Snapshots
Your device offers the ability to configure the 8 snapshots within a Helix preset (or 3 
snapshots of HX Stomp preset, or 4 snapshots of an HX Effects preset), allowing you 
to recall a customized set of options for your current blocks instantly, without the brief 
lag time associated with changing presets! A snapshot is capable of storing the bypass 
state of any amp or effects block, up to 64 assigned parameter values, tempo settings 
and more (please see your device's Owner's Manual for specifics). 
There are two ways to select a snapshot within HX Edit: by clicking on the Snapshots 
menu at the top of the Edit window, or by using the commands within the application's 
Snapshots menu. To edit its settings, select the numbered snapshot you want as your 
destination, then configure the desired tone options for this snapshot.*

The Edit window's Snapshots menu The menu bar's Snapshots menu

*NOTE: You can use your device's Global Settings > Preferences > Snapshot 
Edits to choose between Recall (automatically stores your changes to the current 
snapshot) versus Discard (does not store changes to the current snapshot). 

The camera icon within the Edit window's Snapshots menu is displayed in red  
when the hardware's option is set to Discard.

Once your desired destination snapshot has been selected, use the following steps to 
configure your settings. 

To Store a Block's Bypass State Per Snapshot - Click on the Bypass button 
above any block within the Signal Flow and set your desired bypass state for the 
block (or you can toggle the block's Bypass button within the Edit tab). Any amp 
or effects block’s Bypass state will, by default, be remembered and recalled per 
Snapshot. 
If you prefer to exclude a block from being controlled by Snapshots, select the 
block and set the Snapshot Bypass option from the block’s right-click menu to 
“off” (so that no check mark appears at the left of the menu option). Or, you can 
right-click on the block’s Bypass button within the top right of the Edit tab and 
access the Snapshot Bypass command from its menu. Choosing the Snapshot 
Bypass option from the menu again (so that the check mark appears at the left of 
the menu command), returns the block to the default Snapshot behavior.

Block right-click menu

Edit tab - Block Bypass button right-click menu

The Snapshot Bypass option

http://line6.com/support/manuals/
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To Store a Parameter's Values Per Snapshot - Select the desired block within 
the Signal Flow, then right-click directly on the desired parameter's slider within 
the Edit tab and choose the Snapshots controller option. This creates the 
snapshot assignment for the parameter. 
You can then simply load a snapshot and adjust the snapshot-assigned 
parameter to the desired value. Repeat this step for each snapshot as desired, 
and the parameter values are stored and recalled with each snapshot. We cover 
more about configuring controller options in “The Bypass/Controller Assign Tab” 
on page 31.
To Store a Command Center Messages and Command Values Per Snapshot 
The Value parameters of any instant MIDI CC, Bank/Prog, and MMC message, 
plus the state (Dim or Lit) of any CC Toggle and Ext Amp messages are always 
stored and recalled when selecting a snapshot. Therefore, there is no need 
to manually set any of these parameters to a snapshot assignment within the 
Command Center—see page 37. 

Attention Helix Native Plug-in Users: Snapshot settings are compatible within 
presets between Helix, Helix Rack & Helix LT devices and the Helix Native plug-in! 

Copying, Pasting, Renaming & Customizing Snapshots
The Copy and Paste Snapshot commands are available within the app's main menu. 
Or, (for Helix or HX Effects devices) right-click on the Edit window's Snapshots menu to 
access these commands as well as the snapshot Rename and LED color customization 
options. These snapshot name and LED color options affect the scribble strip names 
(or names in Performance View on Helix LT) and footswitch LED colors when the 
footswitches are in Snapshot Select mode.

The context menu for the Snapshots menu name field (Helix or HX Effects devices)

To Copy & Paste a Snapshot - It is possible to copy all the settings of one 
snapshot and paste them to another snapshot within the same preset. Select 
and load the snapshot you wish to copy and select Copy. Then select and load 
the snapshot you wish to overwrite and choose Paste to paste the clipboard 
contents, replacing the currently loaded snapshot. 

NOTE: The action of pasting a copied snapshot is not tracked by the HX Edit 
Undo / Redo feature (also see next section). 

To Rename a Snapshot - (Helix and HX Effects devices only) Right-click the 
desired snapshot from the Snapshots menu and select Rename Snapshot. Type 
in your new name, then press Enter/Return on your keyboard.
To Customize a Snapshot's LED Color - (Helix and HX Effects devices only) 
When your device is set to Snapshot footswitch mode, each footswitch LED 
defaults to a red color. If you prefer to customize the LED color for the current 
Snapshot, choose the desired color from the right-click menu. Or choose Auto to 
restore the default behavior, or Off for no LED.

NOTE: Remember that you'll need to Save before switching to another preset to 
retain your edited snapshot settings within the current preset! The snapshot that is 
in use when you save your preset is the one that is recalled when the preset is 

loaded again.

Undo / Redo
The HX Edit application supports Undo and Redo for most editing actions within the 
Signal Flow and Edit tab of the current preset, whether the edits are made within HX 
Edit or directly on the connected Helix/HX hardware, accessible via the Undo and 
Redo buttons at the top of the main window (or from the Edit menu).* The Undo / Redo 
history is tracked individually per device window (if you happen to have more than 
one Helix/HX device connected). Your Undo / Redo history is retained until you load a 
different preset, exit the application, or disconnect or power off your connected Helix 
or HX device. 

*NOTE: Also see “Software Edits vs. Hardware Edits” on page 21 for additional 
behavior details. 

The Undo and Redo buttons

Undo is available for most actions performed within the Signal Flow and Edit tab 
in HX Edit, including:

• Parameter changes
• Snapshot selection
• Block model changes
• Signal path changes (block bypass states, adding/cutting, clearing blocks, 

changing path structure, etc.) 
• Hardware edits and edit actions performed via external controller and MIDI 

CC & PC messages (see “Software Edits vs. Hardware Edits” on page 21)
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Actions that are not available for Undo/Redo include the following:

• Tempo changes
• Actions performed within the Presets and IR Library windows (e.g., changing 

setlists, loading a different preset, importing, reordering, or pasting presets or 
IRs, etc.)

NOTE: The application’s Undo history is cleared whenever a different preset 
is loaded . 

• Adding, editing, and removing Snapshot, Bypass, and Controller assignments 

NOTE: Note that when Undo restores the removal of a block that includes 
assignments, in most cases, these assignments are restored with the 
block, but in some cases may not be able to be retained.

• Pasting a copied Snapshot and/or the Snapshot title
• Changes to any settings within the HX Edit Preferences, Command Center, 

and Global EQ windows

NOTE: The Undo button and Edit menu command remains unavailable (dimmed) 
until an undo-able action is performed in HX Edit. Likewise, Redo remains 
unavailable until an Undo action is applied.

Software Edits vs. Hardware Edits
Edit actions performed within the HX Edit application (or “software edits”) are tracked 
individually for Undo / Redo. For example, if you adjust an HX Edit parameter slider, 
move a block, and then change a block’s model, these actions are reverted individually—
one action per each click of Undo. 
Edit actions performed directly on your connected Helix/HX device and via external 
MIDI control (or “hardware edits”), are aggregated into a separate, single undo-able 
action within the Undo history. Therefore, if you perform a number of hardware edits and 
then choose Undo, all such edits are reverted in one click of Undo. Likewise, selecting 
Redo after performing an Undo of several hardware edits restores all the hardware edit 
changes in one click of Redo.

Editing the Tap Tempo
There are a few options available for configuring the tempo, accessible from the Tempo 
Controls at the top of the Signal Flow window. Any of the current preset’s effect models 
set to note division values will follow this Tap Tempo value. (Note Sync mode is available 
for most delay and modulation effects—see page 29.)

Tempo Select 
Menu

Tap Tempo 
Button

      The Tempo Controls

How the Tempo Value is Recalled
Use the Tempo Select menu to choose how the tempo value is saved and recalled 
(this is the same option found in your Helix or HX hardware's Global Settings > MIDI/
Tempo screen):

• Per Snapshot - The tempo value is stored and recalled individually per snapshot 
for the current preset.

• Per Preset - The tempo value is stored and recalled individually with this preset.
• Global - The tempo value is used for all presets whenever set to Global.

NOTE: Your Helix device's tempo can also be configured to follow MIDI Clock from 
an external source, accessed from within your device's Global Settings > 

MIDI/Tempo screen. When your device is actively following MIDI Clock, all options for 
the Tempo Controls are disabled and the Tempo value displays as “[External].”

Entering a Tempo Value
To enter a value, click on the Tap Tempo button rhythmically, or right-click directly on 
the Tap Tempo button and type in your desired numerical value.

Creating & Restoring Complete Device Backups
Use the File menu's Create Backup and Restore From Backup commands to create 
complete backups of your Helix or HX device's current Global Settings, IRs, and 
Presets, and easily restore them back to your device at any time. All presets are backed 
up from their last-saved state, therefore, be sure to save your currently-loaded preset 
before creating your backup to include its current settings.

NOTE: If you have purchased and imported Marketplace premium presets or IRs, 
your computer must be in the Authorized state to be able to use the Create Backup 

and Restore From Backup features, if the backup includes Marketplace premium 
assets. See “Authorize / Deauthorize Your Computer” on page 47. 

TIP: Backup files (.hxb) created using the Create Backup feature for any Helix 
(Helix Floor, LT or Rack) device can then be “Restored” onto any other Helix device. 

This allows you to easily duplicate all your applicable Global Settings, Presets, and IRs 
to another Helix in one action.

Backup files created for HX Stomp devices are compatible only with HX Stomp 
type devices, and HX Effects backup files are compatible only with HX Effects 
type devices.
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To Create a Backup
Select the Create Backup command from the File menu to launch the window.

The Create Backup window (Helix device)

1. Name - Your backup file is automatically named with the type of device (Helix 
Floor, Helix Rack, Helix LT, HX Stomp or HX Effects) and the current date. Op-
tionally, you can click directly on the file name here and edit it as desired.

2. Description - Optionally, you can type in some descriptive notes about this 
backup. All text added here is saved with your backup, and viewable during the 
Restore From Backup process.

3. Where - By default, your Backup file (.hxb) is saved to the following  directory 
on your computer:
• Mac - /Documents/Line 6/Tones/Helix/Backups folder
• PC - \My Documents\Line 6\Tones\Helix\Backups folder

If you wish to save to a different folder, click the folder button and browse to 
select your preferred disk location.

4. Click Create Backup and you'll see the progress of your backup being created, 
and a message once completed successfully (or click Cancel to exit without 
creating a Backup).

You can repeat the above steps at any time to create as many individual 
backups as you like. All compatible backup files for your connected Helix or 
HX are then available within the Restore From Backup window.

TIP: It is highly recommended to create a full Backup before installing device 
firmware, and to perform backups regularly to make sure you always have copies 

of your tones, IRs and settings! 

To Restore From a Backup
Select the Restore From Backup command from the File menu to launch the window.

The Restore From Backup window (Helix device)

1. Backup Folder - The default or most-recently used Backup folder is selected 
here. If you want to find a backup file in a different folder, click the folder button 
to browse to the desired location.

2. Backup File - All compatible Backup files (.hxb) that you created within the cur-
rently selected directory are selectable here. When you select a backup file, the 
following information is displayed so you know the details about the backup 
before you choose to restore from it.
• Date: The creation date of the backup file.
• Device: The specific type of Helix device this backup was created from (Helix 

Floor, Helix Rack, Helix LT, HX Stomp or HX Effects).
• Version: The firmware version installed on the device when the backup was 

created. 
• Description: Any notes that you entered within the Description field when the 

backup was created appear here.

3. Items to Restore - In the lower pane, you can select the individual items you 
wish to be restored from the selected backup file: Global Settings, Impulse Re-
sponses and Presets. Whichever items you select here will be restored, over-
writing those currently on your Helix device.
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TIP: For Helix, Helix Floor & Helix LT devices, note that by clicking on the arrow 
to the left of the Presets checkbox, you can expand the option (as pictured 

above) to individually choose whichever Setlists you want to restore from the 
selected Backup!

4. Click Restore Backup and you'll see the progress of the restore process, and 
then a pop-up message once completed successfully (or click Close to exit 
without restoring). Do not disturb the HX Edit application or device until the 
Restore process is complete.

TIP: If the Backup that you restored includes any presets or setlists, it is highly 
recommended to power your device off and on again to allow it “rebuild” the 

presets. This process optimizes preset loading times and “IR File Reference” 
functionality.  

You can repeat the above steps at any time, and select any available Helix or 
HX Backup file stored on your computer. 
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The Signal Flow Window
The Signal Flow window allows you to directly access the Amp, Effects, Mix & Looper 
blocks within your preset and configure your signal path routing simply by clicking and 
dragging. Once you select any block within the Signal Flow, the Inspector's Edit tabbed 
panel below provides access to all its editable parameters. The options offered here are 
essentially the same as found on your connected Helix or HX device, making editing 
very straight-forward.

HX Device Owners: HX Edit application functionality described within this chapter 
is the same with Helix or HX devices, except where noted.

Split BlockPath 1A

Path 2A

Path 1B Merge  - Mixer Block

The Signal Flow Window (Helix device)

Split BlockPath 1A Path 1B Merge-Mixer Block

The Signal Flow Window (HX Stomp device)

Split BlockPath 1A Path 1B Merge-Mixer Block

The Signal Flow Window (HX Effects device)

Show/Hide Block Labels Option
If you prefer a cleaner look within the HX Edit app's Signal Flow window, you can “hide” 
the descriptive text labels that appear below each block using the Show/Hide option 
within the Preferences > View tab (see page 42). When set to hide the labels, you'll 
only see a block's label appear when hovering your mouse over the block.

Block Label Option Set to Show Block Label Option Set to Hide

Block Bypass Assignment Indicator
If you create a Bypass assignment for any Amp or Effects block within your tone (via 
any footswitch, EXP, or MIDI type hardware controller), you’ll see the block name label 
displayed in brackets, as shown below. Please see “The Bypass/Controller Assign 
Tab” on page 31 for the full info on creating Bypass assignments. (Note that if you 
happen to have the above-mentioned Show/Hide Block Label option set to “Hide” you 
won’t see these labels or indicators except for when hovering over the block.)

Bracketed block label indicate a block bypass assignment

Hardware Block Signal Indicators & Level Meters
As of firmware version 2.90, Helix and HX devices include real-time level indicators 
and metering for specific block types, which are very handy for visually checking and 
adjusting the gain staging throughout the signal flow of your tone. 

NOTE: These indicators and meters are visible only on the screen of your 
device, and not within the HX Edit application at this time. 

To follow are highlights of some of these features—please see the firmware v2.9x 
Release Notes for your device for more info.  

Signal Indicators
(Helix and HX devices) For all Input, Output, Send, and FX Loop block types within 
the Signal Flow, when an input or output signal is present, these blocks display with a 
green fill to indicate a signal is present. Whenever the signal level at any of these block 
types is too hot, a red fill color is displayed as a clip indicator (which means you should 
reduce the signal level of block(s) preceding the red indicated block, and/or the red 
indicated block’s own levels, to eliminate the clipping). 

Level Meters
(Helix devices) Whenever an Output, Send, FX Loop, Compressor, or Gate type 
block is selected within the Signal Flow, you’ll see its meter(s) appear within the lower 
Inspector panel of the Helix device’s Home screen. 
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• For Output, Send, and FX Loop blocks, the meter measures output level and 
is displayed green for normal signal levels. Whenever the signal is too hot, the 
meter is displayed red to alert you of clipping. 

• For a Dynamics - Compressor or Gate type block, the yellow meter measures 
the amount of gain reduction being applied by the effect.

Moving Blocks & Arranging the Signal Flow
To move blocks within a signal path, click and drag any block to its desired location. To 
follow are a number of pointers for arranging the signal flow in different ways.

HX Device Owners: You'll see only the HX Stomp/Effects device's single Path 1 
displayed within the HX Edit signal flow panel. The HX Path 1 can be similarly 
split to offer parallel Paths 1A and 1B, as shown in the preceding screenshots.

Path 1 / Path 2 (Helix devices only) - Unlike on the Helix hardware, within HX 
Edit it is possible to copy or move a block, including its current settings, between 
main Paths 1 and 2 via drag and drop. You can also Cut or Copy a block and then 
Paste into any desired location on the opposite path to re-locate it there, along 
with its settings intact—see next section. 
Split Paths - To create a split (or “parallel”) path, simply drag a block down 
from the main signal path (Path 1A or Path 2A) and you'll see a split path (Path 
B) appear, with both a Split and Merge block created at each end (as shown in 
images at the start of this chapter). Each path is stereo, with the audio content 
fed to each determined by the Split block type selected (see next section). To 
remove the split path, clear or move all blocks out of the parallel “B” path. 
Mix (Split and Merge-Mixer) Blocks - When a Split block is selected in the 
signal flow, you can choose from among 3 types of Split blocks, and adjust the 
balance options using the parameter sliders that appear in the Edit tab below. 
Note that you can click and drag the Split and Merge-Mixer blocks to position 
them however you like within the path. 

Split Path Options
There are four Split types you can choose from for any Split block. 

Split Y: By default, a Split > Y appears any time parallel Path B is created. Use 
the Balance A and Balance B (pan) parameters to adjust the left/right stereo 
balance fed to each stereo path, respectively.
Split A/B: Use the Route To parameter to determine the total amount of signal 
fed to Path A versus Path B.
Split Crossover: Splits the audio content so that treble frequencies are sent to 
Path A and bass frequencies are sent to Path B. Use the Frequency parameter to 
set the center frequency; Any signal above this frequency is sent to Path A, and 
any signal below this frequency is sent to Path B.

Split Dynamic: Similar to a crossover, except the audio content above the 
audio Threshold is sent to Path A, and the content below the audio Threshold 
is sent to Path B (or the path routing is reversed when Reverse is On). Attack 
determines how fast the signal routes to Path B once reaching the Threshold, and 
Release determines how fast the signal returns to Path A once falling below the 
Threshold—typically, higher values result in a smoother transition. Reverse, when 
On, flips the Path. 

Much like any effects type block, a Split block can be bypassed, as well as have a 
bypass assignment created for it_bypassing the Split block results in it feeding equal 
left and right signals to each stereo parallel path. Functionality for Split blocks and 
Paths differ slightly for Helix vs. HX devices, as detailed here.

Helix, Helix Rack & Helix LT Devices
If you drag a Split block down from Path A (or right-click on the Split block and choose 
Create Input), it will change into a separate Input block for Path B, which then offers a 
set of Input block options in the Edit panel. Likewise, if you drag a Merge block down 
(or right-click on the block and choose Create Output), it becomes a separate Output 
block for Path B. When dragged to Path B, the Split or Merge-Mixer block becomes 
inactive and no longer affects either of the signal paths.
This functionality is how you can potentially create up to 4 individual signal paths 
within one preset, each with its own input and output settings, as shown below. Once 
converted to Input & Output blocks, you can drag the inactive Split or Merge-Mixer 
block back up to the main Path A to restore each back to an active Split or Merge-Mixer 
block (or use the right-click options to Restore them).

Inactive Merge-Mixer blocksInactive Split blocks

Split paths converted to individual paths (Helix device)

HX Stomp and HX Effects Devices
On HX devices, once a parallel path is created, the Split block can be dragged left or 
right on Path A to re-position it as desired. (But unlike with Helix devices, a Split block 
cannot be moved down to convert it into a separate Path B Input.) 
It is possible to drag the Path A Merge-Mixer block down (or right-click on the block 
and choose Create Output), as shown in the following screenshot. This routes the Path 
B output separately to the hardware Send 1/2 output jacks, and the Merge-Mixer block 
becomes inactive in this Path B position. 
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Once converted to an output, drag the inactive Merge-Mixer block back up to the main 
Path A to restore the split path and active Merge block (or use the right-click option to 
Restore it).

Inactive Merge-Mixer blockParallel Paths A & B

Split path with Path B routed to the Send L/R Output (HX Stomp device)

Inactive Merge-Mixer blockParallel Paths A & B

Split path with Path B routed to Send 1/2 Output (HX Effects device)

Cutting, Copying, Pasting & Clearing Blocks
You can use the Cut Block or Copy Block commands for an existing processing (Amp, 
Cab, IR, FX or Looper) block, and then use one of the Paste Block commands to paste 
it, with all its current settings, into a new location within any path and within any preset. 
Use Clear Block to remove the selected block from the path. Once you've selected the 
desired block, these commands are accessed either from the menu bar's Edit menu, or 
from a block's (right-click) context menu (or via keyboard shortcuts—see page 58). 

Block Cut, Copy, Paste & Clear commands are available in the Edit menu or block's context menu

TIP: You can also use Copy/Paste, or drag and drop, to copy a block between  
separate HX Edit device windows, as covered below.

Use Cut Block or Copy Block and then any of the Paste Block commands in either 
HX Edit or Helix Native plug-in, as follows:

• Into any path within the same or a different instance of the Helix Native plug-in, 
and within any preset

• Into any path within the HX Edit app, and within any preset
• Into any preset within HX Edit when then connected to a different Helix or 

HX device (as long as the copied Block data is the last item copied to your 
computer's clipboard)

• Into an additional HX Edit application window—also see “Multi-Device, Multi-
Window Support” on page 3

Block Cut / Copy / Paste is allowed for all block types (Amp, Effects, Mix, Input and 
Output blocks), with some restrictions.* This provides great flexibility in re-creating 
tones between Helix Native, HX Edit, and even different Helix & HX devices.

*NOTE: Some restrictions apply for Copy / Paste of blocks, depending on the DSP 
capacity and features of the particular device in use. For example, just as any Helix 

Native plug-in or device preset will prevent adding some block or model types as the 
DSP limit is reached, the same DSP limit rules apply for Copy / Paste. Presets can also 
include only one Looper block, one use of each Send & Return, up to two IR blocks, 
etc. Therefore, Copy and Paste observes these Block rules as well. Physical inputs & 
outputs differ between Helix and HX devices (and between the different HC modes 
within Helix Native), therefore, the copying of Looper, Mix, Input and Output blocks and 
their settings may not be allowed, as covered throughout this chapter.

Cut Block - Clears the block from the Signal Flow and copies the block and its 
current parameter settings to the clipboard.
Copy Block - Copies the block and its current parameter settings to the 
clipboard. 
Paste Block - Pastes the most recently cut or copied block to the selected 
destination. If you select an existing block, this will replace the existing block and its 
settings. To follow are a few handy copy & paste tips.

• Paste Block After / Paste Block Before - If you select an existing block, you 
can alternatively choose either of these commands to paste the block in your 
preferred location. All these Paste Block commands are selectable within the 
main Edit menu, as well as from a block's right-click context menu.

• Mix type blocks (Helix devices only) - Copy & Paste are also available for any 
Input, Output, Split and Merge type block as well, where its settings can be 
copied & pasted into a location with the same block type. (When copying these 
blocks between different device types, which may include unique parameters 
per device, only common parameters are pasted.)

• When copying a block within the same window, or between separate HX Edit 
(and/or Helix Native) windows, all existing assignment types are copied with the 
block, except for any footswitch-based Bypass assignment.*

• When copying a block from HX Edit to Helix Native, it may not appear that 
its hardware-based controller assignments are retained, since the Helix Native 
does not support them. But if you copy the same block back into an HX Edit 
window again, you'll see its original assignments are indeed still intact.*
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*NOTE: When copying a block with existing hardware-based assignments, the 
assignments will not be retained if the destination device does not include or 

support the specific controller type (e.g., if copying a block with an EXP 3 controller 
assignment from a Helix Floor to an HX Stomp device, the assignment is not shown or 
supported, since HX Stomp includes no EXP 3).

Clear Block - Choose Clear Block from the application's Edit menu, from the 
block's (Right-click) context menu, or by clicking the “X” button that appears when 
you hover your mouse cursor over a block. Alternatively, you can select an existing 
block in the Signal Flow and choose None from the Edit tab's Model Browser. 

When hovering over a block, you'll see its Bypass and Clear buttons appear

Clear All Blocks - Available in the block's context menu, this removes all 
processing blocks from the signal flow. (Input & Output block settings remain 
unchanged.)

NOTE: Only one Looper block can exist within any preset at a time. Therefore, you 
cannot Copy and then Paste a Looper block within the same preset. But you can 

use the Cut Block command and then Paste Block to effectively “move” a Looper 
block, including its settings, to a new location, such as to a different path.  

Drag and Drop Blocks
You can also use “drag and drop” to copy/paste a block within the current preset, as 
well as between separate HX Edit and/or Helix Native windows. Copy or Move can be 
performed with any processing type blocks - Amps, Cabs, IRs, FX (as long as the block 
type is supported by the target destination’s Signal Flow). The following drag and drop 
actions are available.

• Drag and drop of a block anywhere within the current HX Edit Signal Flow moves 
the block (including when dragging between Paths).

• Holding the Alt/Option (Mac) or Ctrl (PC) key and performing drag and drop of a 
block anywhere within the current HX Edit Signal Flow copies the block. 

• Drag and drop of a block into the Signal Flow of any other HX Edit or Helix Native 
plug-in window copies the block.

• Holding the Alt (Mac) or Ctrl (PC) key and performing drag and drop of a block 
into any other HX Edit or Helix Native plug-in window moves the block. 

• Since performing a drag and drop of a block between separate windows is 
essentially the same as a Copy/Paste Block operation, the same rules and 
behaviors apply—please see the preceding section.

NOTE: When dragging a block, if you try to drop it on top of an existing block, you'll 
see the existing block shift left or right to place your dragged block before or after 

it. Unlike when using the Copy and Paste commands, it is not supported to replace an 
existing block via drag and drop.

Adding & Bypassing Blocks
To Add Any Type of Block to Your Tone - Simply hover your mouse cursor over 
the desired location on any path and you'll see an empty “None” block location 
appear. Once you select the location, choose any type of block from the Model 
List Menu in the Inspector's Edit tab below (see the following chapter for more 
info). If you select a location already occupied, choosing a different model from the 
menu will replace the selected block's model.
To Toggle the Bypass of a Block - Do any of the following:

• Hover your mouse cursor over a block within the Signal Flow and use the Bypass 
button that appears above the block. 

• Right-click on the block and choose Bypass from the context menu.
• Click on the desired block to select it, then use the Bypass button within the Edit 

tab.
• Click on the desired block to select it and hit the Spacebar.
• A block’s bypass state, by default, is also stored and recalled with each Snapshot  

(see “Configuring & Managing Snapshots” on page 19). 
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The Edit Tab
The Inspector window's Edit panel provides access to all models via its multi-level 
Model Browser, where you can choose from numerous categories of models to make 
up your tone. This panel also displays all available parameters for the block that is 
currently selected within the Signal Flow window, providing easy access for editing. 

HX Device Owners: HX Edit functionality described in this chapter is the same 
for all Helix and HX devices, except where noted. 

Selecting Models
As mentioned in the previous chapter (page 27), add models to your current preset 
by selecting the desired empty location on any path within the Signal Flow window and 
then choose the specific model you want from the Model Select Menu. You can also 
select any existing block within the Signal Flow and change its model this way.

 

List/Grid View Toggle

Category List Model List/Grid

Sub-category Menu

Parameter Sliders
The Edit Panel's Model Browser

Choose the type of block first in the Category List at the left to see all of its available 
models appear in the Model List. Note that, once you've selected a Category, you can 
toggle List/Grid View toggle button to change between a menu list or grid type display 
of the category's models. 

HX Effects Owners: HX Effects devices do not include Helix Amp, Preamp or 
Cab type models, therefore, these categories will not be available. 

Model List view Model Grid view
For block categories that offer it, you'll see a sub-category menu at the top of the 
Model List, where you can choose to see Mono, Stereo or Legacy type models. Amp 
categories offer Guitar & Bass sub-categories, and for Cabs you'll see Single & Dual 
category options. 
Once you click on any model in the Model List it is instantly active and loaded into 
the selected Signal Flow location. You'll see the selected model's editable parameters 
appear at the right of the Edit panel. If you want to remove an existing block, select it 
within the Signal Flow and choose the None category's Empty Block option (or use the 
Clear Block menu command).

DSP Limit
As in your Helix or HX device's Model Select menu, when the current preset reaches 
a high DSP usage, some models become non-selectable within the menu. In the HX 
Edit app's menu, you'll see models dimmed to indicate this, as shown below. To free 
up more DSP resources for the current preset, try removing some models, or selecting 
“Simple” or “Legacy” type models. For Helix devices, utilize both Path 1 and Path 2 to 
take advantage of all available DSP power. (See the DSP Management information within 
your device's  Owner's Manual for details.)

Dimmed models 

Unavailable models appear dimmed when the preset's DSP limit is reached

NOTE: Also see “Preset Compatibility” on page 4 for relevant information 
about DSP limits and the use of Helix presets with the Helix Native Plug-in. 
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Editing Model Parameters
Once added to your tone, simply click on any block to select it, then choose the desired 
model type and tweak its parameters in the Edit panel. To follow are a few editing tips 
(also see “Keyboard Shortcuts”).

Toggling Model Bypass - A Bypass button is available at the top right of the Edit 
panel for any model that offers a bypass option. When a model is bypassed, its 
parameters appear dimmed to indicate this state.  

Edit tab - model active Edit tab - model bypassed

Adjusting Parameter Sliders - There are several ways to adjust slider values:

• Click on any slider's “handle” and drag to the desired value.
• Click on the desired range location within a slider's path and it will jump to the 

clicked value.
• While hovering your mouse cursor directly over any slider's path, use your 

mouse wheel to adjust it.
• Click the up/down arrow buttons at the right for small, incremental adjustments. 

If a down arrow is displayed at the right, click on it to expand its menu.

Type in a Precise Value - Double-click anywhere on a slider's path or on its value 
to manually type in a precise numerical value.
Resetting Sliders - If you're not happy with your slider adjustment, Cmd+Click 
(Mac) or Ctrl+Click (Windows) on the slider to reset it to its initial default value.
Accessing All Parameters - Note that some model types, such as amps and 
complex effects, may have more sliders and controls than you can see all at once 
in the Edit tab. You can re-size the application window to show more sliders, or 
click and drag the vertical scroll bar at the right to access all parameters (or use 
your mouse wheel when hovering your mouse cursor over the scroll bar).

Note Sync - Most modulation and delay effects models offer a Note Sync option, 
allowing the modulation rate or delay repeat time to follow the device's main Tap 
Tempo value (see “Editing the Tap Tempo” on page 21). For models that offer 
it, you can click the Note Sync button within the Edit tab to toggle the feature on/
off. When active (the Note Sync button is lit), the parameter will change to offer 
note division values, as shown in the following screenshot. 

Note value options Note Sync (active)

A Delay block configured for Note Sync

Impulse Response Block Options - When an IR block is selected in the Signal 
Flow, you'll see IR block parameter sliders here in the Edit panel, just like for any 
other block. Use the IR Select parameter to choose the index number for the 
desired IR from your IR Library. Remember that you'll need to import IR files into 
your Helix or HX device using the application's Impulses tab for an IR block to 
utilize them—see “Importing and Exporting Impulse Responses” on page 14.
Looper Block Options - It is possible to add a Looper block to a preset, and 
view and edit several Looper block parameters within the Edit tab. However, it 
is not possible to toggle the Looper mode of your connected device on and off 
within the HX Edit application.

TIPS: 
Right-click on a slider for a handy menu to assign external control of the 

parameter to one of your Helix or HX device's controllers, or to an external MIDI 
controller—also see page 34. 
Alt+Click directly on slider in the Edit tab to instantly create a Snapshot Controller 
Assignment for the parameter—see page 19.
By default, all Amp & Effects blocks’ bypass state is automatically stored and recalled 
per Snapshot. If you prefer, you can exclude a block’s bypass state from being 
recalled via Snapshot changes—see page 19.

Editing Input, Output, Split & Mixer Blocks
Much like Amp & Effects blocks, you can click on the Input, Output, Split or Mixer 
blocks of any path and access their options in the Edit panel. 

Input Block Options: 
• Helix and HX Stomp Devices -  Different parameters, such as Gate, Level, 

Pan, etc., are displayed depending on the specific input type you select from 
the Input block's menu. If the Multi or Variax input type is selected (available 
on Helix devices only), you'll see options here for selecting a Variax model, 
individual string tunings & levels, and more. 

• HX Effects Devices - The path's input is “fixed” and, therefore, is not selectable 
and does not offer block options.

Output Block Options:
• Helix Devices - When the Output block of any path is selected, you'll see output 

routing options available, as well as other options the selected Output block for 
your device offers (Pan, Level, L6 LINK - Powercab® & DT amp options, etc.). In 
addition to your Helix device's analog and digital outputs, you can also choose 
to route the output of one path to the input of another later path. Note that you 
can route the output of Path 1 into Path 2 in a “serial” fashion to take advantage 
of both paths' DSP capacity! 

• HX Stomp and HX Effects Devices - When a split path is created, the Mixer 
block can be dragged down to Path B to create a separate “Send” output 
(see “Split Path Options” on page 25). When this dual-output, split path 
configuration exists, you can click on the Path A (Main) output or the Path B 
(Send) output to access Pan and Level parameters for each. The HX Stomp 
Path B output additionally offers a Mono/Stereo option.
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Split Block Options - If your preset includes a split path, click directly on the 
point on the main path where the signal divides to select the Split block and you'll 
see options for choosing different Split block types and their parameters. Note 
that there is also a Bypass switch for Split blocks which, when bypassed, feeds 
an  equal signal balance to each parallel path.
Mixer Block Options - If your preset includes a split path, click directly on the 
point on the main path where the signal returns to select the Merge-Mixer block 
and you'll see several mixer options for blending the two paths' signals.

L6 LINK - Powercab Plus and DT 25/50 Amp  
Options
Helix Floor, Rack and LT devices include the Line 6 proprietary L6 LINK technology, 
providing a simple, single-cable connection for mono/stereo audio and remote control 
capability between Helix and up to two Line 6 Powercab Plus 112 or 212 powered 
speaker systems or DT 25/50 amps. This allows you to store and recall Powercab Plus/
DT parameters via your Helix device—globally or even per Helix preset! 
For L6 LINK functionality, the following versions (or later) are required:

• Helix device firmware v2.80 
• Powercab Plus system firmware v2.00 
• HX Edit v2.80 (if you wish to use HX Edit to access these Helix-L6 LINK 

parameters). 
For best results, it is highly recommended to use the latest available application 
and firmware versions for all  your Line 6 products.
These options are accessible in HX Edit by selecting the Output block within the Signal 
Flow window, and choosing either the Multi or Digital output block type within the Edit 
tab. Click on the Powercab or DT 25/50 tab to configure the desired options for your 
respective device(s).

The L6 LINK Powercab and DT 25/50 amp options

Within the Powercab and DT 25/50 tabs, you’ll see the following sets of controls at the 
top of the screen.

Remote - Selects the Speaker Remote behavior from Helix to your connected 
Powercab Plus or DT unit(s).

• Off - No remote control settings are sent from Helix to the unit(s).
• Preset - All settings within the tab are saved with this Helix preset only, and are 

sent from Helix to the L6 LINK-connected unit(s) upon load of the Helix preset.
• Global - All settings with this tab are sent from Helix to the L6 LINK-connected 

unit(s). These sent settings remain the same regardless of the Helix preset that 
is loaded.

Note that the following three options will change to indicate whether they are 
applied per preset or globally, depending on the respective Remote option 
selected.

Mode - (Powercab tab screen only) Select the desired Powercab Mode (Flat, 
Speaker, or User IR). 

Flat Voicing - When Flat is selected for the above Powercab Mode option, 
you’ll see this row of controls to select either FRFR, LF Flat, or LF Raw for 
the Voicing function of the Powercab Flat mode.

Select - Allows you to configure the remote settings for each unit “1” and “2” of 
the L6 LINK-connected unit(s), or “1+2” for adjusting both simultaneously. You’ll 
see the sliders within the tab change accordingly when you select 1, 2, or  
1+2 Link, allowing you to control the respective unit(s), as described below.

• When using one Powercab 112 Plus or a single DT amp - it can be controlled 
from Helix by selecting 1.

• When using two Powercab 112 Plus systems or DT amps - the first can be 
controlled from Helix by selecting 1, the second can be controlled by selecting 
2, or both can be controlled as one by selecting 1+2 Link.

• When using one or two Powercab 112 Plus amps - selecting 1 controls the 
left speaker(s) of the unit(s) and 2 controls the right speaker(s), or both speakers 
can be controlled as one by selecting 1+2 Link.

NOTE: Any of the individual sliders within the tab can optionally be assigned to the 
Snapshot controller and then the slider value changed per Snapshot. Or, any 
slider can be assigned to a Helix hardware or external MIDI controller, and the 

slider value changed remotely. These controller assignments will function whether the 
L6 LINK settings are configured for the above Preset or Global operation. 

Please refer to your Powercab Family Pilot’s Guide or DT amplifier documentation for 
details on the individual Mode, Speaker, and other options available for these devices. 

NOTE: L6 LINK can also be used to connect up to two Line 6 StageSource powered 
speakers. When two StageSource speakers are connected, the Helix left channel 
audio is automatically routed to the first StageSource, and the right channel audio to 

the 2nd StageSource. Helix does not send any control or parameter messages to 
StageSource speakers via L6 LINK, therefore, there are no Helix Output block options to 
configure. 

https://www.line6.com/manuals
https://line6.com/legacy/
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The Bypass/Controller 
Assign Tab
This tabbed panel combines the options found within the Controller Assign screens of 
your Helix or HX device (as well as the options within the Helix and HX Stomp devices' 
Bypass Assign screens), allowing you to assign model parameter functions to your 
device's footswitches & expression pedals, or external MIDI controllers for real-time, 
remote control. It is also possible here to assign model parameters to be stored and 
recalled with snapshots, as well as to customize footswitch labels and LED colors.

HX Device Owners: HX Edit functionality described in this chapter is the same 
for all Helix and HX devices, except where noted. 

TIP: For creating & managing assignments for the transmission of MIDI commands 
from your (Helix or HX Effects) device's footswitches and pedals, see “The Command 
Center Window” on page 37.  

In addition to the options for creating assignments, a list of existing bypass & controller  
assignments for the current preset appears within the left portion of this panel, allowing 
you to select and edit assignment options. (This handy display of existing assignments 
in one list is something not found on your Helix or HX device's screens.)

Column HeadersAssignment List Selected Block

Selected Assignment Bypass/Control 
Parameters

Footswitch/Controller 
Menu

Assignment Menu

The Bypass/Controller tab

Attention Helix Native Plug-in Users: The Helix Native plug-in's Automation/
Controller Assign panel supports a different set of controller assignments (for use 
with host DAW software's parameter automation). Therefore, Helix Native will 

essentially ignore any HX Edit-created hardware controller assignments saved in a 
preset—see “Preset Compatibility” on page 4. 

Editing an Existing Assignment
When working with Factory Presets, you'll see that most already have some existing 
assignments, and they appear within the Assignments List at the left of the Bypass/
Controller Assign tab (see previous image). Once you create your own Bypass & 
Controller assignments, you'll see them appear within this list as well. At any time you 
can select an assignment within the list to see and edit its options, as described below. 
Please also refer to the following examples for creating specific assignments types for 
more info.

Clearing Existing Assignments
If you right-click directly on any existing Bypass or Controller assignment within the 
Assignment List, you'll find handy options for deleting the selected or all assignments.

The Clear Assignment options within an assignment's context menu

Clear Assignment - Deletes the assignment that you clicked on. 
Clear All Assignments - Deletes all Bypass, Controller, Snapshot, and MIDI 
assignments that exist within the current preset.

Minimum & Maximum Sliders
Use the Min & Max sliders to set the range of control. For example, if creating a 
controller assignment utilizing an EXP Pedal, the Min setting equates to the pedal's 
“heel down” value, and the Max to its “toe down” value. If assigning to a footswitch, 
clicking the switch toggles between your configured Min & Max values. (Note that if 
assigning to a snapshot, all you need to do is set the single parameter value you wish 
to be recalled with the currently-loaded snapshot.)

TIP: You can “reverse” the behavior of a controller by setting the Min to 100% and the 
Max to 0%, such as to make an assigned Wah pedal work backwards!  

Latching/Momentary Footswitch Option
For amp & effects models, you'll also find the Type option here to have the assigned 
footswitch behave as Latching (alternating On/Off on each click) versus Momentary 
(active only while the footswitch is held down).
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MIDI CC In Selector
For assignments that offer remote control via external MIDI, this parameter is where 
you can define the specific MIDI CC value (CC 0-127) to match the MIDI CC value 
being transmitted from your external MIDI controller device or MIDI software. Your MIDI 
hardware or software must be capable of sending MIDI CC messages via 5-pin MIDI 
cable or USB to your Helix or HX device.* 

*NOTE: Your Helix or HX device can receive MIDI from either its 5-pin MIDI IN jack 
or over USB. (MIDI over USB can be received when connected to a computer, via 
a DAW host or MIDI software.) Use the device's Global Settings - MIDI Tempo 

options to configure its receiving MIDI channel and other MIDI options. 

Switch LED Option
(Helix and HX Effects devices only) By default, the color of the LED light surrounding 
your assigned footswitch is set to Auto Color, where it intelligently takes on the color 
according to the assigned model type. You can optionally use this slider to manually 
configure this LED color as desired.

Customizing a Footswitch Label
(Helix and HX Effects devices only) For any selected Bypass or Controller assignment 
that is created using your device's Footswitch, you'll see a Customize control displaying 
the block model's default name. This is the label displayed on the hardware's scribble 
strip for this footswitch (or on the LCD screen for a Helix LT device) when the Helix 
device is in Stomp Footswitch Mode. If you want to customize this label, double-click 
on the existing name, type your new text in the field and hit your Enter/Return key. To 
clear your text and return to the default model label, click the Clear (eraser) button to 
the right of the field.

The Customize label control

NOTE: On Helix and HX Effects Devices, if a footswitch includes one or more 
additional block Bypass, Controller or Command Center assignments, the default 
label appears as Multiple (X) with “X” being the number of assignments. You can 

customize the label in this scenario, but note that it can also be customized within the 
Custom field of the other assignment panels as well, with the latest customization edit 
affecting the label in all places. 

Creating a Bypass Assignment
Create a Bypass assignment for any Amp, Cab, IR, Effect, Looper or Split type block 
to allow it to be toggled on/off via one of your Helix or HX device's footswitches, 
controllers or via external MIDI.

NOTE: On Helix devices, adding a Volume Pedal, Pan, Wah, or Pitch Wham block 
automatically creates a Bypass assignment to the Helix on-board pedal's EXP 
Toe footswitch. On HX devices, a Bypass assignment is automatically created for 

these block types on EXP 1 / EXP 2. You can change or clear this assignment if 
desired—see “Editing an Existing Assignment” on page 31.

Creating a Bypass Assignment Using a Footswitch 
1. Click on the block within the Signal Flow for which you want to create the Bypass 

assignment. 

2. At the right of the Bypass/Controller Assign panel, if not already selected by 
default, click the Assignment Menu and choose Bypass as the parameter to 
control. 

3. Click on the Footswitch/Controller Menu to select the desired footswitch or 
controller and your assignment is created. 

Selecting a footswitch controller for block Bypass assignment

TIP: Alternatively, right-click on a block within the Signal Flow and choose the desired 
Footswitch or Controller to quickly create a Bypass assignment.

Creating a Bypass Assignment Using an External MIDI Controller Source
It is also possible to configure a block to be controlled remotely via an external MIDI 
controller switch, or via MIDI software on your DAW computer. All that is required is that 
the MIDI controller is capable of sending MIDI CC messages via 5-pin MIDI cable or 
USB to your Helix or HX device.* 
A MIDI Bypass assignment can be created independently of a Helix or HX hardware 
controller source assignment for the same block. You will only see one Bypass assignment 
entry displayed within the HX Edit app's Assignments List, regardless if it includes an 
active MIDI assignment source, hardware controller assignment source, or both.

*NOTE: Your Helix or HX device can receive MIDI from either its 5-pin MIDI IN or 
over USB. (MIDI over USB can be received when connected to a computer, via a 
DAW host or MIDI software.) Use the device's Global Settings - MIDI Tempo 

options to configure its receiving MIDI channel and other MIDI options. 



 33 

1. Click on the block within the Signal Flow for which you want to create the MIDI-
In Bypass assignment. 

2. At the right of the Bypass/Controller Assign panel, if not already selected by 
default, click the Assignment Menu and choose Bypass as the parameter to 
control. 

3. Set the MIDI In parameter to match the MIDI CC number (0–127) that your ex-
ternal MIDI controller is sending. To “disable” the MIDI assignment, simply set 
this parameter to Off.

Setting the MIDI In's CC number in the Bypass/Controller Assign panel

Or, instead of steps 2 & 3 above, you can right-click directly on the desired 
block within the Signal Flow and choose MIDI In and your MIDI CC from the 
menu. 

Setting the MIDI In’s CC number from the block’s right-click menu

Your configuration is now complete and your external MIDI source should 
successfully toggle the selected block's Bypass. You'll also see the CC 
number you selected shown in the Assignment list's Source column (“MIDI In 
11”).

TIP: Alternatively, you can utilize the Learn (MIDI Learn) feature within the Bypass 
Assign screen of your Helix or HX device to create a MIDI Bypass Assignment.  

NOTE: With Helix and HX Effects devices, you can use CC67 to toggle the Bypass 
of any 6 Switch Looper block. This is a pre-defined, global MIDI CC hardware 
assignment that does not appear within the HX Edit Bypass/Controller Assign 

panel. 

Creating a Bypass Assignment Using an Expression Pedal
It is also possible to assign a block's Bypass to an Expression pedal (or to a Variax 
knob on Helix devices). An example of this is to configure a Wah block so that resting 
the pedal at the “heel” position toggles the effect off, and then moving the pedal away 
from this position to use the Wah automatically activates the effect again. Set this type 
of configuration using the following steps.*

*HX Effects Owners: On HX Effects, this type of EXP 1 - Bypass configuration 
is configured automatically for any Wah or Pitch Wham type block you add to 

your tone, and to EXP 2 for any added Volume/Pan block. You can follow these steps 
to manually create an EXP Pedal - Bypass assignment for any type of block. 

1. Start by adding a Wah block to your tone and selecting it within the Signal Flow. 

2. If using a Helix device with an on-board EXP 1 pedal, move the pedal forward 
and click the Toe Switch so that it is set to EXP Pedal 1, and the Wah block is 
active.

3. On a Helix or HX Stomp device, since the Wah block is already automatically as-
signed to the EXP Pedal Toe switch for bypass, you'll need to change its Bypass 
assignment to EXP Pedal 1 instead. 

Select the Wah block in the Signal Flow view and go to the Bypass/Controller 
Assign tab. Select the existing Bypass assignment in the list at the left, then 
select the EXP Pedal 1 controller from the Controller/Switch menu at the right.

 
Selecting an expression pedal controller for block bypass assignment

4. Once the assignment is created, you can configure its option sliders at the right 
of the panel.

Configuring an expression pedal - Bypass assignment options

• Position - For a Bypass assignment, this determines the position of the 
controller where the block's bypass is triggered. Set this slider to 5% or lower 
to establish a “heel down” resting position to trigger your bypass toggle.
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• Wait - Determines the duration of time for which the assigned controller must 
rest at the configured Position value before the bypass is triggered. For this 
type of Wah Bypass assignment, 300 ms is generally a good setting, since it 
prevents unwanted bypass triggering during the typical use of the pedal for 
your Wah effect.

Once configured, you'll see that your EXP 1 pedal's heel down position toggles 
the Wah block off, and as soon as you move the pedal, it activates the Wah 
until you move the pedal back to the Min heel position and rest it there for 300 
ms or more (as determined by the Wait slider). You can choose to configure 
other blocks' parameters with a “pedal bypass” using these same steps as 
well.

TIP: By default, all blocks are automatically assigned for Snapshot Bypass—that is, 
each block’s bypass state is automatically remembered and recalled per Snapshot 
by default. You can also choose to exclude any block from Snapshot Bypass—see 

“Configuring & Managing Snapshots” on page 19.

Bypass Assignments for Multiple Blocks
For Helix & HX hardware, you can only assign the Bypass toggle of any particular 
block to one footswitch at a time. If a block already has an existing Bypass assignment 
and you change the assignment, this will move the assignment to the newly selected 
footswitch or controller. But it is possible to assign the Bypass function for multiple 
blocks to one common footswitch or controller for simultaneous switching. 
Each Helix or HX device's footswitch or controller can have up to 8 assignments. 
You can additionally create Controller and (on Helix or HX Effects) Command Center 
assignments utilizing footswitches that simultaneously include Bypass assignments. 
It's also possible to create snapshots that include multiple Bypass & other parameter 
changes all in one click—see the respective sections for more on these assignment 
types!

Block Bypass Assignment Indicator
Once you’ve created a Bypass assignment for a block, you’ll see the block’s name label 
displayed in brackets to indicate this. (Also see page 24.)

Bracketed block label indicate a block bypass assignment

TIP: A handy trick is to create a multi-bypass assignment to toggle one block off and 
the other on simultaneously, such as to change between two different distortions, 
between two different amps, etc. To reverse the switching, select one block within the 

Signal Flow and manually click its Bypass button so that one block is the opposite bypass 
state as the other. Now whenever you toggle the assigned Bypass footswitch, both blocks' 
bypass states are toggled oppositely. 

Creating a Controller Assignment
Just as on your Helix or HX device's Controller Assign screen, you can create a 
Controller assignment for practically any block's parameter (yes, even any Input, 
Output, Split and Merge block parameter!) to allow it to be controlled by a remote 
device's footswitches or controllers, or by external MIDI gear.* Here in the Bypass/
Controller Assign tab you can also configure a Snapshot assignment, to allow your 
desired parameter settings to be stored & recalled with a preset's snapshots. 

*NOTE: Your Helix or HX device can receive MIDI from either its 5-pin MIDI IN or 
USB. (MIDI over USB can be received when connected to a computer, via a DAW 
host or MIDI software.) Use the device's Global Settings - MIDI Tempo options 

to configure its receiving MIDI channel and other MIDI options. 

Creating a Controller Assignment Using an EXP Pedal or Footswitch
1. Click on the block within the Signal Flow that includes the parameter for which 

you want to create the Controller assignment. 

2. At the right of the Bypass/Controller Assign panel, click the Assignment menu 
and choose the parameter to control—for this example we'll choose the Mix of 
a 70s Chorus block.

Selecting a Chorus block's Mix parameter for controller assignment 

3. Click on the Switch/Controller menu to select the desired controller and your 
assignment is created. We'll choose the EXP Pedal 1, but you can alternatively 
choose any EXP Pedal (or, if using a Helix device, one of the Variax Knob con-
trollers). It is also possible to choose one of your device's Footswitches as the 
controller, which allows you to then configure a specific parameter value for 
each of the two states of the footswitch. More on this in the final step.

Selecting an EXP Pedal controller for controller assignment

TIP: Alternatively, right-click on the Mix slider for the 70s Chorus within the Edit tab to 
access the context menu and quickly create a Controller assignment.
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4. Once you've created the Controller assignment, you'll see it appear in the list at 
the left of the Bypass/Controller Assign tab. Select the assignment in the list to 
access options specific to the type of controller you've chosen. For EXP Pedal 
and Variax Knob controller types, there are options for the Min and Max, which 
allow you to limit the range of the assigned parameter as you move the pedal or 
knob controller from minimum to maximum position. For our example, we'll set 
the Max slider to 50% so that it achieves a 50% wet/dry Mix balance when our 
controller is moved to full open.

Configuring options for an EXP Pedal controller assignment

If you have chosen a Footswitch as your controller rather than an EXP Pedal or 
Variax Knob, you'll have a few more options, as described below.

Configuring options for a footswitch controller assignment

• Type - Choose the footswitch behavior:
• Latching - Press and release the footswitch to toggle between the “On/Off” 

states.
• Momentary - Press and hold and the footswitch. While held down, the “On” 

state of the switch is active. While released, the “Off” state is active.
• Min and Max - Configure these two sliders to the specific values you'd like the 

“Off” and “On” footswitch states of the assigned footswitch to toggle between. 
• Switch LED - (Helix and HX Effects devices only) Customize the color of the 

LED that surrounds the assigned footswitch on your device. 
• Customize - (Helix and HX Effects devices only) You can edit the name that 

appears for the assigned footswitch label on your device by clicking in this field. 
To return to the default label, click the eraser button.

Creating a Controller Assignment Using an External MIDI Controller Source
It is also possible to configure a block's parameter to be controlled remotely via an 
external MIDI controller device, or via MIDI software. 

1. To configure a parameter for external MIDI control, you can essentially use the 
same steps as in the above controller assignment example. However, in step 3 
you will want to select MIDI CC from the Footswitch/Controller Menu.

Selecting MIDI CC as the controller type 

2. Once the assignment is created, configure the Min & Max sliders to limit the 
range of the assigned parameter control, if desired. You then need to set the 
MIDI CC In slider value to match the MIDI CC number being sent from your 
external MIDI source. If this value does not match the MIDI CC being sent, the 
parameter will not respond.

Configuring a MIDI CC assignment's options

Your configuration is now complete and your external MIDI controller source 
should successfully control the selected 70s Chorus - Mix parameter. You'll 
also see the assigned CC number shown in the Assignment list's Source 
column (“MIDI CC 16”) for reference.

TIP: Alternatively, you can utilize the Learn Controller (MIDI Learn) feature within the 
Controller Assign screen of your Helix or HX device to create a MIDI Controller 
assignment.  



 36 

Creating a Snapshots Controller Assignment
Configure a block's parameter with a Snapshots assignment to allow the parameter's 
settings to be stored & recalled with a preset's snapshots. 
1. Since a Snapshots assignment is simply one type of controller assignment, you 

can follow the same steps 1 and 2 from “Creating a Controller Assignment Using 
an EXP Pedal or Footswitch” on page 34 to select the block within the Signal 
Flow, and then choose the desired parameter in the Bypass/Controller Assign 
tab's Parameter Menu. 

2. In the Controller Menu, choose Snapshots.

Selecting the Snapshots controller type

TIP: Click on the desired slider within the HX Edit Edit tab and use the “Alt+click” or 
“S” keyboard shortcuts to instantly create a Snapshots controller assignment.  

3. Unlike with other controller types, you won't see any options in the right of the 
Bypass/Controller tab for a Snapshots controller assignment. 

A snapshots assignment is created—there are no configurable options for this assignment type

With this assignment created for the parameter, simply choose the desired  
snapshot from the Snapshots Menu at the top of the HX Edit application 
window, and then whatever value you set for this parameter is automatically 
stored and recalled with the snapshot. This allows you to configure up to 8 
different values on Helix devices (or 4 values on HX Effects, or 3 values on HX 
Stomp) for each preset—one for each available snapshot. Please see your 
device's  
Owner's Manual for details on using snapshots.

Controller Assignments for Variax and L6 LINK Parameters
(Helix devices only) It is also possible to create hardware, MIDI, and snapshot controller 
assignments for the individual Input block–Variax parameters, and Output block–L6 LINK 
(Powercab and DT 25/50) parameters. Controller assignments can be created the same 
as any other block parameters, by selecting the Input or Output block, and ether right-
clicking directly on the desired Edit tab–parameter slider, or by using the menus within the  

Bypass/Controller Assignment tab. Note that these parameter types are grouped within their 
own sub-tabs within the Edit tab. Please also see “L6 LINK - Powercab Plus and DT 25/50 Amp  
Options” on page 30.
As an example, the following shows a Footswitch Controller assignment created for 
the  L6 LINK–Powercab–Speaker Type select parameter within the Bypass/Controller 
Assignments tab. In the Assignments list at the left you can see the created assignment, 
selected so that the assignment’s options appear in the inspector at the right. Note 
that, since the options for this assignment are deep within the Bypass/Controller tab’s  
Powercab sub-tab, a “back” arrow button is available at the top left of the inspector 
pane. Clicking this allows you to easily navigate back to the main Output block options.

Back button

Options for an existing L6 LINK–Powercab parameter’s Footswitch Controller Assignment

Multiple Controller Assignments
Just as on the hardware, you can only assign a parameter to one Controller at a time. 
However, it is possible to assign multiple parameters to one common Controller, for 
example, you could create the following Controller assignments:

• Configure an EXP Pedal for the Mix parameters of two different effects to blend 
between them.

• Configure an EXP Pedal to simultaneously adjust a few of the Input block > 
Variax String Level parameters, if you happen to want that level of control over  
individual string volumes!

It is also possible to create additional Bypass assignments and/or Command Center 
assignments on footswitches that also include Controller assignments—see the 
respective sections for more on these assignment types.

NOTE: (Helix and HX Effects devices only) If a footswitch includes one or more 
additional block Bypass, Controller or Command Center assignments, the default 
label appears as Multiple (X) with “X” being the number of assignments. You can 

optionally customize the footswitch label—see “Customizing a Footswitch Label” on 
page 32. 
The footswitch label can also be customized within the Customize label field within the 
Command Center window, with the latest customization edit affecting the label in all 
places. See the next chapter.

http://line6.com/support/manuals/
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The Command Center 
Window
To display the Command Center window, select it from the application's Window 
menu. This window offers the options found within the Helix or HX Effects devices' 
Menu - Command Center screen, allowing you to create MIDI, Bank/Program, MMC,  
External Amp Channel Switching, and even Hotkey (QWERTY key) output assignments 
(as well as CV assignments on Helix devices) to remotely control other gear from your 
device. As of HX Edit and firmware version 2.90, you can also configure footswitches to 
expand your device’s Stomp mode with additional control functions (see “HX Preset, 
Snapshot, and Looper Commands” on page 39). Please refer to your Helix or HX 
Effects Owner's Manual for details on the types of commands supported and their 
options. Many of the Command Center window functions are also accessible using 
keyboard shortcuts—see page 58.

TIP: Your Helix makes an excellent external USB remote control device for host DAW 
and other popular software applications! Check out the presets that include “Remote” 

in their titles, found within the TEMPLATES Preset Library, which are pre-configured for 
sending commonly used control commands for specific, popular DAW applications. 
Several of the Template presets are configured with Hotkey assignments to control other 
software apps (see the following “Hotkey Assignment “section). Note that you can  easily 
copy and paste all commands into other presets too—see “Copying, Pasting and 
Clearing Commands” on page 38.

HX Stomp Owners: HX Stomp devices do not include the Command Center 
feature. HX Edit functionality described in this chapter is the same for all Helix 

and HX Effects devices, except where noted. Please refer to the MIDI chapter within 
your HX Stomp Owner's Manual for details on its MIDI functionality.

Command Menu

EXP Pedals

Instant Controllers 
Variax Knobs 

Footswitches

EXP Pedal Toe Switch
Snapshots Menu

Selected Controller

Inspector Done Button
The Command Center window (Helix Floor device)

NOTE: The application's Command Center window will show Control selector 
items specific to your device. For example, as shown above, the Helix Floor device 

offers more hardware options for controller assignment (Variax Knobs, 3 EXP Pedals, 
and a Pedal Toe switch), than are available with an HX Effects.
Command Center assignments remain intact on exported presets, and are translated 
where possible when loaded on a different Helix or HX device type—not all Command 
Center assignments may be available if the new device does not include the equivalent  
footswitch and controller types. 

Attention Helix Native Plug-in Users: Helix Native does not include the 
Command Center or support for creating or customizing these types of 

commands. However, existing Command Center assignments are retained even after 
loading, editing or exporting presets with Helix Native. Also see “Preset Compatibility 
with Helix Native Plug-in” on page 4.

Creating a Command Center Assignment
Click directly on any Control Selector item (Instant , Footswitch, EXP Pedal or 
Variax Knob) for which you want to map an assignment. Then, in the inspector pane 
at the right portion of the window, click on the Command menu to choose the type 
of message you wish to transmit from this control. Once a command type is selected, 
configure its options using the parameter sliders that appear. Once you save, these 
Command Center settings are stored individually with the current preset.

You'll see a turquoise triangle indicator above the control items that include an 
assignment. To remove an existing assignment, select the control item again within the 
Command Center window and choose None from the Controller menu, or right-click 
and choose one of the Clear Command options from the context menu.

Assignment Indicators

http://line6.com/support/manuals/
http://line6.com/support/manuals/
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Creating a Hotkey Assignment
Any Instant or Footswitch type controller on your Helix or HX Effects device can also be 
configured to send “QWERTY” keyboard commands to your computer via USB. This 
allows you to remotely control DAWs, DJ software, lighting software, media players, 
video software, browsers, photo editing software, video games, etc… If you can control 
it with your computer keyboard, you can now control it with your feet! To create a 
Hotkey assignment:

1. Select the desired Instant or Footswitch controller (we’ll choose Footswitch 4), 
then choose Hotkey from the Command menu to see the options.

The Hotkey options

2. Manually choose your specific command by clicking the Keystroke dropdown 
menu and select the keyboard character, and optionally add up to three modifier 
keys (Shift, Control, Command, etc.) using the three Modifier options.*

Or, even easier, use the “Learn” function, by clicking on the little keypad icon 
button in the Keystroke section, and then you’ll see it turn green, awaiting your 
keyboard command to be typed.

Awaiting a keystroke to “learn” your Hotkey command

Now simply type any key, or any combination key and modifier key(s) in one 
keystroke, and HX Edit will automatically learn and apply it as your command. 

3. Use the Type option to choose the behavior you prefer for your Footswitch 
(Latching or Momentary). Optionally use the Switch LED selector and Custom-
ize field to add a custom LED color and scribble strip label to your device’s 
Footswitch (see the following sections for details).

*NOTE: On your Helix/HX Effects device screen, you’ll see a single Mac/PC option 
within these three Modifier menus—this selection corresponds to the Windows 
key on Windows OS systems, and to the Command key on macOS systems.

Copying, Pasting and Clearing Commands
Just as on your Helix or HX Effects device, there are options available to easily Copy, 
Paste and Clear Command Center assignments. Using these commands from the 
application's Edit menu, or from the individual controls' right-click context menu, you 
can copy and paste an assignment from one controller to another, copy & paste all 
command assignments within the current preset to another preset, clear the current 
command assignment, or clear all of the preset's current command assignments. 

NOTE: Customized label and LED color options for Footswitch controls are not 
copied with a footswitch’s commands (to allow the target footswitch’s existing 
label and colors to remain unchanged). 

The Command Center context menu's Cut, Copy Paste & Clear commands

It is also possible to paste within the Command Center window for any other preset, even 
if a different Helix device is connected to the HX Edit application while your last-copied 
command data still exists on the clipboard. At this time, it is not possible to utilize the 
Copy All Commands and Paste All Commands options between different devices.*

*NOTE: The different Helix device types offer varying sets of Command Center 
assignment options, therefore, unsupported commands cannot be copied 
between different Helix devices (e.g., Helix LT and HX Effects devices do not offer 

an EXP 3 controller, thus it is not possible to paste an EXP 3 command assignment from 
a Helix floor to these devices).

To Cut, Copy or Clear - Simply right-click on the desired instant , Footswitch, EXP 
Pedal or Variax Knob controller item that includes the assignment and choose the 
command from the context menu. 

• Use Cut if you want to clear the assignments of the selected Control Select 
item, and also copy the assignments to the clipboard.

• Use Copy All if you want to copy the complete set of existing Command Center  
assignments within the current preset and you can then load a different preset 
and use Paste All Commands within its Command Center window to copy all 
in one action.

• Use Clear All if you want to wipe out all the Command Center assignments 
from the current preset and start clean.

To Paste - Once you've copied Command Center assignment data to the 
clipboard, right-click on your desired destination controller item (within the same 
preset, or in another) and choose the Paste or Paste All option. 
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Configuring Unique Command Values Per Snapshot
Once you’ve created an assignment to any Instant, Footswitch, Pedal, or other controller 
within the Command Center, it is possible to configure the command’s values differently 
per snapshot if desired, allowing a great deal of message variety possibilities within a 
single preset. (Most Commands’ parameter values are automatically stored & recalled 
per snapshot—there is no need to manually create a Snapshot controller assignment.)
For example, if you have configured one of the  Instant controllers with a MIDI CC type 
command, you can configure the MIDI Channel, CC #, and/or Value to be different per 
Snapshot, thus triggering a different function on your MIDI-connected hardware each 
time you change to a different snapshot within the current Helix preset! 

Configuring the MIDI CC options on an Instant controller

Note that it is not possible to store or recall a different Command type per snapshot, 
only the values of the sliders for the current command (with the exception of the Switch 
LED color and Customize label values for Footswitch controllers). Please refer to your 
Helix or HX device's Owner's Manual for details about Command Center command 
types and their specific behaviors.
You’ll see a Snapshots menu at the top of the Command Center window. This menu is 
is offered here as a convenience so that you don’t need to close out of the Command 
Center window just to select a different snapshot index number from the top of the main 
HX Edit winow’s Snapshot menu for editing parameter values per snapshot (although 
changing snapshots from the main window performs the same function).* 

The Command Center’s Snapshots menu

To store your Command Center assignment settings per snapshot - First select the 
desired snapshot index number from the Command Center’s Snapshots menu, then 
edit the values of your existing Control Center assignments that you wish to be stored. 
The settings are automatically retained per snapshot during editing—save your preset 
once your edits are complete. (Also see “Configuring & Managing Snapshots”.)

HX Preset, Snapshot, and Looper Commands
As of firmware 2.90 for HX Edit, and Helix & HX Effects device firmware, these “HX” 
commands allow you to configure Stomp mode switches for even greater control of 
internal functions of your device. These commands are saved per preset.

HX Command options within the Command Center Footswitch - Commands menu

NOTE: Although Stomp mode switches can be assigned to multiple functions, 
to avoid unintended behavior, we strongly recommend the HX Preset, HX  

Snapshot, and HX Looper commands be assigned only to empty footswitches.

HX Preset - Allows you to configure a Stomp mode footswitch to immediately 
“jump to” any other preset within the current setlist. With any footswitch controller 
selected in the Command Center window, set the Command parameter to HX 
Preset, and then set the Preset parameter Next or Previous, or choose the 
specific preset (01A~32D) within the current setlist that you wish to load. 
HX Snapshot - Allows you to configure a Stomp mode footswitch to immediately 
recall any snapshot within the current preset. With a footswitch controller 
selected in the Command Center window, set the Command parameter to HX 
Snapshot. The additional options then allow you to recall the desired snapshot 
index number, or Next or Previous snapshot, independently per each Press 
and Release or each Press and Hold of the footswitch. (Note that the assigned, 
Stomp mode footswitch’s label and LED will only indicate the command assigned 
to the Press function.)
HX Looper - For a preset that includes a Looper block, this command allows you 
to configure an instant  or Stomp mode footswitch to trigger any function of the 
Looper (Play, Stop, Record, etc.).

NOTE: A 6 Switch Looper or 1 Switch Looper block must be present in 
your preset for HX Looper commands to function.

• With any instant  command controller selected in the Command Center 
window, set the Command parameter to HX Looper and then use the Function 
parameter to choose the specific Looper function you wish to trigger. (Note 
that it is possible to create HX Looper commands on more than one Instant 
command, so you’ll want to be careful not to set them to trigger multiple, 
conflicting Looper functions!)

http://line6.com/support/manuals/
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• The HX Looper, instant  command assignment’s Function parameter value 
is automatically stored and recalled per snapshot. This allows you to record a 
loop and, for example,  configure an instant command to automatically Play 
the Loop when loading one Snapshot, and Stop when loading a different 
Snapshot. 

• With any Stomp mode footswitch controller selected in the Command Center 
window, set the Command parameter to HX Looper. The additional options 
then allow you to toggle the desired Looper functions independently per each 
Press and Release or each Press and Hold of the footswitch. 
• Note that the assigned, Stomp mode footswitch’s label and LED will only 

indicate the command assigned to the Press function.
• The HX Looper command, Stomp mode footswitch assignment parameter 

values (Behavior, Press, and Release) are automatically stored and recalled 
per snapshot.

Customizing a Footswitch Label
When you create a Command Center assignment to the selected footswitch control 
within the Command Center window, you'll see the Customize field available within the 
parameter display at the right. 
You can customize text in this field to determine what is displayed on the hardware's 
footswitch scribble strip (or on the large screen on Helix LT) when in Stomp Mode. To 
clear your text and return to the default label, click the Clear (eraser) button to the right 
of the field.

Clear buttonCustomize label field

NOTE: If the footswitch includes one or more additional block Bypass, Controller or 
Command Center assignments, the default label appears as Multiple (X) with “X” 
being the number of current assignments. You can customize the label in this 

scenario, but note that it can also be customized within the Customize field of the 
Bypass/Controller Assignment tab as well, with the latest customization edit affecting 
the label in all places. 
This Command Center Footswitch Label - Customize option is not available for the 
footswitch if you have selected the HX Preset, HX Snapshot, or HX Looper type 
command.

Customizing a Footswitch LED Color
When the selected footswitch within the Command Center window includes a 
Command Center assignment, the color of the LED on/off indicator light surrounding 
your footswitch can be customized to your color choice for Stomp footswitch mode by 
using the Switch LED slider/menu at the right.* 

The Command Center - Switch LED parameter

The options are as follows:
• Choose one of the 10 colors
• Auto Color -  The LED intelligently takes on the color according to the assigned 

model type. 
• Off - The LED remains unlit, regardless of the switch state.

*NOTE: This option is also found within the Bypass/Controller Assign panel. 
Customizing an LED in either will overwrite the LED's current Stomp footswitch 
mode settings.

This Command Center - Switch LED option is not available for the footswitch if you 
have selected the HX Preset, HX Snapshot, or HX Looper type command.  
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Global EQ Window
The Global EQ, accessed from the application's Window menu, offers a large graphical 
interface for the Helix or HX Stomp device's Global EQ feature.* As its name suggests, 
the Global EQ settings and bypass state are indeed global and not saved or recalled 
with any preset or snapshot. HX Edit functionality described in this chapter is the same 
for all Helix and HX Stomp devices, except where noted.

*HX Effects Owners: HX Effects devices do not include the Global EQ feature. 

Bypass Button

Done ButtonLevel Slider

Reset Button

Inspector Pane Band Parameters

Apply EQ Output Menu

Band Edit Nodes

The Global EQ is a 5-band, parametric style equalizer, situated after all other processing 
blocks of your Helix or HX Stomp signal path, allowing for sculpting your overall tone 
just before it is sent out your Helix (1/4" and/or XLR) or HX Stomp (Main 1/4") outputs. 
This is especially handy for fine-tuning your tone to compensate for a venue's stage or 
room sound, without having to go in and tweak all your presets.

Adjusting Global EQ Parameters
The Global EQ window offers two methods in which you can view & adjust its settings: 
by dragging any band's edit “node” within the graph, or by adjusting the selected 
band's parameter sliders within the lower inspector portion of the window. The EQ 
processing is functional whenever its Bypass button is set to “active” in this window (or 
via your device's Bypass button when viewing its Global EQ screen). 

Reset - Click the Reset button to instantly return all parameters to their default, 
“flat” values.
Apply EQ Output Menu - (Helix devices only) Select your Helix device's output(s) 
on which you want the Global EQ to be active.
Bypass Button - Toggle the Bypass to globally enable or disable the EQ.
Band Edit Nodes - Click and drag the desired band's Edit Node in the upper 
graph to adjust its Frequency and Gain. You'll also see the respective parameters' 
sliders move within the inspector pane while adjusting any edit node.
Inspector Pane - This lower portion of the window offers a set of adjustable 
parameters for each of the EQ's five bands.
Band Parameters - Each band has its own set of sliders. Note that the Low 
Cut and High Cut are “shelving” type filters, allowing you to set the roll-off point 
for the low and high frequencies respectively. The middle 3 bands are fully 
parametric, with controls for choosing the center Frequency, Gain (with a boost 
or cut of up to 12 dB), and Q (the width of the frequency range affected). Adjust 
the sliders as follows:

• Click and drag any slider's handle or use the Up/Down buttons at the right of 
each slider

• Right-click on a slider to enter a precise value numerically 
• Turn your mouse wheel while hovering your cursor over any slider
• Click on a slider and use the comma/period or -/+ shortcut keys to incrementally 

adjust its value 
• Double click on a slider to individually reset it to its default value

Level Slider - (Helix devices only) Adjusts the post-EQ output level, offering a 
“make-up gain” to compensate for the overall output level change incurred by EQ 
parameter settings.
Done Button - Click to close the Global EQ window.

TIP: Try the handy keyboard shortcuts for adjusting Global EQ options—see page 
58.  
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Preferences and About Box
The Preferences Window
The HX Edit Preferences window includes three tabbed screens to edit application 
options: View, Presets/IRs, and Device Settings. This window is accessed by either 
selecting Preferences from the HX Edit menu (Mac), Help menu (Windows), or by 
clicking the Preferences button (or on the Helix/HX device indicator icon) at the bottom 
of the main HX Edit window.

Click the Preferences (gear icon button) or device indicator to open the Preferences window

NOTE: If you happen to have multiple Helix/HX devices connected, each HX Edit 
application window includes its own Preferences window, and all settings within it 
pertain to HX Edit’s use per individual device.

Restore Factory Settings

This button at the bottom left of the Preferences window resets all items in all three tabs 
of the Preferences window back to the initial, factory default settings.

NOTE: Your Helix or HX device also includes several additional settings within its 
Global Settings screens (as well as its own Restore options)—this Restore 

Factory Settings button restores only the settings shown within the HX Edit 
application’s Preferences window.

Check for Updates

Use this button to manually check for, and optionally install, any available firmware 
updates for your connected Helix or HX device (an active Internet connection is 
required) See page 70. 

Preferences - View Tab

The View tab

This tab includes one option, for configuring how you wish to view the block labels 
within the Signal Flow.

Show/hide name labels - The Show Names setting is the factory default. If you 
prefer to have the Signal Flow window not show labels beneath each block, you 
can choose Hide Names here (see page 24).

Preferences - Presets/IRs Tab

The Presets/IRs tab

This tab includes the following options for the Presets and Impulses Librarian tabs of 
the plug-in.

Preset Numbering Format - The presets within the Librarian’s Presets Panel can 
be numbered as Bank numbers & letters (as 01A-32D, the factory default setting) 
or sequentially (as 000-127) within each setlist, depending on which is more 
convenient for you.
Stereo IR Import - When a stereo IR .wav file is imported by a Helix or HX 
device, it must be converted to mono. This preference lets you choose whether to 
take the left channel (the factory default) or right channel of the source IR file, or 
to sum both channels to mono.
Import Bundle & Export Bundle - (Helix devices only) A Bundle is a single file 
containing the complete contents of the Helix device’s Preset Library (or, the full 
Preset Library from Helix Native plug-in, if exported from Helix Native). These 
buttons allow you to Import a Helix Bundle file from your hard drive, or create 
and save all your device’s setlists and presets in their currently-saved state as a 
Bundle file to your hard drive. Please see page 13 for details.
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Preferences - Device Settings Tab
The Device Settings screen offers options for your connected device’s configurable 
EXP and Footswitch options. Note that these options only exist for Helix LT, HX Effects 
and HX Stomp devices (you’ll see no options in this tab with a Helix Floor or Rack 
device in use, since these devices do not utilize shared EXP jacks).

Helix LT

Helix LT Device Settings

EXP 2/Ext Amp Option - Helix LT devices incorporate a “shared” EXP PEDAL 2/
EXT AMP jack. This option allows you to choose the jack’s functionality (same as 
the Helix LT hardware’s Global Settings > Preferences option).

HX Effects

HX Effects Device Settings

Pedal 1 and Pedal 2 Jack Options - For the HX Effects device’s two rear panel 
Pedal jacks, these options allows you to choose their functionality (same as the 
HX Effects hardware’s Global Settings > Preferences options).

HX Stomp

HX Stomp Device Settings

For the HX Stomp device’s rear panel, TRS EXP 1/2 FS 4/5 jack, the EXP/FS options 
allow you to choose the individual functionality for the “Tip” and “Ring” connections 
(same as the HX Stomp hardware’s Global Settings > Preferences options).

EXP/FS Tip - Determines whether the jack’s Tip signal is an Expression Pedal 1 
input jack or a Footswitch 4 input jack.
EXP/FS Ring - Determines whether the jack’s Ring signal is an Expression Pedal 
2 input jack or a Footswitch 5 input jack.
FS3, FS4, FS5 Functions - Determines the behavior for each footswitch, such 
as for Tap/Tuner, Snapshot, Bank, or Preset select, or All Bypass. Options vary 
depending on connected hardware and other HX Stomp Global Settings—please 
refer to your HX Stomp Owner’s Manual for details.

The About/Legal Box and Help Options
These options are available by:

• Selecting About HX Edit from the HX Edit menu (Mac), Help menu (Windows)
• Selecting the Help or Pilot’s Guide options from the application’s Help menu 
• Or, selecting any of these options from the ? button menu at the bottom left of 

the HX Edit main window

Click the ? button to access the menu

About Box
Choose About at the left of the window to display the About Box screen, which provides 
version information for the HX Edit application.

Connected device’s 
firmware version

HX Edit app version

The HX Edit About box screen - About tab selected

https://www.line6.com/manuals
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Note that your connected Helix/HX device’s current firmware version is displayed at 
the top of this window. It is always recommended that you use the latest available 
versions of both your device firmware and HX Edit application. If you are also to be 
using and sharing presets with the Line 6 Helix Native plug-in, it is also recommended 
to use the latest version of it (also see “Preset Compatibility with Helix Native Plug-in” 
on page 4).

Please be sure to read the Release Notes available with all firmware, device 
driver, and application versions before installing, since there may be specific 

instructions for the order and procedure for your installations, depending on the existing 
versions you already have installed. 

For Helix and HX device firmware updates, you can use the Updater feature built 
right into the HX Edit app, or the Line 6 Updater application (see “Firmware Updater 
& Additional Resources” on page 70). The latest Line 6 Updater and HX Edit 
application installers can be downloaded free from line6.com/software.

Legal Information
Choose the Legal tab at the left of the window to display the Legal screen, which lists  
all the necessary trademark, copyright, and other legally required statements for the HX 
Edit software. 

Online Help
Choose the Online Help option from the menu to go directly to the Line 6 Support 
website page within your browser app. Here you can find the Knowledge Base, FAQs, 
videos, User Forums, and more for HX Edit and Helix/HX devices.

Pilot’s Guide
Choose the Pilot’s Guide option from the menu to open the PDF document you are 
now reading.

https://line6.com/software/
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Marketplace & 
Account Options
Marketplace

Now open for business is the Line 6 Marketplace online shop, where you'll find 3rd-
party, premium add-on assets that even further enhance the functionality of your Helix 
and HX devices, as well as for Helix Native plug-in! As of this writing, professionally 
crafted presets and IRs are available. Check back often on the Marketplace site for 
product news and announcements. As covered within this chapter, you're only a few 
clicks away from using new Marketplace assets on your system, right from the My 
Account menu in HX Edit.

NOTE: Version 2.70 of HX Edit and device firmware, and 1.70 of Helix Native (or 
later versions) are required for full support and use of premium Marketplace 
presets and IRs. 

Get Your Marketplace Assets
Access the Marketplace website by choosing the Get More Presets and Get More 
IRs, commands within the My Account menu at the bottom left of the HX Edit window 
(or go directly to https://line6.com/marketplace/). When visiting the Marketplace site, 
simply sign in to your Line 6 account, choose the desired pack(s) of presets or IRs, add 
them to your cart, and check out.* 

*NOTE: Be sure to log in to the same Line 6 account on which you've authorized 
your computer for HX Edit and Helix Native to ensure your Marketplace purchased 
assets are added to the correct account!

Once your purchase is complete, your downloadable Marketplace assets are deposited 
into your Line 6 account, which include your personal license that allows you to import 
them on your authorized computer system. Each Marketplace purchase is downloadable 
as a “zip” file that you'll need to “unzip” on your local hard drive once downloaded.

To download your purchased assets, click on the Manage Account command 
within HX Edit app's My Account menu (or go directly to https://line6.com/
account/), sign in to your account, and select Helix Marketplace from the 
Hardware & Software section at the left.

Licenses for your purchased assets are automatically added to your Line 6 
account and “synced” the next time you use the HX Edit application, as long as 
you are actively signed in to your Line 6 account from the My Account menu (see 
“Sign In / Sign Out” on page 46).

Import and Utilize Your Marketplace Assets
An Internet connection is required for the computer where you'll be using the HX Edit 
app to authorize it for the use of Marketplace premium assets, and for the sync with 
your Line 6 account to initially authenticate your newly purchased Marketplace licensed 
assets. Otherwise, an active Internet connections is not required for the use of HX Edit. 
Please see the following sections for details about signing in and authorization.

Once you've signed in and authorized your computer via HX Edit, your premium 
Marketplace presets and IRs can then be imported and used just like any other 
presets and IRs within HX Edit (and/or within Helix Native).
Once imported, premium Marketplace presets and/or premium Impulse Responses 
(.hir files), appear with a golden guitar pick “badge” at their right in the HX Edit 
librarian lists. (Also see page 12. and page 14 for more about importing 
presets and IRs.)

The golden guitar pick badges indicate premium Marketplace presets and IRs

https://line6.com/marketplace/
https://line6.com/marketplace/
https://line6.com/marketplace/
https://line6.com/account/
https://line6.com/account/
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The My Account Menu Options
At the bottom left of the HX Edit application window, you'll see the My Account menu 
and account status indicator. Initially, before you've signed in to your Line 6 online 
account and/or authorized your computer for Marketplace premium assets, you'll see 
this menu displayed with the My Account label.

The My Account menu (not signed in or authorized)

Clicking on the My Account menu displays options for signing in & managing your Line 
6 account, as well as for access to the Marketplace online shop.*

*NOTE: It is not required that your computer have an active Internet connection, nor 
do you need to be signed in or authorized at all for the HX Edit app itself to be 
functional. But signing in is necessary to authorize (or deauthorize) your computer to 

allow the import and export of premium assets purchased from the online Marketplace. 
If you don't plan to use Marketplace premium assets, you don't have to worry 
about signing in and out with HX Edit, and you can simply ignore the following 
Sign In / Sign Out and Authorize / Deauthorize sections. 

Sign In / Sign Out
If you are not currently signed in, choose Sign In from the menu and enter your Line 6  
account user name and password in the Sign In window. If you have forgotten your sign 
in credentials, or have not already created a Line 6 account, choose the Forgot my 
password/username or Create a Line 6 account option within the window. If you are 
already signed in and wish to sign out, choose the Sign Out option from the menu.

TIP: If you plan on purchasing premium Marketplace assets, it is easiest to simply 
remain actively signed in, with your computer in the authorized state. This allows the 
licenses for your purchased assets to automatically be “synced” from your Line 6 

account, and for the assets able to be utilized for all actions within the HX Edit app.  

The Line 6 account Sign In window

Computer Authorization Status Indicator
Once you've signed in, your computer is automatically authorized, as confirmed by a 
pop up window letting you know the sign in and authorization were successful. You'll see 
the My Account menu label display your first name (derived from your Line 6 account) 
and indicate the status of your account sign in and computer authorization (more details 
about authorization in the following section). 
Whenever signed out, the menu button displays the “My Account” label, with no colored 
authorization indicator. 

Signed in with computer Deauthorized

Signed out with computer Deauthorized

Signed in with computer authorized

Once you've authorized your computer, you can optionally sign out, and your computer 
remains in the authorized state, allowing you to continue to perform import, export, copy 
and back up actions with your Marketplace assets, even if your Internet connection is not 
currently active.
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Note that you will need an Internet connection to be able to sign in again to access the 
Deauthorize and Authorize options from the menu, as well as to initially synchronize with 
your online Line 6 account after making any new Marketplace purchase (see “License 
Synchronization”).

Authorize / Deauthorize Your Computer
It is necessary for your computer to be in the authorized state for performing any HX Edit 
Import, Export, Copy/Paste or Backup/Restore action that includes your purchased 
Marketplace premium IRs or presets (as well as setlists or bundles that include them). 
Simply signing in to your Line 6 account will authorize your computer automatically.*

*NOTE: It is permitted to authorize a maximum of 4 of your computers concurrently. 
If you've already authorized 4 computers, you can deauthorize one computer to 
free up one of your authorizations. 

Deauthorizing You Computer
While signed in to your Line 6 account, choose the Deauthorize Computer command 
from the My Account menu and the brief online deauthorization process completes 
automatically. You'll see a confirmation dialog appear and the Authorization Status 
Indicator for the My Account menu will change to red to indicate your deauthorized 
state (see preceding section). Additionally, deauthorizing your computer will also 
automatically sign you out of your Line 6 account.
When deauthorized, the HX Edit application still functions to provide all preset & IR 
librarian and signal flow editing tasks, however, Marketplace-purchased assets are not 
able to be imported or exported with the HX Edit app. You can choose Authorize 
Computer from the menu to authorize the computer again at any time, providing you 
have not exceeded the 4 computer authorization limit.

Helix Native Plug-in Owners: This authorization/deauthorization within HX Edit 
globally authorizes/deauthorizes your computer for the use of the Helix Native 
plug-in (and the use of Marketplace assets within it) as well, assuming your Helix 

Native license and Marketplace purchases were performed using your same Line 6 
user account. Please also see the Helix Native Plug-in Pilot's Guide. 

License Synchronization
Whenever you make a purchase from Marketplace, a license for each product you 
purchase is deposited into your online Line 6 account. For the HX Edit application to 
access your new licenses and effectively “unlock” your purchased assets, it needs to 
perform a “sync” process with your Line 6 account. You must have an active Internet 
connection and be signed in within HX Edit on your next use of the app after your 
purchase for this license synchronization to occur. 
When you're signed in, this brief sync takes place automatically in HX Edit the next time 
you launch the application, or if already running, when you next click on the HX Edit 
app window. (Note that it may take up to 5 minutes before a sync occurs if HX Edit was 
already running.) Once the license sync has completed, an active Internet connection is 
not required for the use of these Marketplace purchased assets within HX Edit or within 
your Helix hardware.

Manage Account
Choose this menu option to be taken to the Line6.com My Account page, where 
you can view and update your Line 6 user account—view and manage add-ons and 
Marketplace purchases, register Line 6 gear, update your personal information, and 
more.

http://line6.com/support/manuals/
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Model Lists
To follow are the lists of all Effect, Amp, Speaker Cabinet & Microphone models included 
in Helix and HX devices, as well as the original gear they are based on.* Models, in 
many cases, include some unique parameters, typically based on the controls found 
on the original gear we modeled. However, you will also find a set of options that are 
common to model category types, as described in the sections that follow.

HX Effects Owners: Note that HX Effects devices include all Effects models, but 
not the Amp, Cab, and Mic models within the following lists. 

Effects Models
The following Effects models are found within each of the Helix and HX device’s 
respective block category menus (Distortion, Dynamics, EQ, etc.). Once you’ve selected 
an effects category in the application’s Model Browser menu, you’ll see up to three 
effects sub-categories: Mono, Stereo, and Legacy. Mono models process in mono, as 
you’d expect, collapsing the stereo output of any block preceding it to mono. Stereo 
models process the signal as discrete stereo-in, stereo-out. Legacy type models, just 
as on earlier Line 6 devices, are a mixed bag and can be either mono, stereo or mono-
in/stereo-out. 

NOTE: “Legacy” models are effects from the classic Line 6 DL4™, DM4™, MM4™, 
and FM4™ stompboxes as well as M13®, M9®, and M5® processors. 

Distortion Models
Model Subcategories Based On*
Kinky Boost Mono, Stereo Xotic® EP Booster
Deranged Master Mono, Stereo Dallas Rangemaster Treble Booster
Minotaur Mono, Stereo Klon® Centaur
Teemah! Mono, Stereo Paul Cochrane Timmy® Overdrive
Heir Apparent! Mono, Stereo Analogman Prince of Tone
Tone Sovereign Mono, Stereo Analogman King of Tone
Alpaca Rogue Mono, Stereo Way Huge® Red Llama (modded)
Compulsive Drive Mono, Stereo Fulltone® OCD
Dhyana Drive Mono, Stereo Hermida Zendrive
Valve Driver Mono, Stereo Chandler Tube Driver

Distortion Models
Model Subcategories Based On*
Top Secret OD Mono, Stereo DOD® OD-250
Scream 808 Mono, Stereo Ibanez® TS808 Tube Screamer®

Hedgehog D9 Mono, Stereo MAXON® SD9 Sonic Distortion
Stupor OD Mono, Stereo BOSS® SD-1 Overdrive
Deez One Vintage Mono, Stereo BOSS® DS-1 Distortion (Made-in-Japan)
Deez One Mod Mono, Stereo BOSS® DS-1 Distortion (Keeley modded)
Vermin Dist Mono, Stereo Pro Co RAT
KWB Mono, Stereo Benadrian Kowloon Walled Bunny Distortion
Legendary Drive Mono, Stereo Carvin® VLD1 Legacy Drive (hi gain channel)
Arbitrator Fuzz Mono, Stereo Arbiter® FuzzFace®

Triangle Fuzz Mono, Stereo Electro-Harmonix® Big Muff Pi®

Industrial Fuzz Mono, Stereo Z.Vex Fuzz Factory
Tycoctavia Fuzz Mono, Stereo Tycobrahe® Octavia
Wringer Fuzz Mono, Stereo Garbage's modded BOSS® FZ-2
Thrifter Fuzz Mono, Stereo Line 6 Original
Xenomorph Fuzz Mono, Stereo Subdecay Harmonic Antagonizer
Megaphone Mono, Stereo Megaphone
Bitcrusher Mono, Stereo Line 6 Original
Ampeg Scrambler Mono, Stereo Ampeg® Scrambler Bass Overdrive
ZeroAmp Bass DI Mono, Stereo Tech 21 SansAmp Bass Driver DI V1
Obsidian 7000 Mono, Stereo Darkglass® Electronics Microtubes® B7K Ultra
Clawthorn Drive Mono, Stereo Wounded Paw Battering Ram
Tube Drive Legacy Chandler Tube Driver
Screamer Legacy Ibanez® Tube Screamer®

Overdrive Legacy DOD® Overdrive/Preamp 250
Classic Dist Legacy ProCo RAT
Heavy Dist Legacy BOSS® Metal Zone
Colordrive Legacy Colorsound® Overdriver
Buzz Saw Legacy Maestro® Fuzz Tone
Facial Fuzz Legacy Arbiter® Fuzz Face®

*See “U.S. Registered Trademarks” on page 57 All product names used in this document are trademarks of their respective owners and neither Yamaha Guitar Group nor Line 6 are associated or affiliated with them.  
These trademarks appear solely to identify products whose tones and sounds were studied by Line 6 during sound model development.
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Distortion Models
Model Subcategories Based On*
Jumbo Fuzz Legacy Vox® Tone Bender
Fuzz Pi Legacy Electro-Harmonix® Big Muff Pi®

Jet Fuzz Legacy Roland® Jet Phaser
L6 Drive Legacy Colorsound® Overdriver (modded)
L6 Distortion Legacy Line 6 Original
Sub Oct Fuzz Legacy PAiA Roctave Divider
Octave Fuzz Legacy Tycobrahe® Octavia

Dynamics Models
Model Subcategories Based On*
Deluxe Comp Mono, Stereo Line 6 Original
Red Squeeze Mono, Stereo MXR® Dyna Comp
Kinky Comp Mono, Stereo Xotic® SP Compressor
Rochester Comp Mono, Stereo Ashly® CLX-52 (in conjunction w/ B. Sheehan)
LA Studio Comp Mono, Stereo Teletronix® LA-2A®

3-Band Comp Mono, Stereo Line 6 Original
Noise Gate Mono, Stereo Line 6 Original
Hard Gate Mono, Stereo Line 6 Original
Autoswell Mono, Stereo Line 6 Original
Tube Comp Legacy Teletronix® LA-2A®

Red Comp Legacy MXR® Dyna Comp
Blue Comp Legacy BOSS® CS-1
Blue Comp Treb Legacy BOSS® CS-1 (Treble switch on)
Vetta Comp Legacy Line 6 Original
Vetta Juice Legacy Line 6 Original
Boost Comp Legacy MXR® Micro Amp

EQ Models
Model Subcategories Based On*
Simple EQ Mono, Stereo Line 6 Original
Low and High Cut Mono, Stereo Line 6 Original
Low/High Shelf Mono, Stereo Line 6 Original
Parametric Mono, Stereo Line 6 Original
Tilt Mono, Stereo Line 6 Original
10 Band Graphic Mono, Stereo MXR® 10-Band Graphic EQ
Cali Q Graphic Mono, Stereo MESA/Boogie® Mark IV Graphic EQ

Modulation Models
Model Subcategories Based On*
Optical Trem Mono, Stereo Fender® optical tremolo circuit
60s Bias Trem Mono, Stereo Vox® AC-15 Tremolo
Tremolo/Autopan Mono, Stereo BOSS® PN-2
Harmonic Tremolo Mono, Stereo Line 6 Original
Bleat Chop Trem Mono, Stereo Lightfoot Labs Goatkeeper
Script Mod Phase Mono, Stereo MXR® Phase 90
Pebble Phaser Mono, Stereo Electro-Harmonix® Small Stone
Ubiquitous Vibe Mono, Stereo Shin-ei Uni-Vibe®

Deluxe Phaser Mono, Stereo Line 6 Original
Gray Flanger Mono, Stereo MXR® 117 Flanger
Harmonic Flanger Mono, Stereo A/DA Flanger
Courtesan Flange Mono, Stereo Electro-Harmonix® Deluxe EM
Dynamix Flanger Mono, Stereo Line 6 Original
Chorus Mono, Stereo Line 6 Original
70s Chorus Mono, Stereo BOSS® CE-1
PlastiChorus Mono, Stereo Modded Arion SCH-Z chorus
Trinity Chorus Stereo Dytronics® Tri-Stereo Chorus
Bubble Vibrato Mono, Stereo BOSS® VB-2 Vibrato
Vibe Rotary Stereo Fender® Vibratone
122 Rotary Stereo Leslie® 122

*See “U.S. Registered Trademarks” on page 57 All product names used in this document are trademarks of their respective owners and neither Yamaha Guitar Group nor Line 6 are associated or affiliated with them.  
These trademarks appear solely to identify products whose tones and sounds were studied by Line 6 during sound model development.
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Modulation Models
Model Subcategories Based On*
145 Rotary Stereo Leslie® 145
Double Take Mono, Stereo Line 6 Original
AM Ring Mod Mono, Stereo Line 6 Original
Pitch Ring Mod Stereo Line 6 Original
Pattern Tremolo Legacy Line 6 Original
Panner Legacy Line 6 Original
Bias Tremolo Legacy 1960 Vox® AC-15 Tremolo
Opto Tremolo Legacy 1964 Fender® Deluxe Reverb®

Script Phase Legacy MXR® Phase 90 (script logo version)
Panned Phaser Legacy Ibanez® Flying Pan
Barberpole Legacy Line 6 Original
Dual Phaser Legacy Mu-Tron® Bi-Phase
U-Vibe Legacy Shin-ei Uni-Vibe®

Phaser Legacy MXR® Phase 90
Pitch Vibrato Legacy BOSS® VB-2
Dimension Legacy Roland® Dimension D
Analog Chorus Legacy BOSS® CE-1
Tri Chorus Legacy Dytronics® Tri-Stereo Chorus
Analog Flanger Legacy MXR® Flanger
Jet Flanger Legacy A/DA Flanger
AC Flanger Legacy MXR® Flanger
80A Flanger Legacy A/DA Flanger
Frequency Shift Legacy Line 6 Original
Ring Modulator Legacy Line 6 Original
Rotary Drum Legacy Fender® Vibratone
Rotary Drum/Horn Legacy Leslie® 145

Delay Models
Model Subcategories Based On*
Simple Delay Mono, Stereo Line 6 Original
Mod/Chorus Echo Mono, Stereo Line 6 Original
Dual Delay Stereo Line 6 Original
Multitap 4 Stereo Line 6 Original
Multitap 6 Stereo Line 6 Original
Ping Pong Stereo Line 6 Original
Sweep Echo Mono, Stereo Line 6 Original
Ducked Delay Mono, Stereo TC Electronic® 2290
Reverse Delay Mono, Stereo Line 6 Original
Vintage Digital Mono, Stereo Line 6 Original
Vintage Swell Mono, Stereo Line 6 Original
Pitch Echo Mono, Stereo Line 6 Original
Transistor Tape Mono, Stereo Maestro® Echoplex EP-3
Cosmos Echo Mono, Stereo Roland® RE-201 Space Echo
Harmony Delay Stereo Line 6 Original
Bucket Brigade Mono, Stereo BOSS® DM-2
Adriatic Delay Mono, Stereo BOSS® DM-2 w/ Adrian Mod
Adriatic Swell Mono, Stereo Line 6 Original
Elephant Man Mono, Stereo Electro-Harmonix® Deluxe Memory Man
Multi Pass Mono, Stereo Line 6 Original
Ping Pong Legacy Line 6 Original
Dynamic Legacy TC Electronic® 2290
Stereo Legacy Line 6 Original
Digital Legacy Line 6 Original
Dig w/Mod Legacy Line 6 Original
Reverse Legacy Line 6 Original
Lo Res Legacy Line 6 Original
Tube Echo Legacy Maestro® Echoplex EP-1
Tape Echo Legacy Maestro® Echoplex EP-3
Sweep Echo Legacy Line 6 Original

*See “U.S. Registered Trademarks” on page 57 All product names used in this document are trademarks of their respective owners and neither Yamaha Guitar Group nor Line 6 are associated or affiliated with them.  
These trademarks appear solely to identify products whose tones and sounds were studied by Line 6 during sound model development.
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Delay Models
Model Subcategories Based On*
Echo Platter Legacy Binson® EchoRec®

Analog Echo Legacy BOSS® DM-2
Analog w/Mod Legacy Electro-Harmonix® Deluxe Memory Man
Auto-Volume Echo Legacy Line 6 Original
Multi-Head Legacy Roland® RE-101 Space Echo

Reverb Models
Model Subcategory Based On*
Glitz Mono, Stereo Line 6 Original
Ganymede Mono, Stereo Line 6 Original
Searchlights Mono, Stereo Line 6 Original
Plateaux Mono, Stereo Line 6 Original
Double Tank Mono, Stereo Line 6 Original
Plate Legacy Line 6 Original
Room Legacy Line 6 Original
Chamber Legacy Line 6 Original
Hall Legacy Line 6 Original
Echo Legacy Line 6 Original
Tile Legacy Line 6 Original
Cave Legacy Line 6 Original
Ducking Legacy Line 6 Original
Octo Legacy Line 6 Original
'63 Spring Legacy Line 6 Original
Spring Legacy Line 6 Original
Particle Verb Legacy Line 6 Original

Pitch/Synth Models
Model Subcategories Based On*
Pitch Wham Mono, Stereo Digitech® Whammy®

Twin Harmony Mono, Stereo Eventide® H3000
Simple Pitch Mono, Stereo Line 6 Original

Pitch/Synth Models
Model Subcategories Based On*
Dual Pitch Mono, Stereo Line 6 Original
3 OSC Synth Stereo Line 6 Original
3 Note Generator Mono, Stereo Line 6 Original
4 OSC Generator Mono, Stereo Line 6 Original
Bass Octaver Legacy EBS® OctaBass
Smart Harmony Legacy Eventide® H3000
Octi Synth Legacy Line 6 Original

Synth O Matic Legacy Line 6 Original

Attack Synth Legacy Korg® X911 Guitar Synth

Synth String Legacy Roland® GR700 Guitar Synth

Growler Legacy Line 6 Original

Filter Models
Model Subcategories Based On*
Mutant Filter Mono, Stereo Musitronics® Mu-Tron® III
Mystery Filter Mono, Stereo Korg® A3
Autofilter Mono, Stereo Line 6 Original
Asheville Pattrn Mono, Stereo Moog® Moogerfooger® MF-105M MuRF Filter
Voice Box Legacy Line 6 Original

V Tron Legacy Musitronics® Mu-Tron® III

Q Filter Legacy Line 6 Original

Seeker Legacy Z Vex Seek Wah

Obi Wah Legacy Oberheim® voltage-controlled S&H filter

Tron Up Legacy Musitronics® Mu-Tron® III (up position)

Tron Down Legacy Musitronics® Mu-Tron® III (down position)

Throbber Legacy Electrix® Filter Factory

Slow Filter Legacy Line 6 Original

Spin Cycle Legacy Craig Anderton's Wah/Anti-Wah

Comet Trails Legacy Line 6 Original

*See “U.S. Registered Trademarks” on page 57 All product names used in this document are trademarks of their respective owners and neither Yamaha Guitar Group nor Line 6 are associated or affiliated with them.  
These trademarks appear solely to identify products whose tones and sounds were studied by Line 6 during sound model development.
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Wah Models
Model Subcategories Based On*
UK Wah 846 Mono, Stereo Vox® V846
Teardrop 310 Mono, Stereo Dunlop® Cry Baby® Fasel model 310
Fassel Mono, Stereo Dunlop® Cry Baby® Super

Weeper Mono, Stereo Arbiter® Cry Baby®

Chrome Mono, Stereo Vox® V847

Chrome Custom Mono, Stereo Modded Vox® V847

Throaty Mono, Stereo RMC® Real McCoy 1

Vetta Wah Mono, Stereo Line 6 Original

Colorful Mono, Stereo Colorsound® Wah-fuzz

Conductor Mono, Stereo Maestro® Boomerang

Volume/Pan Models
Model Subcategories Based On*
Volume Pedal Mono, Stereo Line 6 Original
Gain Mono, Stereo Line 6 Original
Pan Stereo Line 6 Original
Stereo Width Stereo Line 6 Original

Common FX Settings
Parameter Description

Drive Adjusts the amount of overdrive, distortion, or fuzz.

Bass Adjusts the bass level.

Mid Adjusts the midrange level.

Treble Adjusts the treble level.

Speed

Adjusts the speed of the effect, with higher settings providing faster 
rates. Activate the model's Note Sync parameter to toggle 
between Hz and note values. Choosing a Hz value provides a 
specific modulation speed in cycles per second; choosing a note 
value provides a time based on the current tempo. Not all Speed 
parameters can be synced to note values, as they may be non-linear 
and highly interactive.

Rate
Adjusts the rate of the effect, with higher settings providing faster 
rates. Activate the model's Note Sync parameter to toggle 
between Hz and note values. Not all Rate parameters can be synced 
to note values, as they may be non-linear and highly interactive.

Time

Adjusts the delay/repeat time, with higher settings providing longer 
delays. Activate the model's Note Sync parameter to toggle 
between Hz and note values. Choosing a ms value provides a 
specific time in milliseconds; choosing a note division value provides 
a time based on the current tempo. With a note division value, this 
parameter’s value is retained when changing models.

Depth Adjusts the intensity of the modulation. Higher settings result in more 
extreme pitch bending, wobble, or throb, depending on the effect.

Feedback Adjusts the amount of delayed signal fed back into the effect. Higher 
settings can provide more dramatic textures.

Decay Sets the length of time the reverb effect sustains.

Predelay Determines the time before the reverb effect is heard.

Scale

On stereo delays, the Scale offers control over the left & right channel 
repeats proportionately. The left channel repeats following the Time 
value and the right channel will repeat at a time that is the percentage 
of the left time. For example, if a delay's Time is set for 1 second and 
the Scale set to 75%, the left channel will repeat at 1 second and the 
right at 750 milliseconds (ms).

Spread

Spread differs slightly among stereo delay effects. For most delays, 
it adjusts how widely the repeats bounce left and right. With the Ping 
Pong Delay, for example, 0 is in the middle (mono), and 10 is full left to 
right panning for the repeats.
For modulated stereo delays, Spread affects the LFOs’ (low frequency 
oscillators) stereo modulation behavior. At 0 the LFOs are in sync. At 
10, the two LFOs are 180 degrees out of sync, so that when one side 
is modulating up, the other side is modulating down.

*See “U.S. Registered Trademarks” on page 57 All product names used in this document are trademarks of their respective owners and neither Yamaha Guitar Group nor Line 6 are associated or affiliated with them.  
These trademarks appear solely to identify products whose tones and sounds were studied by Line 6 during sound model development.



 53 

Parameter Description

Headroom
Some mod and delay pedals' internal signal paths exhibit a bit of grit, 
especially when placed after a high-gain amp block. Negative values 
increase the perceived amount of grit; positive values clean things up 
a bit. At 0dB, the model behaves like the original pedal.

Low Cut Filters a portion of the block’s bass and/or treble frequencies, which 
can help remove rumble and/or high-end harshness.High Cut

Mix
Blends the effected “wet” signal vs. the “dry” signal passed through 
the block. When set to 0%, the path bypasses the effect completely. 
When set to 100%, the entire path is fed through the effect, and no 
dry thru signal is heard.

Level

Adjusts the overall output level of the effects block. Be careful not to 
boost this parameter too high on multiple blocks, as digital clipping 
could occur. You should typically leave this at 0.0dB for most blocks. 
Where the original pedal's level or volume knob behavior doesn't 
really apply to dB values, 0.0-10 may be used.

Trails

Trails Off: Any delay repeats or reverb decays are instantly muted 
when the block is bypassed. 
Trails On: Any delay repeats or reverb decays continue to decay 
naturally when the block is bypassed or a different snapshot is 
selected. 

Amp Models
The following guitar & bass amp models are found within the Amp+Cab, Amp and 
Preamp block category menus for all Helix devices and HX Stomp devices, as of 
firmware version 2.90. Note that you’ll also see Guitar and Bass subcategories for the 
Amp+Cab & Amp categories, and Guitar, Bass and Mic subcategories for the Preamp 
category.

HX Effects Owners: Amp, Preamp, Speaker Cab, and Mic models are not 
supported by HX Effects devices, therefore, you will not see these categories or 
models within the HX Edit Model menus when the HX Effects is in use. 

• Amp+Cab blocks include an Amp plus a matched Cab model. You can change 
out the Cab for sonic variation (see the list of “Speaker Cabinet Models” on 
page 55).

• Amp blocks are identical to Amp+Cab blocks, except they contain no matched 
Cab model. Using an Amp block is the best choice if you want to use an IR 
block. Or try using a few IR or Cab blocks in a parallel Split Path for even more 
variation.

• Preamp versions of each amp model are also included, which provide the tone 
of just the preamp stage of the amp. Preamp blocks require less computer 
processing than a full Amp block.

Amp Models
Model Subcategory Based On*

WhoWatt 100 Guitar Hiwatt® DR-103 Brill

Soup Pro Guitar Supro® S6616

Stone Age 185 Guitar Gibson® EH-185

Voltage Queen Guitar Victoria Vintage Queen

Tweed Blues Nrm Guitar Fender® Bassman® (normal channel)

Tweed Blues Brt Guitar Fender® Bassman® (bright channel)

Fullerton Nrm Guitar Fender® 5C3 Tweed Deluxe (normal channel)

Fullerton Brt Guitar Fender® 5C3 Tweed Deluxe (bright channel)

Fullerton Jump Guitar Fender® 5C3 Tweed Deluxe (jumped channels)

Grammatico Nrm Guitar Grammatico® LaGrange (normal channel)

Grammatico Brt Guitar Grammatico® LaGrange (bright channel)

Grammatico Jump Guitar Grammatico® LaGrange (jumped channels)

US Small Tweed Guitar Fender® Champ®

US Deluxe Nrm Guitar Fender® Deluxe Reverb® (normal channel)

US Deluxe Vib Guitar Fender® Deluxe Reverb® (vibrato channel)

US Double Nrm Guitar Fender® Twin Reverb® (normal channel)

US Double Vib Guitar Fender® Twin Reverb® (vibrato channel)

Mail Order Twin Guitar Silvertone® 1484

Divided Duo Guitar ÷13 JRT 9/15

Interstate Zed Guitar Dr Z® Route 66

Derailed Ingrid Guitar Trainwreck® Circuits Express

Jazz Rivet 120 Guitar Roland® JC-120 Jazz Chorus

Essex A15 Guitar Vox® AC-15

Essex A30 Guitar Vox® AC-30 with top boost

A30 Fawn Nrm Guitar Vox® AC-30 Fawn (normal channel)

A30 Fawn Brt Guitar Vox® AC-30 Fawn (bright channel)

Matchstick Ch1 Guitar Matchless® DC30 (channel 1)

Matchstick Ch2 Guitar Matchless® DC30 (channel 2)

*See “U.S. Registered Trademarks” on page 57 All product names used in this document are trademarks of their respective owners and neither Yamaha Guitar Group nor Line 6 are associated or affiliated with them.  
These trademarks appear solely to identify products whose tones and sounds were studied by Line 6 during sound model development.
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Amp Models
Model Subcategory Based On*

Matchstick Jump Guitar Matchless® DC30 (jumped)

Mandarin 80 Guitar Orange® OR80

Brit J45 Nrm Guitar Marshall® JTM-45 (normal channel)

Brit J45 Brt Guitar Marshall® JTM-45 (bright channel)

Brit Trem Nrm Guitar Marshall® JTM-50 (normal channel)

Brit Trem Brt Guitar Marshall® JTM-50 (bright channel)

Brit Trem Jump Guitar Marshall® JTM-50 (jumped)

Brit Plexi Nrm Guitar Marshall® Super Lead 100 (normal channel)

Brit Plexi Brt Guitar Marshall® Super Lead 100 (bright channel)

Brit Plexi Jump Guitar Marshall® Super Lead 100 (jumped)

Brit P75 Nrm Guitar Park® 75 (normal channel)

Brit P75 Brt Guitar Park® 75 (bright channel)

Brit 2204 Guitar Marshall® JCM-800

Placater Clean Guitar Friedman BE-100 (clean channel)

Placater Dirty Guitar Friedman BE-100 (BE/HBE channel)

Cartographer Guitar Ben Adrian Cartographer

German Mahadeva Guitar Bogner® Shiva

German Ubersonic Guitar Bogner® Überschall®

Cali Texas Ch1 Guitar MESA/Boogie® Lone Star (clean channel)

Cali Texas Ch2 Guitar MESA/Boogie® Lone Star (drive channel)

Cali IV Rhythm 1 Guitar MESA/Boogie® Mark IV (channel I)

Cali IV Rhythm  2 Guitar MESA/Boogie® Mark IV (channel II)

Cali IV Lead Guitar MESA/Boogie® Mark IV (lead channel)

Cali Rectifire Guitar MESA/Boogie® Dual Rectifier®

Archetype Clean Guitar Paul Reed Smith® Archon® (clean channel)

Archetype Lead Guitar Paul Reed Smith® Archon® (lead channel)

ANGL Meteor Guitar ENGL® Fireball 100

Solo Lead Clean Guitar Soldano SLO-100 (clean channel)

Amp Models
Model Subcategory Based On*

Solo Lead Crunch Guitar Soldano SLO-100 (crunch channel)

Solo Lead OD Guitar Soldano SLO-100 (overdrive channel)

PV Panama Guitar Peavey® 5150®

Revv Gen Purple Guitar Revv® Generator 120 (purple/gain ch. 3)

Revv Gen Red Guitar Revv® Generator 120 (red/high gain ch. 4)

Line 6 Elektrik Guitar Line 6 Original

Line 6 Doom Guitar Line 6 Original

Line 6 Epic Guitar Line 6 Original

Line 6 2204 Mod Guitar Line 6 Original

Line 6 Fatality Guitar Line 6 Original

Line 6 Litigator Guitar Line 6 Original

Line 6 Badonk Guitar Line 6 Original

Ampeg B-15NF Bass Ampeg® B-15NF Portaflex®

Ampeg SVT Nrm Bass Ampeg® SVT® (normal channel)

Ampeg SVT Brt Bass Ampeg® SVT® (bright channel)

Ampeg SVT-4 PRO Bass Ampeg® SVT®--4 PRO

Woody Blue Bass Acoustic® 360

Agua 51 Bass Aguilar® DB51

Cali Bass Bass MESA/Boogie® M9 Carbine

Cali 400 Ch1 Bass MESA/Boogie® Bass 400+ (channel 1)

Cali 400 Ch2 Bass MESA/Boogie® Bass 400+ (channel 2)

G Cougar 800 Bass Gallien-Krueger® GK 800RB

Del Sol 300 Bass Sunn® Coliseum 300

Busy One Ch1 Bass Pearce BC-1 preamp (channel 1)

Busy One Ch2 Bass Pearce BC-1 preamp (channel 2)

Busy One Jump Bass Pearce BC-1 preamp (jumped)

Studio Tube Pre Preamp > Mic Requisite Y7 mic preamp

*See “U.S. Registered Trademarks” on page 57 All product names used in this document are trademarks of their respective owners and neither Yamaha Guitar Group nor Line 6 are associated or affiliated with them.  
These trademarks appear solely to identify products whose tones and sounds were studied by Line 6 during sound model development.
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Common Amp Settings
Parameter Description

Master
Adjusts the amount of power amp distortion. This parameter is highly 
interactive with all other power amp parameters—the lower the Master 
is set, the less effect the other controls will have.

Sag
Lower Sag values offer a “tighter” responsiveness for metal and djent 
playing; higher values provide more touch dynamics & sustain for 
blues and classic rock riffs.

Hum Controls how much heater hum and AC ripple interacts with your tone. 
At higher settings, things get freaky.Ripple

Bias Changes the Bias of the power tubes. Lower values achieve a “colder” 
Class AB biasing. At maximum, the amp is operating in Class A.

Bias X
Determines how the power amp tubes' voicing reacts when pushed 
hard. Set low for a tighter feel. Set high for more tube compression. 
This parameter is highly reactive with the Drive and Master settings.

Speaker Cabinet Models
The following Cab models are available within the Amp+Cab and Cab block category 
menus for all Helix devices and HX Stomp devices, as of firmware version 2.90. All Cab 
models also include your choice of Mic model type used on the Cab, as well as several 
Mic settings (see the list of “Microphone Models” on page 56).
There are two subcategories of Cab blocks—Single and Dual. Not surprisingly, Dual 
Cabs require twice as much processor usage as single Cabs. When you select a Dual 
Cab within the Model menu, you’ll see two model tabs, allowing you to select the 
specific cab and settings for each. Dual Cab blocks are stereo, with each of the two 
cabs panned hard left and right.

Cab Models
Model Subcategories Based On*
Soup Pro Ellipse Single, Dual 1 x 6x9" Supro® S6616
1x8 Small Tweed Single, Dual 1x8" Fender® Champ
1x12 Field Coil Single, Dual 1x12" Gibson® EH185
1x12 Fullerton Single, Dual 1x12" Fender® 5C3 Tweed Deluxe
1x12 Grammatico Single, Dual 1x12" Grammatico® LaGrange
1x12 US Deluxe Single, Dual 1x12" Fender® Deluxe Oxford
1x12 Celest 12H Single, Dual 1x12" ÷13 JRT 9/15 G12 H30
1x12 Blue Bell Single, Dual 1x12" Vox® AC-15 Blue
1x12 Lead 80 Single, Dual 1x12" Bogner® Shiva CL80

Cab Models
Model Subcategories Based On*
1x12 Cali IV Single, Dual 1x12" MESA/Boogie® Mk IV
1x12 Cali Ext Single, Dual 1x12" MESA/Boogie® EVM12L
2x12 Double C12N Single, Dual 2x12" Fender® Twin C12N
2x12 Mail C12Q Single, Dual 2x12" Silvertone® 1484
2x12 Interstate Single, Dual 2x12" Dr Z® Z Best V30
2x12 Jazz Rivet Single, Dual 2x12" Roland® JC-120
2x12 Silver Bell Single, Dual 2x12" Vox® AC-30TB Silver
2x12 Blue Bell Single, Dual 2x12" Vox® AC-30 Fawn Blue
2x12 Match H30 Single, Dual 1x12" Matchless® DC-30 G12H30
2x12 Match G25 Single, Dual 1x12" Matchless® DC-30 Greenback 25
4x10 Tweed P10R Single, Dual 4x10" Fender® Bassman® P10R
4x12 WhoWatt 100 Single, Dual 4x12" Hiwatt® AP Fane®

4x12 Mandarin EM Single, Dual 4x12" Orange® Eminence
4x12 Greenback25 Single, Dual 4x12" Marshall® Basketweave G12 M25
4x12 Greenback20 Single, Dual 4x12" Marshall® Basketweave G12 M20
4x12 Blackback30 Single, Dual 4x12" Park® 75 G12 H30
4x12 1960 T75 Single, Dual 4x12" Marshall® 1960 AT75
4x12 Uber V30 Single, Dual 4x12" Bogner® Uberkab V30
4x12 Uber T75 Single, Dual 4x12" Bogner® Uberkab T75
4x12 Cali V30 Single, Dual 4x12" MESA/Boogie® 4FB V30
4x12 XXL V30 Single, Dual 4x12" ENGL® XXL V30
4x12 SoloLead EM Single, Dual 4x12" Soldano
1x12 Del Sol Single, Dual 1x12" Sunn® Coliseum
1x15 Ampeg B-15 Single, Dual 1x15" Ampeg® B-15
1x18 Del Sol Single, Dual 1x18" Sunn® Coliseum
1x18 Woody Blue Single, Dual 1x18" Acoustic® 360
2x15 Brute Single, Dual 2x15" MESA/Boogie® 2x15 EV
4x10 Ampeg HLF Single, Dual 4x10" Ampeg® SVT® 410HLF
6x10 Cali Power Single, Dual 6x10" MESA/Boogie® Power House
8x10 Ampeg SVT E Single, Dual 8x10" Ampeg® SVT®

*See “U.S. Registered Trademarks” on page 57 All product names used in this document are trademarks of their respective owners and neither Yamaha Guitar Group nor Line 6 are associated or affiliated with them.  
These trademarks appear solely to identify products whose tones and sounds were studied by Line 6 during sound model development.
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Microphone Models
Mic Models

Model Based On*

57 Dynamic Shure® SM57

409 Dynamic Sennheiser® MD 409

421 Dynamic Sennheiser® MD 421-U

30 Dynamic Heil Sound® PR 30

20 Dynamic Electro-Voice® RE20

121 Ribbon Royer® R-121

160 Ribbon Beyerdynamic® M 160

4038 Ribbon Coles 4038

414 Cond AKG® C414 TLII

84 Cond Neumann® KM84

67 Cond Neumann® U67

87 Cond Neumann® U87

47 Cond Neumann® U47

112 Dynamic AKG® D112

12 Dynamic AKG® D12

7 Dynamic Shure® SM7

Cab & Mic Settings
Knob Parameter Description

1 Mic Selects one of the 16 available mic models.

2 Distance Sets the distance (1 inch to 12 inches) between the mic and 
the speaker grille.

3 Low Cut Filters a portion of the cab's bass and/or treble frequencies, 
which can help remove rumble and/or high-end harshness.4 High Cut

5 EarlyReflc Sets the amount of “early reflections.” Higher values add more 
reflective room sound to your Amp tone.

6 Level Adjusts the overall output level of the Cab.

*See “U.S. Registered Trademarks” on page 57 All product names used in this document are trademarks of their respective owners and neither Yamaha Guitar Group nor Line 6 are associated or affiliated with them.  
These trademarks appear solely to identify products whose tones and sounds were studied by Line 6 during sound model development.
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U.S. Registered Trademarks
All product names used in this document are trademarks of their respective owners and neither Yamaha Guitar Group nor Line 6 are associated or affiliated with them.  These 
trademarks appear solely to identify products whose tones and sounds were studied by Line 6 during sound model development. 

5150 is a registered trademark of ELVH Inc.
Acoustic is a registered trademark of GTRC Services, Inc. 
Aguilar is a registered trademark David Boonshoft.
AKG, DOD and Whammy are registered trademarks of Harman International Industries, Inc. 
Arbiter is a registered trademark of Sound City Amplification LLC.
Ashly is a registered trademark of Ashly Audio, Inc.
Binson, Dytronics, LA-2A and Teletronix are registered trademarks of Universal Audio, Inc. 
Beyerdynamic is a registered trademark of Beyer Dynamic GmbH & Co. KG. 
Bogner and Überschall are registered trademarks of Bogner Amplification. 
BOSS and Roland are registered trademarks of Roland Corporation U.S.
Carvin is a registered trademark of Kiesel Guitars.
Colorsound is a registered trademark of Sola Sound Limited Corporation, UK. 
Cry Baby, Dunlop, Fuzz Face, MXR and Uni-Vibe are registered trademarks of Dunlop 
Manufacturing, Inc. 
Darkglass and Microtubes are registered trademarks of Darkglass Electronics, TMI Douglas 
Castro.
Digitech is a registered trademark of DOD Electronics Corporation.
Dr. Z is a registered trademark of Dr. Z Amps, Inc.
EBS is a registered trademark according of EBS Holding.
EchoRec is a registered trademark of Nicholas Harris. 
Electro-Harmonix and Big Muff Pi are registered trademarks of New Sensor Corp. 
Electro-Voice is a registered trademark of Bosch Security Systems, Inc. 
Engl is a registered trademark of Beate Ausflug and Edmund Engl. 
Eventide is a registered trademark of Eventide Inc. 
Fane is a trademark of Fane International Ltd. 
Fender, Twin Reverb, Bassman, Champ, Deluxe Reverb and Sunn are registered trademarks 
of Fender Musical Instruments Corp. 
Fulltone is a registered trademark of Fulltone Musical Products, Inc. 
Gallien-Krueger is a registered trademark of Gallien Technology, Inc. 
Gibson and Maestro are registered trademarks of Gibson Guitar Corp. 
Heil Sound is a registered trademark of Heil Sound Ltd. 
Hiwatt is a registered trademark of Simon Giles and Justin Harrison. 
Ibanez is a registered trademark of Hoshino, Inc. 
Klon is a registered trademark of Klon, LLC. 

Korg is a registered trademark of Korg, Inc.  
Leslie is a registered trademark of Suzuki Musical Instrument Manufacturing Co. Ltd. 
Lone Star is a registered trademark of Randall C. Smith.
Marshall is a registered trademark of Marshall Amplification Plc. 
Matchless is a registered trademark of Matchless, LLC. 
MAXON is a registered trademark of Nisshin Onpa Co., Ltd. 
Mesa/Boogie and Rectifier are registered trademarks of Mesa/Boogie, Ltd. 
Moog and Moogerfooger are registered trademarks of Moog Music, Inc.
Musitronics is a registered trademark of Mark S. Simonsen. 
Mu-Tron is a registered trademark of Henry Zajac. 
Neumann is a registered trademark of Georg Neumann GmbH.
Orange is a registered trademark of Orange Brand Services Limited. 
Park is a registered trademark of AMP RX LLC. 
Paul Reed Smith and Archon are registered trademarks of Paul Reed Smith Guitars, LP. 
Peavey is a registered trademark of Peavey Electronics Corporation. 
Revv is a registered trademark of Revv Amplification Inc.
RMC is a registered trademark of Richard McClish.
Royer is a registered trademark of Bulldog Audio, Inc. DBA Rover Labs. 
Sennheiser is a registered trademark of Sennheiser Electronic GmbH & Co. KG. 
Shure is a registered trademark of Shure Inc. 
Silvertone is a registered trademark of Samick Music Corporation. 
Supro is a registered trademark of Absara Audio LLC. 
TC Electronic is a registered trademark of MUSIC Group IP Ltd. 
Tech21 is a registered trademark of Tech21 Licensing Ltd.
Timmy is a registered trademark of Paul Cochrane AKA PAULCAUDIO. 
Trainwreck is a registered trademark of of Scott Alan Fischer and Mona Fischer. 
Tube Screamer is a registered trademark of Hoshino Gakki Co. Ltd. 
Tycobrahe is a registered trademark of Kurt Stier. 
Vox is a registered trademark of Vox R&D Limited.
Way Huge is a registered trademark of Saucy Inc.
Xotic is a registered trademark of Prosound Communications, Inc.
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Keyboard Shortcuts
The following keyboard shortcuts are available to speed up tasks when working in the HX Edit application. Where indicated, some shortcuts require that “focus” be placed on a 
window, panel, or specific control to be able to trigger its function. To place focus within the desired window, press your Tab key to cycle focus between the Librarian, Editor, and 
Inspector windows—you'll see the window outlined in blue to indicate it has focus. Whenever the Command Center, Global EQ, or Preferences modal windows are opened from 
the app's Window menu, they will automatically have focus. To place focus on a tabbed panel, click directly within the desired Presets, Impulses, Edit, or Controller Assign panel. 
To place focus on any block, or on any parameter slider, button or menu list, simply click directly on it to select it, or use the Up/Down and Left/Right arrow keys to navigate through 
blocks, presets, IRs or menu items. 

HX Device Owners: Shortcuts listed in the following tables are the same for use with Helix and HX devices, except where noted. 

Global Shortcuts
Command Mac PC Function - These shortcuts perform the following functions regardless of focus 

Window Focus
(forward)

Tab Toggles focus between the Librarian, Signal Flow, and Inspector (as indicated by blue outline of selected window)

Window Focus
(reverse)

Shift + Tab Performs same focus action as above, but rotates through Librarian, Signal Flow and Inspector in reverse order

Enter Tap Tempo T “Tap” the key rhythmically to enter the system Tap Tempo value

Tap Tempo Mode 
Selection

Shift T+ Changes the Tap Tempo Mode menu selection (Per Snapshot, Per Preset or Global)

HX Edit Pilot’s 
Guide

N/A F1 Launches this PDF document you are now reading 

About Box Window N/A Alt
?
/+ Displays the About HX Edit window, containing application version information

HX Edit Menu Commands - Shortcuts (Mac only)
Command Mac PC Function - These shortcuts perform the following functions, regardless of focus 

Preferences ,<+Command
⌘⌘ * Opens the Preferences window. 

Quit HX Edit Command
⌘⌘ Q+ * Quits the HX Edit application.

*See the File Menu Commands table for PC equivalent shortcuts.)
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File Menu Commands - Shortcuts
Command Mac PC Presets Tab Focus Impulses Tab Focus Signal Flow Panel Focus Inspector Tab Focus

Save Preset Command
⌘⌘ S+ Ctrl S+ Saves the currently loaded preset

Save Preset As

Command
⌘⌘

Shift

S+
+

Shift

Ctrl

S+
+ Displays the Save As window, where you can choose the destination setlist and preset 

Import Preset/IR Command
⌘⌘ I+

Ctrl I+ Imports a preset into the 
currently-selected librarian list 
slot

Imports an IR into the currently-
selected librarian list slot

These shortcuts are functional and act upon the 
Presets or Impulses tab, whichever is currently 
displayed within the Library window

Export Preset/IR Command
⌘⌘ E+ Ctrl E+ Exports the currently-selected 

preset
Exports the currently-selected 
IR 

Import Setlist

Command
⌘⌘ I+
+Option

Alt

Alt I+
+Ctrl Imports a setlist, replacing the 

current setlist and its presets
No function These shortcuts are functional whenever the Presets 

tab is currently displayed within the Library window

Export Setlist

Command
⌘⌘ E+
+Option

Alt

Alt E+
+Ctrl Exports the current setlist and 

its presets as a setlist file to 
your computer

Import Bundle
(Helix devices)

Command
⌘⌘

Shift

I+
+

Shift

Ctrl

I+
+ Imports a bundle, replacing all 

setlists and presets
No function These shortcuts are functional whenever the Presets 

tab is currently displayed within the Library window

Export Bundle
(Helix devices)

Command
⌘⌘

Shift

E+
+

Shift

Ctrl

E+
+ Exports all setlists and their 

presets as a bundle file to 
your computer

Preferences * Alt + Return
Enter Opens Preferences window (use ESC to close the window)

Quit * Ctrl Q+ Quits HX Edit application

*See the HX Edit Menu Commands table for Mac equivalent shortcuts.

Edit Menu Commands - Shortcuts
Command Mac PC Presets Tab Focus Impulses Tab Focus Signal Flow Panel Focus Inspector Tab Focus

Undo Command
⌘⌘ Z+

Ctrl Z+ No function No function Reverses the last supported 
block or signal flow action

Reverses the last supported 
Edit tab action

Redo

Command
⌘⌘

Shift

Z+
+

Shift

Ctrl

Z+
+ No function No function Reverses the last Undo 

action within the signal flow
Reverses the last Undo 
action within the Edit tab

Cut Command
⌘⌘ X+

Ctrl X+ No function No function Copies the selected block & 
its settings to the clipboard 
and deletes the block from 
the signal flow

No function
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Edit Menu Commands - Shortcuts
Command Mac PC Presets Tab Focus Impulses Tab Focus Signal Flow Panel Focus Inspector Tab Focus

Copy Command
⌘⌘ C+ Ctrl C+ Copies the 

currently-selected preset (in 
its last-saved state) to the 
clipboard

Copies the 
currently-selected IR (with 
its current settings) to the 
clipboard

Copies the selected block 
(with its current settings) to 
the clipboard

No function

Paste Command
⌘⌘ V+ Ctrl V+ Pastes the last-copied 

preset from the clipboard 
into the selected preset 
location

Pastes the last-copied IR 
from the clipboard into the 
selected IR location

Pastes the last-copied 
block from the clipboard 
into the selected block 
location

No function

Clear Command
⌘⌘ + Delete Delete No function Clears the selected IR 

location(s)
Deletes the block from the 
signal flow

No function

Select All Command
⌘⌘ A+ Ctrl A+ Selects all 128 preset 

locations within the current 
setlist

Selects all 128 IR locations 
within the Impulses list

No function No function

Rename Command
⌘⌘ R+ Ctrl R+ Allows the selected preset 

to be renamed
Allows the selected IR to be 
renamed

Allows the currently loaded preset to be renamed

Window Menu Commands - Shortcuts
Command Mac PC Presets or Impulses Tab Focus Signal Flow Panel Focus Inspector Window Focus
Show/Hide Librarian Panel

Command
⌘⌘

Shift

L+
+

Shift

Ctrl

L+
+ Shows or hides the Preset/Impulses Librarian panel

Command Center
(Helix & HX Effects)

Command
⌘⌘

Shift

M+
+

Shift

Ctrl

M+
+ Opens (and places focus in) and closes the Command Center window

Global EQ
(Helix devices)

Command
⌘⌘

Shift

G+
+

Shift

Ctrl

G+
+ Opens (and places focus in) and closes the Global EQ window 

Snapshots Menu Commands - Shortcuts
Command Mac PC Presets Tab Focus Impulses Tab Focus Signal Flow Panel Focus Inspector Tab Focus
Copy

Command
⌘⌘

Shift

C+
+

Shift

Ctrl

C+
+ Copies the currently loaded snapshot to the clipboard

Paste

Command
⌘⌘

Shift

V+
+

Shift

Ctrl

V+
+ Pastes the last-copied snapshot contents from the clipboard into the current snapshot 

Rename

Command
⌘⌘

Shift

R+
+

Shift

Ctrl

R+
+ Allows you to enter in a new title to rename the current snapshot
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Snapshots Menu Commands - Shortcuts
Command Mac PC Presets Tab Focus Impulses Tab Focus Signal Flow Panel Focus Inspector Tab Focus

Snapshot 1
(All Helix & HX 
devices)

Command
⌘⌘ 1+ Ctrl 1+ Loads Snapshot 1 

Snapshot 2
(All Helix & HX 
devices)

Command
⌘⌘ 2+ Ctrl 2+ Loads Snapshot 2

Snapshot 3
(All Helix & HX 
devices)

Command
⌘⌘ 3+ Ctrl 3+ Loads Snapshot 3

Snapshot 4
(Helix & HX Effects 
devices)

Command
⌘⌘ 4+ Ctrl 4+ Loads Snapshot 4

Snapshot 5 
(Helix devices) Command

⌘⌘ 5+ Ctrl 5+ Loads Snapshot 5

Snapshot 6
(Helix devices) Command

⌘⌘ 6+ Ctrl 6+ Loads Snapshot 6

Snapshot 7
(Helix devices) Command

⌘⌘ 7+ Ctrl 7+ Loads Snapshot 7

Snapshot 8
(Helix devices) Command

⌘⌘ 8+ Ctrl 8+ Loads Snapshot 8

Librarian Window - Shortcuts
Command Mac PC Presets Tab Focus Impulses Tab Focus

Presets Tab P Displays and changes focus to the Presets tab No function

Impulses Tab I No function Displays and changes focus to the Impulses tab

Display Context 
Menu Ctrl +

or

or
Shift + Return

Enter

or
Shift + Return

Enter

Displays the context menu for selected preset location
(Navigate an open menu using Up/Down Arrow keys and 
ENTER key to make selection. Use ESC key to dismiss 
menu.)

Displays the context menu for selected IR location
(Navigate an open menu using Up/Down Arrow keys and 
ENTER key to make selection. Use ESC key to dismiss 
menu.)

Change Tab Focus Changes focus between the Presets and IR tabs Changes focus between the Presets and IR tabs

Navigate Selection Navigates the preset selection within the current setlist Navigates the IR selection within the Impulses list

Extend Selection
Shift + Extends the preset selection within the current setlist Extends the IR selection within the Impulses list
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Librarian Window - Shortcuts
Command Mac PC Presets Tab Focus Impulses Tab Focus

Contiguous Multi-
select Shift + Selects contiguous, multiple presets within the current 

setlist
Selects contiguous, multiple IRs within the Impulses list

Non-contiguous 
Multi-select Command

⌘⌘ + Ctrl + Selects non-contiguous, multiple presets within the current 
setlist

Selects non-contiguous, multiple IRs within the Impulses 
list

Rename Preset/IR
Delay click

Renames the clicked preset (click once and then a 2nd time 
1/3 of a second or later)

Renames the clicked IR (click once and then a 2nd time 1/3 
of a second or later)

Rename Setlist
(Helix devices)

R Renames the current setlist No function

Setlist 1
(Helix devices)

1 Displays Setlist 1 No function

Setlist 2
(Helix devices)

2 Displays Setlist 2 No function

Setlist 3
(Helix devices)

3 Displays Setlist 3 No function

Setlist 4
(Helix devices)

4 Displays Setlist 4 No function

Setlist 5
(Helix devices)

5 Displays Setlist 5 No function

Setlist 6
(Helix devices)

6 Displays Setlist 6 No function

Setlist 7
(Helix devices)

7 Displays Setlist 7 No function

Setlist 8
(Helix devices)

8 Displays Setlist 8 No function

Signal Flow Window - Shortcuts
Command Mac PC Function - These shortcuts perform the following functions when the Signal Flow window has focus

Navigate Selection Selects and cycles through blocks within the Signal Flow 

Edit Tab Return
Enter Activates the Edit tab, displays the edit options for the selected block, and gives focus to the Model Category of the 

selected block's model
Display Block 
Context Menu Shift + Return

Enter

or  Ctrl +

or  

Shift + Return
Enter

or  

Displays the block's context menu*
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Signal Flow Window - Shortcuts
Command Mac PC Function - These shortcuts perform the following functions when the Signal Flow window has focus

Block Bypass 
Toggle

Spacebar Toggles the bypass state of the selected block

Amp Block Select
(Helix & HX Effects 
devices)

A Selects and cycles through selecting the Amp, Amp+Cab and Preamp blocks within the current preset

Block Select
 Single-click

Selects a block or empty block location

Display Edit tab - 
Model Browser  Double-click

Double click on any block or empty block location to display the Model Browser to choose a model

*Open context menus can be navigated by arrow keys, where ENTER makes a selection, and ESC dismisses the open menu.

Inspector Window - Shortcuts
Command Mac PC Edit Tab Focus* Bypass/Controller Assign Tab Focus
Edit Tab E  or  H No function Displays and places focus on the Edit tabbed panel

Bypass/Controller 
Assign Tab

B  or C Displays and places focus on the Bypass/Controller 
Assign tabbed panel

No function

Select Previous/Next 
Parameter or List

Advances the focus to the previous or next parameter 
slider or list
(If Model Grid view is visible, Shift must be used to 
advance focus out of Model Grid—see next shortcut)

No function

Select Previous/Next 
Tabbed List

Shift + Advances the focus to the first parameter on the 
previous or next tabbed list (if Amp+Cab or Dual Cab, 
or if Variax input parameters are present)

No function

Snapshot Assign Alt + Click directly on any parameter slider to quickly assign/
unassign its value to/from a Snapshots controller (or, 
when a parameter slider has focus, press S).

No function

Display Context 
Menu Shift + Return

Enter

or  Ctrl +

or  

Shift + Return
Enter

or  

Display the context menu for the selected parameter 
slider 

Display the context menu for the selected Bypass or 
Controller Assignment within the Assignments list 
(Note that the Shift+Enter shortcut does not work within 
this tab, but right click actions do)

Reset to Default
Command

⌘⌘ + Ctrl + Click on any block’s parameter slider to reset it to its 
default value (or, when a parameter slider has focus, 
press D).

Click on any assignment’s parameter slider to reset it to 
its default value (or, when a parameter slider has focus, 
press D)

Toggle Model List 
and Grid Views

G Toggles between displaying the Category/Model List 
View and Model Grid View

No function

*Focus within the Edit tab is indicated by turquoise colored outline surrounding a Model Browser item, or vertical line at left of parameter sliders. See next section for more details.
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Edit Tab - Model Browser Shortcuts
There are numerous keyboard shortcuts available for working within the multi-level Model 
Browser of the Inspector's Edit tab. The functionality of these shortcuts is dependent 
upon the element within the Edit tab that currently has focus, as described below. 

List/Grid View Toggle

Category List Model List/Grid

Sub-category Menu

Parameter Sliders

Within the Model Browser, the element that currently has focus is indicated by a 
turquoise colored outline. You can set the focus by either clicking to select an item 
within the list, or use your Up/Down/Left/Right arrow keys.

Model Focus (List View)

Model Category 
Focus 

Model Focus (Grid View)

Slider Focus 

Edit Tab: Category List or Model/Grid List Focus Shortcuts
Mac or PC Function 

Changes category or model selection

Moves focus between Category List, Model List and Parameter 
Sliders
(If Model Grid view is visible, Shift must be used to advance focus 
out of Model Grid)

Shift + For navigation when the Model Grid View is in use—Moves focus to 
the first parameter slider

Shift + For navigation when the Model Grid View is in use—Displays the 
Model Category Menu 
(Use Up/Down Arrow keys and ENTER keys to navigate and select 
Category within menu)

G Toggles between displaying the Category/Model List View and 
Model Grid View

Shift D+ Selects Distortion category

Shift Y+ Selects Dynamics category

Shift Q+ Selects EQ category

Shift M+ Selects Modulation category

Shift L+ Selects Delay category

Shift R+ Selects Reverb category

Shift S+ Selects Pitch/Synth category

Shift F+ Selects Filter category

Shift W+ Selects Wah category

Shift A+
+Option

Alt Selects Amp+Cab category (Helix and HX Stomp devices)

Shift A+ Selects Amp category (Helix and HX Stomp devices)

Shift P+ Selects Preamp category (Helix and HX Stomp devices)
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Edit Tab: Category List or Model/Grid List Focus Shortcuts
Mac or PC Function 

Shift C+ Selects Cab category (Helix and HX Stomp devices)

Shift I+ Selects IR category

Shift V+ Selects Volume/Pan category

Shift N+ Selects Send/Return category

Shift O+ Selects Looper category

Edit Tab: Parameter Slider Focus Shortcuts
Mac or PC Function 

 or  
_
-

+
=

Increments/decrements parameter value - fine adjustment

Shift + _
-

+
=

Shift +

or

Increments/decrements parameter value - coarse adjustment

Return
Enter Edits numerical parameter value or shows drop-down menu for 

discrete parameter choices. (Navigate an open menu using Up/
Down Arrow keys and ENTER key to make selection. Use ESC key 
to dismiss menu.)

Shift
+
Return
Enter

Opens the selected slider's context menu for controller assignment 
options

N For “Note Sync” capable parameters (indicated by the  button to 
the right of the slider), this toggles the functionality between Note 
Sync and ms/Hz

Edit Tab: Parameter Slider Focus Shortcuts
Mac or PC Function 

D Sets the selected parameter to its default value

S For block parameters, assigns parameter to a Snapshot controller

Double-click Enters edit mode for numerical parameter value (tap Enter/Return 
key to accept edited value)

TIP: The above Parameter Slider Focus Shortcuts are also functional for parameter 
sliders within the Inspector - Bypass/Controller Assign tab.
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Command Center, Global EQ & Preferences Window Shortcuts
(Helix and HX Effects devices only) Focus within these windows is indicated by the turquoise colored outline surrounding a control, or by the vertical line at left of any parameter slider.

Command Center Window - Shortcuts (Helix and HX Effects devices)
Command Mac PC Function 
Any Control Has Focus

Open/Close 
Command Center

Command
⌘⌘

Shift

M+
+

Ctrl

Shift

M+
+ Opens and closes the Command Center Window 

You can alternatively use ESC to close the open Command Center window

Focus Next Tab Move focus to next command parameter

Focus Previous Shift + Tab Move focus to previous command parameter

Parameter Slider Focus

Adjust Parameter  
Value - Fine

 or  
_
-

+
=

Adjusts the selected parameter slider's value up or down using small increments

Adjust Parameter  
Value - Coarse

Shift + _
-

+
=

Shift +

or

Adjusts the selected parameter slider's value up or down using large increments

Edit Numerical 
Parameter Value Return

Enter Edits the selected parameter's numerical value, or displays a parameter's drop-down menu for parameter options

Customize Label Control Focus

Edit Custom Label Return
Enter Edits the text within the Customize label field to create a custom name for any Footswitch label

Remove Custom 
Label

Delete Deletes the text within an edited Customize label field and returns it to its default label

Controller Grid Focus

Select Controller 
Within Grid

When any Controller (Instant, Footswitch , Variax Knob or EXP Pedal) has focus within the Grid pane—Moves the 
selection to the next or previous Controller
(Use TAB to place focus on Command menu and then use Arrow keys to choose Command option)
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Command Center Window - Shortcuts (Helix and HX Effects devices)
Command Mac PC Function 
Command Menu Focus (as indicated)

Command Menu 
Option Selection

_
-

+
=or

When the Command Menu has focus, but the menu is not open—chooses the next or previous option within the 
Command menu. Once the desired command within the menu list is highlighted, press the ENTER key to choose the 
command

Open Command 
Menu Return

Enter When the Command Menu has focus, but the menu is not open—use the ENTER key to open the menu, and then use 
the following shortcut keys to choose a command from the open menu list. 

Dismiss Command 
Menu

Esc When the Command Menu has focus and is open—use the ESC key to close the menu without making a selection

Change Command 
Menu Selection

When the Command Menu has focus and is open—use the Up/Down Arrow keys to highlight the desired command in 
the menu list, then use the ENTER key to select the highlighted command

Global EQ Window - Shortcuts (Helix and HX Stomp devices)
Command Mac PC Function 
Any Control Has Focus

Open/Close Global 
EQ 

Command
⌘⌘

Shift

G+
+

Ctrl

Shift

G+
+ Opens and closes the Global EQ Window. 

You can alternatively use ESC to close the open Global EQ window.

Focus Next Tab Move focus to next control

Focus Previous Shift + Tab Move focus to previous control

Reset R Invoke the Reset button to set all parameters “flat”

Apply EQ
(Helix devices)

A Cycle through the Apply EQ menu's output modes

Bypass B Toggle Bypass on/off 

EQ Graph Pane Focus

Low Cut 1 Selects the Low Cut node

Low Peak 2 Selects the Low Peak node

Mid Peak 3 Selects the Mid Peak node

High Peak 4 Selects the High Peak node
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Global EQ Window - Shortcuts (Helix and HX Stomp devices)
Command Mac PC Function 

High Cut 5 Selects the High Cut node

Adjust Edit Node -
Fine

Adjusts the selected edit node in small increments
Use the numbered keys above to select the desired node, then use Up/Down keys to edit Gain and Left/Right arrow keys 
to edit Frequency

Adjust Edit Node -
Coarse

Shift + Tab Adjusts the selected edit node in large increments
Use the numbered keys above to select the desired node, then use Up/Down keys to edit Gain and Left/Right arrow keys 
to edit Frequency

Increment Q Value 
- Fine

Q Increments the selected node's Q parameter value by 0.1

Increment Q Value 
- Coarse Shift Q+ Increments the selected node's Q parameter value by 1.0

Decrement Q Value 
- Fine Ctrl Q+ Decrements the selected node's Q parameter value by 0.1

Decrement Q Value 
- Coarse

Shift

Ctrl

Q+
+ Decrements the selected node's Q parameter value by 1.0

Control-Specific Focus (as indicated)

Reset Return
Enter When the Reset button has focus—Resets all parameters to default “flat” values

Bypass Spacebar When the Bypass button has focus—Toggles Global EQ Bypass

Close Window Return
Enter When the Done button has focus—Triggers the Done button to exit the Global EQ window. Optionally, you can use the 

ESC key to close the window
Apply To
Output Options
(Helix devices)

_
-

+
=or

When the Apply To output menu has focus—Selects the Apply To output menu's next or previous option. Optionally, you 
can use the ENTER key when the menu has focus to expand and view the menu list

Preferences Window - Shortcuts
Command Mac PC Function 

Open Preferences  
Window Command

⌘⌘ + <,
+
Return
Enter

Alt
Opens the Preferences window 
You can use the ESC key to close the window
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Additional Mouse Behaviors
But wait, there's more! To follow are additional time-saving gestures using your mouse 
wheel or mouse buttons. 

• Use your mouse wheel while hovering over...
• Any block within the Signal Flow to access the block’s Bypass and Clear 

buttons
• Any parameter slider and adjust its value
• Any scroll bar to scroll the panel's contents, such as within the Presets and 

Impulses lists and Edit and Bypass/Controller Assign tabs
• The Snapshots  menu to load a different snapshot
• The numerical Tap Tempo control to increment/decrement the tempo value
• The Setlist menu (Helix devices) to load a different setlist 

• Left-click and hold the mouse button, or right-click on... 
• The Preset tab's Setlist menu (Helix devices) to rename the current setlist
• The Snapshots menu to rename the current snapshot
• The numerical Tap Tempo control to edit the numerical tempo value

• Within the Presets Librarian tabbed window, Alt/Option + Left-click (Mac) or Ctrl 
+ Left-click (PC) and drag and drop any preset (or multiple selected presets) to 
copy into new preset slot locations, overwriting the presets that currently exist 
there. (Dragging and dropping a preset without using a modifier key moves the 
preset and reorders your preset list.)

• Just try Right-clicking (or Ctrl+Left-clicking on Mac) on different items within 
the application, and you may just discover a handy menu of commands you 
didn’t know about!
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Firmware Updater & 
Additional Resources
Helix and HX Device Firmware Updater
As of HX Edit version 2.90, a Firmware Updater is now built right in to the HX Edit 
application! With your Helix or HX device connected and an active Internet connection, 
when you launch HX Edit, it will automatically check to see if your device has the latest 
available firmware installed, and you’ll be prompted to have HX Edit update your device 
if needed. You can also access the Check for Updates button within the HX Edit 
Preferences window at any time - see page 42. It is highly recommended to always 
use the latest versions of device firmware, HX Edit, and Helix Native software to benefit 
from the latest features and the smoothest product compatibility.

To Update your Device Firmware
If you have not done so already, update your HX Edit application to version 2.92 (or the 
latest available version), available from line6.com/software/, then connect your Helix or 
HX device to your Mac or PC and launch HX Edit and proceed with the following steps.

NOTE: If you wish to install any firmware version on your device other than the 
latest, using a version of HX Edit older than v2.90, and/or have no Internet 

connection on your current computer, you must use the separate Line 6 Updater 
application—please skip to “Using the Line 6 Updater App” on page 72. 

Sign In: If you have not already done so, click the My Account button at the 
lower left of the HX Edit window and choose Sign In, enter your Username and 
Password, and click Sign in. If you have not yet created one, click Create a Line 
6 Account in the Sign In window to go to the line6.com website and create your 
free account, and then return to HX Edit and sign in. 

Signing in to your Line 6 account within HX Edit

Upon launch of HX Edit (or once you’ve signed in with HX Edit), if the app finds a 
newer firmware version for your device online, you’ll see a pop-up window. Here 
you can choose to Remind Me Later, read the Release Notes, or click Update 
Now to proceed and update your device.*

*IMPORTANT! Please be sure to read the Release Notes for all Line 6 
application and device driver installations first, before performing 

updates or installations. There may be specific instructions for the order 
and procedure to perform the update, depending on the existing version 
you already have installed.

Also, whenever a newer firmware is available, you’ll see a notification at the 
bottom right of the HX Edit app window. 

Choosing OK in the above Update Available window launches the Updater, which 
walks you through the simple backup and firmware update process, as described 
in the following steps.

• Create Backup - You are prompted to create a backup, which includes all your 
device’s presets, setlists, IRs and global settings. Click OK to continue 

https://line6.com/software/
https://line6.com/account/
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• Optionally, you can customize the title, description, and save location for your 
Backup file within the Create Backup window (see page 21 for details). Click 
the Create Backup button to proceed. 

• End User License Agreement: - You must agree to the terms of the License 
Agreement to perform the firmware installation - read and click OK to continue. 

• Update Device: Click Update and the Updater does its thing—simply sit back 
and wait for the update to run, as indicated by the status bar at the bottom of 
the window. It is especially important not to disturb the device’s controls 
and cable connections until the update fully completes! 

• Update Complete: Once finished, you’ll see the Update Complete screen. Just 
click Back to HX Edit and wait for your device to restart and rebuild all presets. 
You’ll then be reconnected to the HX Edit app—ready to start using the new 
firmware!

While the presets on your device will not be altered, some minor sonic changes 
may still occur with some firmware updates, as noted within any firmware’s 
Release Notes.



 72 

TIP: In most cases, firmware versions will also include new Factory Presets. 
However, the firmware update process does not install these new Factory Presets 

(since we figure you really would not want any of your existing presets overwritten!). You 
can install them by performing a Factory Restore—please see your Helix or HX Owner's 
Manual for details.

TIP: Alternatively, you can manually check for available firmware updates anytime 
by clicking the Check For Updates button found within “The Preferences 

Window”.

Using the Line 6 Updater App
As mentioned in the previous section, for updating to the latest available Helix 
or HX device firmware, it is recommended to use the built in Firmware Updater 
within HX Edit version 2.92. If for any reason you prefer to use an earlier version 

of HX Edit, and/or wish to “roll back” to or install firmware version older than version 
2.90, you must use the separate Line 6 Updater application. The Line 6 Updater 
software is installed automatically on Windows computers with the installation of the 
HX Edit application—or, the latest Mac and Windows versions can be downloaded from 
line6.com/software/.

IMPORTANT! Please be sure to read the Release Notes for all Line 6 
application and device driver installations first, before performing 

updates or installations. Also read the Release Notes and Special Instructions 
displayed within the Line 6 Updater application when starting a firmware update 
(see the following steps). There may be specific instructions for the order and 
procedure to perform the update, depending on the existing version you already 
have installed.

TIP: It is always a good idea to create a backup of your Helix or HX device's contents 
before performing a firmware update! The best procedure is to perform the backup 
in your existing HX Edit version first—then update to the latest device firmware and 

HX Edit versions. See “Creating & Restoring Complete Device Backups” on page 21.

To use the Line 6 Updater application - Once you have Line 6 Updater installed, with 
your Helix or HX device connected and powered on, quit all other Line 6 and audio 
applications and launch the application.

On Mac - Go to Applications > Line 6 > Line 6 Updater
On Windows® - Go to the Start button menu > All Apps (or Programs) > Line 6 > 
Line 6 Updater

• Once you’ve launched the Line 6 Updater app, you will be asked to sign into 
your Line 6 account.* If you do not have an account, you must first create one. 
Follow the prompts through to the quick online registration.

*NOTE: If the computer you are using is not connected to the Internet, it is 
still possible to use Line 6 Updater in “Offline Mode” to update your 

device. Please see the steps at the end of this section for details. 
• Once logged in, any USB-connected and supported Line 6 products will appear 

in the main view of the Line 6 Updater application. Click on the device you wish 
to update and your device's current firmware version and available updates are 
displayed.

• Select the desired firmware version and click the Update button. 
• The firmware’s Release Notes are shown before continuing with the update 

process. Read them for important details.* 
• The License Agreement is displayed next. Read through the agreement and 

Click Accept to agree to the terms and conditions and start the update process.
• You'll then see the firmware's Special Instructions displayed. Be sure to read all 

instructions here carefully and follow the steps closely. 
• When ready click Next and Line 6 Updater software will assist you in performing 

the update in minutes. It is especially important not to disturb the device’s 
controls and cable connections until the update fully completes!

While the presets on your device will not be altered, some minor sonic changes may still 
occur with firmware updates, as noted within any firmware's Release Notes. 

Using Line 6 Updater in Offline Mode
If the computer you are using to run the Line 6 Updater app is not connected to the 
Internet, you can use the app’s Offline Mode to update your Helix or HX edit device’s 
firmware, as follows.

• You’ll need to first obtain the latest firmware for your specific Helix or HX device 
by downloading it from the line6.com/software/ web page, then manually copy 
the downloaded (.hxf) file to your computer where you’ll be running Line 6 
Updater. Connect your Helix or HX device directly to the computer’s USB port.

NOTE: While on the Line 6 software page, it is highly recommended that you 
fully read the Release Notes for the firmware version that you are about to 

download before running Line 6 Updater. These notes may include important 
details on the steps for your specific update!

• Launch Line 6 Updater. Rather than logging in, press the Offline Mode button. 
• Choose the Helix or HX device that you wish to update.
• Click the Choose File button to browse your computer and select the (.hxf) 

firmware file you obtained in the first step.
• Now just press the Next button and proceed with the update, carefully following 

all the screen instructions until the process completes.

TIP: Whenever installing firmware, you must be sure to also install the matching 
version number of the HX Edit application. Please visit line6.com/software/ to find 

the correct application version.

https://www.line6.com/manuals
https://www.line6.com/manuals
https://line6.com/software/
https://line6.com/software/
https://line6.com/software/
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Additional Resources
Looking for more info? We’ve got plenty of online resources, just a click away.

• Additional Help documentation covering Helix & HX hardware and Helix Native 
Plug-in is available on the Line 6 Support site at Line 6 Product Manuals. 

• Visit the Line 6 CustomTone site where you can share your presets with the 
world, and download free presets created by Line 6 and other users just like 
you.

• Looking for some professionally crafted presets and Impulse Responses for 
your Helix device or Helix Native plug-in? Check out the new Marketplace, and 
be sure to check back often for news and product announcements.

• Can’t get enough Line 6 gear & accessories? Head on over to the Line 6 Online 
Shop.

• Check out the Line 6 Support page for access to helpful tips, videos, discussion 
forums, or to contact Line 6 Technical Support.

http://line6.com/support/manuals/
http://line6.com/customtone/
https://line6.com/marketplace/
https://shop.line6.com/
http://line6.com/support
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